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RESUMEN

Desarrollar aplicaciones analógicas con menor número de componentes

electrónicos se ha convertido en la barrera que la ciencia y la tecnología buscan

atravesar; Lattice Semiconductor lo consigue al desarrollar los dispositivos

programabies en sistema ispPAC.

Estudiar e ¡mplementar un módulo de desarrollo que permita el empleo de esta

nueva tecnología para configurar filtros analógicos de manera ágil y sencilla como

parte de los circuitos capaces de ser programados en los ispPAC es el objetivo de

este proyecto.

Para comprobar el óptimo desempeño de esta tecnología se diseñaron filtros pasa

bajos de quinto orden de Butterworth y Elípticos, de los que se obtuvo las

simulaciones en el software del Módulo de desarrollo (PAC-Designer). Las

pruebas realizadas una vez programado el ispPAC80/81, ratificaron el

comportamiento y bondades del sistema desarrollado, reafirmando así la gran

utilidad del dispositivo ispPAC y las herramientas de desarrollo.

Al comparar los resultados obtenidos con los teóricos se encontraron errores deí

5% que no son relevantes, lo que comprueba la ventaja del sistema, considerando

el poco tiempo invertido en el desarrollo.



PRESENTACIÓN

En este proyecto de titulación se describen las características y prestaciones más

relevantes de la familia de dispositivos analógicos programables de Lattice

Semiconductor: ispPAC (in-system programmable Programmable Analog Circuits)

y de manera especifica los alcances, beneficios y ventajas del diseño de filtros

analógicos en ei dispositivo ispPAC80/81, dando a conocer esta tecnología se

persigue la finalidad de presentar una herramienta para el aprendizaje teórico -

práctico, dejando además abierta la posibilidad de que se desarrollen nuevas

aplicaciones con estos dispositivos en un futuro cercano.

En el Primer Capítulo se presenta una introducción a la programabilidad en

sistema (ISP), adicionalmente se abordan las características y prestaciones más

relevantes de los dispositivos ispPAC y en especial del chip ispPAC80/81

elemento con el que se desarrolla el proyecto de titulación.

El Segundo CapítuloJ describe el módulo de desarrollo, abordando de manera

general cada uno de sus componentes y el comportamiento para un adecuado

funcionamiento y operación en conjunto con el integrado ispPAC80/81, así

también se analiza el hardware necesario para la comunicación Módulo - PC

(Cable ISPDownload), haciendo énfasis en el estándar IEEE1149.1 que obedece

este interfaz.

En ei Tercer Capítulo, se analiza el software para la programación del dispositivo

ispPAC en el módulo de desarrollo, dando a conocer la facilidad que presenta

para la manipulación del usuario gracias a la interfaz gráfica de usuario (GUI) que

dispone.

Una introducción a los filtros analógicos se desarrolla en el Cuarto Capítulo, con lo

que se pretende recordar las características relevantes de los circuitos activos con

los que se pueden desarrollar aplicaciones analógicas como es el caso de los



filtros de Butterworth y Chebychev,,fundamentac¡ón teórica que se emplea para la

programación e interpretación de los filtros que se programan en el ispPAC80/81.

Luego de que se programa el dispositivo, en el Quinto Capítulo, se establece el

Análisis de las pruebas realizadas del módulo de desarrollo y del ispPAC80/81 en

el Laboratorio de Electrónica Básica de la E.P.N, y se interpretan los resultados

obtenidos, con la finalidad de comparar los datos experimentales con los teóricos

(obtenidos de las simulaciones) y comprobar así el óptimo desempeño de esta

tecnología.

El Sexto Capítulo hace referencia a las Conclusiones y Recomendaciones que

realiza el autor, observaciones que son la recopilación de los hechos y

experiencias suscitadas a lo largo del desarrollo del proyecto de titulación.



CAPITULO 1

INTRODUCCIÓN

La aparición de los componentes analógicos programables ispPAC constituye un

avance importante en el campo del diseño analógico, similar a la revolución que

produjeron, en el diseño digital, los dispositivos lógicos programables.

Los dispositivos analógicos programables son componentes que surgieron de la

necesidad de agilizar el proceso de diseño y verificación de circuitos analógicos.

Aunque la complejidad de los ispPAC todavía se encuentra lejos en comparación

a sus homólogos digitales; sin embargo, estos componentes presentan beneficios

y ventajas gracias al concepto de programabilidad que introducen estos

dispositivos. Además, el soporte de software gráfico de programación, así como la

programación ISP, facilita enormemente todas las etapas del proceso de diseño.

Estos dispositivos de reciente aparición en la industria, son fáciles de usar y

programar mediante el software PAC-Designer a través de un PC; juntos estos

productos constituyen una herramienta útil para diseñar, integrar y configurar

circuitos analógicos.

Estudiar la tecnología ispPAC y desarrollar e implementar un módulo de

desarrollo que permita el empleo de esta nueva tecnología, se convierte en el

objetivo trazado en este proyecto de titulación, con la finalidad de brindar nuevas

herramientas que agiliten los procesos de aprendizaje y desarrollo de

aplicaciones, optimizando recursos y tiempo.

Al realizar aplicaciones, las funciones, características y rasgos de estos

dispositivos pueden ser reconfigurados y reprogramados en segundos, lo que

implica que se podrían conseguir productos para comercializar más rápidamente,

o podría ampliar su versatilidad y tiempo de vida útil,



Por otro lado, el método de programación en sistema ISP (In-System

Programmable), desarrollado por la empresa Lattice, simplifica y acelera

radicalmente el desarrollo de aplicaciones con estos circuitos analógicos.

La herramienta PAC-Designer opera bajo plataforma Windows, y provee una

interfaz gráfica de usuario que garantiza un fácil diseño a través de las librerías

que dispone para la elaboración de circuitos analógicos. Lo mencionado sumado

a las opciones de verificación que dispone el software, hace que la programación

sea segura.

Como se verá, a través de la tecnología ISP, Lattice provee programabilidad

tridimensional: funcionalidad y características de rendimiento para cada célula, así

como la interconexión del dispositivo a nivel físico (en la estructura del módulo de

desarrollo).

De esta forma, la programación, el borrado y el reprogramado se logra rápida y

fácilmente a través de la interfaz que dispone el módulo de desarrollo y que se

explicarán con mayor detalle en capítulos posteriores.

Como resultado, se logra integrar rápidamente y con gran precisión ai ispPAC,

para reemplazar docenas de componentes normales individuales en un solo

dispositivo. Permite a ios diseñadores tener un dispositivo conveniente, con

componentes internos que pueden satisfacer diferentes requisitos específicos sin

las incertidumbres, costos y retrasos de ASICs convencionales.

En la actualidad existen cuatro dispositivos analógicos programables

proporcionados por Lattice, el ispPACIO, ¡spPAC20, ispPACSO, e ispPACSO/81,

los cuales presentan una estructura física interna que varía de uno a otro, debido

a que sus funciones están orientadas a diferentes aplicaciones; sin embrago el

concepto de arquitectura de todos estos dispositivos es el mismo.



Con la finalidad de establecer comparaciones entre los dispositivos ispPAC, a

continuación se tabulan las características y funciones que presentan:

Tabla 1.1 Características de ios Circuitos Analógicos Programables.

Características

Ancho de Banda

máximo

Rango de Filtros

de precisión

Rango de Voltaje

de entrada

Rango de

ganancia

programable

Tipo de memoria

Empaquetamiento

ispPACIO

550 kHz

10-1 00 kHz

1 - 4 V

0-10 VA/

Pasos:

1 V/V

EEPROM

28 pines PDIP

28 pines SOIC

ispPAC20

550 kHz

10-1 00 kHz

1 -4V

0 - 400 VA/

Pasos:

1 V/V

EEPROM

44 pines PLCC

44 pines TQFP

¡spPACSO

1.5MHz

49kHz-1.57MHz

0-2.8 V

0 - 42 V/V

Pasos:

0.008 V/V

SRAM

EEPROM

28 pines PDIP

24 pines SOIC

ispPAC80/81

750kHz/75kHz

50kHz-750kHz

10kHz~75kHz

1 -4V

1,2, 5, 10 VA/

EEPROM

16 pines PDIP

16 pines SOIC

Tabla 1.2 Principales Funciones de los dispositivos ispPAC

Funciones

Amplificación

Atenuación

Filtrado

Monitoreo de

Voltaje/Corriente

ispPACIO

-/

-/

ispPAC20

S

S

S

ispPACSO

^

^

^

ispPAC80/81

^

^

Gracias a los datos proporcionados por las tablas anteriormente expuestas, se

pueden advertir las prestaciones de cada uno de los ispPACs, y que dejan ai

descubierto la facilidad de combinar sus funciones para diferentes aplicaciones.



Para el estudio e ¡mplementación del módulo de desarrollo objetivo de este

proyecto de titulación se empleará el ispPAC80/81, debido a su disponibilidad en

el mercado al momento que se lo adquirió, así como también por las funciones

que presta, que sin lugar a dudas serán el inicio para la exploración y

perfeccionamiento de futuras aplicaciones dentro de esta tecnología.

1.1 ARQUITECTURA DE LOS ispPAC

El ispPAC80/81 es parte de los circuitos analógicos programables de la familia

Lattice. Se programa digitalmente vía tecnología no volátil E2CMOS. Es decir,

emplea una memoria tipo NVRAM (memoria no volátil de acceso aleatorio), que

permite retener su contenido cuando se apaga el sistema.

El elemento funcional activo básico de los dispositivos ispPAC es el PACell que,

dependiendo de la arquitectura específica del dispositivo, puede convertirse en un

amplificador de instrumentación, un amplificador sumador u otra etapa activa

elemental.

Se construyen módulos de función analógicos, llamado PACblocks, con múltiples

PACelIs, para reemplazar componentes analógicos tradicionales como

amplificadores y filtros activos, eliminando ía necesidad de resistencias externas y

condensadores, lo que proporciona una flexibilidad adicional en los diseños de

amplificadores sumadores/restadores, filtros, atenuadores, etc.

Para aclarar el concepto de PACell y PACblock, se presenta en la Figura 1.1 el

núcleo simplificado de un filtro diseñado con el ispPAC80/81, así como su función

de transferencia:



OUT

G = 1/20K; G/2 = 1/40K; C2 = C231 = C213; C4 = C435; C4/2 = C453

'

+ 2(l2C5G2C1)-(c22Z,2G2

2(G3£4C2)+(G3L4C3

Figura 1.1 Esquemático simplificado de un filtro configurado en el ispPAC8Q/81

El conjunto de OPAMPs interconectados (PACells), constituyen un filtro de quinto

orden del cual se obtiene una función de transferencia que presenta fase invertida

solo para este bloque; al combinarse con la inversión del PACell de entrada

(Amplificador de Instrumentación), la ganancia de salida del ¡spPAC80/81 es

positiva (ninguna inversión).



El número específico de PACblocks y sus funciones varían de acuerdo al

dispositivo ispPAC. A mayor número de PACblocks se logra perfeccionar las

aplicaciones y ampliar las opciones de diseño.

Otro de los elementos importantes en la arquitectura de los dispositivos ispPAC

es el entramado de conexiones analógicas denominado Analog Routing Pool

(ARP). El ARP se refiere a un sistema de conexionado programable que tiene

como función realizar las conexiones entre los pines dei dispositivo y las

entradas/salidas de los PACell y PACblocks.

Amplificador de
Instrumentación

PACell

Amplificador
de Salida
PACell

Filtro/Sumador

PACblock

= ispPAC80/81

Figura 1.2 Jerarquía del PACell



Todos los dispositivos ispPAC disponen de una Interfaz Periférica Serial (SPI),

que permite ajustan la ganancia, seleccionar configuraciones, e iniciar ciclos de

calibración.

La Figura 1.2 representa a un ¡spPAC80/81, el mismo que posee en la entrada un

amplificador de instrumentación (IA) con ganancia ajustable (en pasos semi-

íogarítmicos de: 1, 2, 5, y 10 para acondicionar una gama amplia de señales de

entrada.

Adicionalmente dispone de una memoria no volátil NVRAM, la misma que tiene la

función de guardar dos configuraciones de filtros pasa-bajos de quinto orden (TV y

£B') totalmente diferentes, y que se configuran con e! software de desarrollo, para

luego ser descargados al dispositivo. De esta forma se proporciona la capacidad

de cambiar rápidamente la ganancia al sistema, y acoplar dos tipos de filtros, que

proporcionarían dos frecuencias de corte.

El ispPAC80/81 incorpora en su circuitería un interfaz de prueba automático

(JTAG) y un interfaz periférico serial (SPI) el primero se encarga del diagnóstico

del dispositivo así como también de la programación y borrado de la memoria

RAM, a través de cuatro líneas que en el Cl se identifican por ios pines TMS,

TCK, TDO, y TDI, mientras que el segundo posee un registro de cambio que es

volátil y debe escribirse después de cada ciclo de encendido o antes de que se

use, afectando únicamente a la ganancia del IA, a la selección del filtro pre-

programado 'A ' o 'B,' y a la calibración del dispositivo.

Internamente, la selección de! modo de ¡nterfaz JTAG y SPI es realizado por

medio de un multiplexor (MUX) 2 a 1 que se controla por el pin ENSPI (Enable

SPI). Si a ENSPI se aplica un cero lógico, el dispositivo se mantendrá en el modo

de interfaz JTAG (NVRAM) y, sí su estado lógico cambia a uno invocará al modo

de interfaz SPi. Esto se ¡lustra en la Figura 1.3.
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Figura 1.3 Sistema de Adquisición de datos usando el pin ENSPI

A continuación se describe y analiza las características y prestaciones relevantes

del dispositivo analógico programable de Lattice, el ¡spPAC80/81, debido a las

características y herramientas de desarrollo que brinda ai programador, con

objeto de deducir sus posibles aplicaciones.

1.2 CARACTERÍSTICAS GENERALES DEL ispPAC80/81

En cuanto a sus posibilidades de programación ISP, este dispositivo posee:

- Un Amplificación de instrumentación.

- Filtros Activos de Precisión con un rango de frecuencia que varía entre

50KHza750 KHz.

- Topología para implementar filtros Pasa Bajo de Quinto Orden para

Tiempo-Continuo

- Configuración de memoria A/B, Dual.

- Celdas No Volátiles E-CMOS

- Puerto Programable Serial IEEE 1149.



Puede ser programado para proveer;

- Rango Programable de Ganancia (OdB a 20dB)

- Implementación Múltiple de Filtros: Elíptico, Chevychev, Bessel,

Butterworth, de Fase Lineal, Gausiano y Legendre.

- Baja Distorsión (THD < -74dB máx. a 100kHz)

- Auto Calibración del Voltaje de compensación de entrada.

En modo diferencia! posee las características:

- Instrumento Amplificador con una Entrada de alto CMRR (58dB).

- Modo Común de Referencia en el Chip de 2.5V

En cuanto a voltaje y potencia de consumo, este dispositivo puede operar con 5V

y 165mW.

Con este dispositivo es posible realizar:

Acondicionamiento de señales solo con un suministro de 5V.

Filtros programables con I/O totalmente diferenciales.

Sección de entrada analógica, Sistema de adquisición de datos de 12 Bits.

Sistemas DSP.

Reconstrucción de Filtros con Alto rendimiento.

En base a las características expuestas del ispPAC80/81, se presenta una

inquietud con respecto al costo beneficio. Si bien es cierto la característica

relevante «del ispPAC80/81 es la de generar respuestas a filtros pasa bajos de

quinto orden; ¿cuánta inversión conllevaría su implementacíón dentro del módulo

de desarrollo?; alrededor de ciento noventa dólares americanos (190 USD),

cantidad que en comparación al monto que se emplearía para el diseño de filtros

de quinto orden con componentes tradicionales, es elevado; pero que, analizando
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el beneficio que representa el obtener diseños en pocos minutos comparado con

el tiempo que tardaría en diseñar el filtro por métodos habituales, obtener una

respuesta aceptable y verificar el correcto funcionamiento del circuito, no se

escatima el monto invertido sino mas bien la gran ventaja de obtener resultados

óptimos y en el menor tiempo posible como se mostrará en los siguientes

capítulos.
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CAPITULO 2

DESCRIPCIÓN DEL MÓDULO DE DESARROLLO ispPAC

El módulo de desarrollo (Figura 2.1) permite configurar rápidamente el

ispPAC80/81. Este módulo está diseñado sobre un circuito impreso, que posibilita

la conexión de un Cl tipo DIP de 16 pines (ispPAC80/81), conectores para

señales de entrada y salida, un cable de programación JTAG que obedece al

estándar IEEE 114.9.1 y una sección que tiene un arreglo para conectar circuitería

adicional para realizar prototipos.

Cada entrada y salida es accesible al usuario a través de conectores BNC y

Jumpers.

O /^x
™-(J

VS Í45V) GND

tiL
VE

TÍO
TDI
te

PLOC

TMS

TCK

Conectores BNC

Conectores tipo
banana

Pushbutton

Pací de 3 6 pínes

Pad de 36 pines

Arreglo prototipo
286 agujeros

Pines para el
InterfazJTAG

Jumpers de conexión

Capacitores de Bypass
y desacoplamiento

Resistencia

ispPAC80/81

Figura 2.1 Módulo de desarrollo ispPAC80/81



Haciendo un resumen, el circuito impreso contiene un arreglo para prototipos de

286 agujeros que pueden ser usados para implementar proyectos que incluso se

conectan a dispositivos externos.

Para dotarle de expansión, las señales de !a interfaz de programación, así como

las señales analógicas, están conectadas a un dúo de hileras en una cabecera

con 34 pads (terminales de conexión).

El circuito impreso contiene un botón para realizar una calibración inicial. Junto al

dispositivo ispPAC80/81 existen capacitores de Desacoplamiento y Bypass.

C4 T

V

OUT+ BNC OUT- BNC

VS(+5V) GND

10uF_íT

o

+
ENSPI g
es o
TEST(Pin 12)

TESTOS ispPAC80/81

VREFour

-4-*-

IN+ BNC IN- BNC

?

INTERFAZ
CABLE

ispDOWNLOAD

CAL »VS +5V

Figura 2.2 Representación esquemática del Módulo de desarrollo ispPAC80/81
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Adicionalmente cuenta con dos plugs tipo banana que están disponibles en el

Circuito Impreso para conectar la alimentación (Vs) y la conexión de tierra (GND).

2.1 DETALLE DE LOS COMPONENTES DEL MÓDULO DE

DESARROLLO

Haciendo referencia a la Figura 2.1, se presenta a continuación un listado de los

elementos que componen el módulo de desarrollo.

(1) Circuito Impreso, (4.0"x5.0")

(4) Conectares BNC

(2) Jumper de Posiciones 3x1

(1) Terminal de 8-pines para programación JTAG (J5)

(1) Switch Pushbutton (Normalmente Abierto)

(2) Plugs tipo Banana para Vs y Gnd

(1) Capacitor de !OuF(C1)

1) Capacitor de .1uF (C2)

1) Capacitor de .01uF(C3)

1) Capacitor de 1uF(C4)

1) Resistencia de 10KOhm (R1)

1) Zócalo de 16-pines DIP

1) Dispositivo de 16-Pines ispPAC80/81
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2.2 ESPECIFICACIONES TÉCNICAS DEL ispPAC80/81

Figura 2.3 Diagrama Funcional de Bloques del ispPAC80/81

Los bloques analógicos, llamados PACell™(s), reemplazan los componentes

analógicos tradicionales como los amplificadores operacionales (opamps),

eliminando la necesidad de resistencias y capacitores externos. Como no requiere

la configuración de elementos externos, el ispPAC80/81 facilita el proceso,

simplifica la implementación de circuitos prototipo y admite cambios que

promueven mayor funcionalidad y alto rendimiento.

Con todos los componentes en el Chip, la preocupación por la degradación de la

respuesta disminuye, debido a que se suprimen los problemas relacionados al

acoplamiento de elementos y otros factores externos. El ispPAC80/81 proporciona

de esta forma fiabilidad y respuesta iterativa.

Como ya se mencionó anteriormente, el ispPAC80/81 se configura a través de un

puerto serial estandarizado IEEE 1149.1. La gran flexibilidad que presenta este

dispositivo posibilita la programación, comprobación y reconfiguración; si se

desea, en el circuito impreso.
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2.2.1 DESCRIPCIÓN DE PINES

El ispPAC80/81 presenta 16 pines, cada uno de los cuales cumple con funciones

definidas y que inmediatamente se describen

Pin

1

2

3

4

5

6

7

8

9

10,11

12,15

Símbolo

TMS

TCK

TDI

TDO

CS

CAL

ENSPI

GND

VREFout

IN

TEST

Nombre

Selección

del modo de Prueba

Reloj

Entrada para

datos de prueba.

Salida de

datos de prueba

Chip select

Auto calibración

Habilitar modo SPI

Tierra

Referencia en

Modo Común

Entradas (+ o -)

Pínes de Prueba

Descripción

Pin (entrada) de selección de! modo lógico del

interfaz serial. Únicamente en modo interfaz JTAG

Pin (entrada) de reloj del interfaz lógico serial.

Únicamente con modo JTAG (ispPACSO); modos

JTAGySPI(ispPAC81).

Pin (entrada) para ambos modos de operación

JTAG y SPi del ¡nterfaz lógico serial. Datos de

entrada Válidos en el flanco ascendente del TCK

(JTAG), o en el flanco ascendente del CS (SPI)

Pin (salida) para ambos modos de operación JTAG

y SPI del interfaz lógico serial. Datos de entrada

Válidos en el flanco descendente del TCK (JTAG),

o en el flanco ascendente de! CS (SPI)

Pin de entrada lógica de Chip seiect. Datos de

enclavamiento en SPI

Pin (entrada) digital. Secuencia de comandos para

auto-calibración en un flanco ascendente.

Pin de entrada lógica SPI habilitada. Cuando esta

en alto, el puerto serial corre en modo SPI

Pin de Tierra, Normalmente debe conectarse al

plano de tierra analógica.

Pin de salida de voltaje de referencia en modo

común (+2.5V nominales). Debe desviarse a tierra

con un capacitor de 1uF.

Pines de entrada diferencial, Se usan dos pines

(IN+ e IN-) como componentes del ViN, donde el V!N

diferencial es V!N = V!N+ - VIN_.

Pines de Prueba. Conectar a tierra para una

operación adecuada del circuito.
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13,14

16

OUT

Vs

Salidas (+ o -)

Voltaje

de alimentación

Pines de salida diferencia!, usando dos pines

(OUT+ y OUT-). Complementario con respecto al

VREFOUT- VOUT diferencial es VOUT = VQUT+ - VOUT-

Pin de alimentación de voltaje (5V nominal). Debe

desviarse a tierra con capacitores de 1 |jF y 0,01 pF

Dentro del módulo de desarrollo es importante señalar ciertas notas de conexión

que facilitaran ia manipulación adecuada del equipo:

1. Se etiquetan todas las entradas y salidas con ios signos más(+) y menos(-). La

polaridad es determinada por la referencia y puede ser seleccionada

externamente invirtiendo ia conexión de los pines.

2. Todos los pines de salida son "sujetos" a una salida interna del dispositivo y

debería quedar abierto si no se usó, VOUT+ y VOUT- no deben conectarse juntos

para evitar un incremento en la potencia que después no se pueda disipar.

3. Cuando la señal de entrada es asincrónica, la otra mitad de ia entrada

diferencial sin usar debe ser conectada a una referencia en modo común DC

(generalmente VREFOUT, 2.5V).

2.2.2 LÍMITES ABSOLUTOS DE UTILIZACIÓN

Para el correcto funcionamiento del dispositivo es necesario considerar los límites

de utilización que proporciona el fabricante;

Voltaje de Entrada Vs.......... .-0.5 a+7V

Voltaje de Entrada Lógico y Análogo Aplicado., O a Vs

Duración de Corto Circuito de Salida Lógico y Análogo Indefinido

Temperatura de línea (Soldadura, 10seg)... 260°C

Temperatura Ambiente con energía aplicada..... -55 a 125°C

Temperatura máxima de dispositivo -65 a 150°C
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Nota: E! exceder los valores listados puede causar daño permanente al

dispositivo. Estos son valores límites para su funcionamiento óptimo.

Aquellas condiciones ajenas a las indicadas en las secciones de operación

de esta especificación no deben tomarse como implícitas.

2.2.3 OPCIONES DE PRESENTACIÓN.

Como se mencionó en el Capítulo 1, el ¡spPAC80/81, puede ser un chip PDIP o

SOIC de 16 pines, razón por la cual su tamaño depende de la presentación del

mismo.
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Figura 2.4 Encapsulados del ispPAC80/81: a) 16 Pines PDIP, b) 16 Pines SOIC

Cada uno de los encapsulados tiene dimensiones propias, tal como se muestran

en las Figuras 2,5 y 2.6; para facilitar su lectura, se expresa en pulgadas un valor

mínimo y otro máximo separados por una barra inclinada (MIN. / MAX);

adicionalmente, entre paréntesis se expresan estas magnitudes en milímetros.
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2.2.4 DESCRIPCIÓN DE LA NUMERACIÓN DEL DISPOSITIVO

La numeración del dispositivo se debe interpretar de acuerdo a la norma

siguiente:

ispPAC 80 - XX XX

Familia del dispositivo -

Número del dispositivo-

Orado de rendimiento -
Estándar = 01

Presentación
P = PDIP, S =

I = temperatura Industrial
Vacío = Comercial

2.3 CONFIGURACIONES DE REFERENCIA

En las especificaciones de configuración que se listan a continuación, por facilidad

Lattice adopta una notación de ocho caracteres alfanuméricos que hacen

referencia a un filtro en particular, del cual se han efectuado mediciones para

establecer las características eléctricas tanto AC como DC.

Por ejemplo el filtro CC051042, representa a un filtro de la familia elíptica, en

donde las letras CC señalan que es un filtro Chevychev Completo, con una

respuesta de frecuencia Chevychev en pasa alto, pasa bajo o banda suprimida

del filtro.
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Los números siguientes "05" se refieren al orden del filtro. En este caso el

ispPAC80/81 será siempre de quinto orden. A continuación los dígitos indican el

coeficiente de reflexión (rf), en este caso 10%, y tiene una relación matemática

directa a la magnitud de la respuesta de frecuencia en la banda de paso del filtro,

que se expresa en dB = IQ^LogO-rf2). Finalmente, los dos últimos dígitos hacen

referencia a la pendiente de atenuación de la banda de paso a banda suprimida y

que se expresa como un ángulo, en este caso 42 grados o 1.49

(l/sin((7t/180)*42)).

Esta configuración corresponde al filtro elíptico con el número de identificación !D

#3083 (Fp=50.0QkHz; Fc=56.23kHz) de la base de datos del PAC-Designer.

Debido al número casi ilimitado de configuraciones realizables con el

ispPAC80/81, se deben seleccionar las configuraciones que en este proyecto se

utilizarán de prueba, en este caso se escogieron los filtros de la familia Elíptica

fueron preferidos debido a la gran cantidad de parámetros que pueden ser directa

y fácilmente probados, con lo que se podría asegurar que todos ios circuitos

interiores del ispPAC80/81 están operando correctamente.

2.3.1 ESPECIFICACIONES DE CONFIGURACIÓN DEL ispPAC80/81

Como se mencionó anteriormente, el ¡spPAC80/81 puede ser configurado de

acuerdo a las necesidades del usuario, para ¡o cual es recomendable referirse a

las especificaciones que se listan a continuación y que, permitirán el correcto

funcionamiento del equipo y su futura manipulación. Como características

generales se tiene TA ™ 25°C; Vs = 5.0V; 1V < VOUT < 4V ; Ganancia = 1 ; Carga

de salida = 200pF, 1M£1 Configuración de Filtro = CC051042, FP = SOkHz; Auto-

calibración antes de iniciar. En la Tabla 2.1 se listan las características más

relevantes.



Tabla 2.1 Características Eléctricas DC.
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Símbolo Parámetro Condición Mín. Típico. Max. Unid.
Entrada Analógica
Vi^ri)

VIN-DIFF

Vos (2)

AVos/AT

RIN
CIN
IB

SN

Rango de Voltaje de
entrada
Oscilación de voltaje
diferencial de entrada (2)
Voltaje diferencial
contrapuesto (Con
referencia a la entrada)
Variación de voltaje
diferencial contrapuesto
Resistencia de entrada
Capacitancia de entrada
Corriente de polarización de
entrada
Densidad de Ruido en el
Voltaje de entrada

Aplicado a VIN+ o VIN.

2| VIN* - V,N_ j

G = 10
G=l

-40 a +85UC

EnDC

A 10kHz, con referencia a
la entrada, G = 10

1

6

30
0.3

40

10a

2
1

28

4

200
2

V

VP.P

^v
mV

|,iV/0C

n
PF
PA

nV/V/&

Salida Analógica

VOUT±
VOUT-DIFF

IOUT
VCM

Rango de Voltaje de salida
Oscilación de voltaje
diferencial de salida (2)
Corriente de salida
Voltaje de salida en modo
común

Presente a VOUT+ o VOUT-
2{ VOUT+ - VOUT- |

Generador/Carga
(VoUTf + VOUT-)/2

0.1
9.6

10
2.495 2.5

4.9

2.505

i_v
VP.P

mA
V

Rendimiento Estático
G

AG/AT
PSR

Rango programable de
ganancia
Error de ganancia
Ganancia contrapuesta
Rechazo de Fuente de
Alimentación

Amplificador de ganancia
de entrada (1,2,5,10)
RL = 300O Diferencial
-40 a +85UC
Diferencial a 1kHz
Desbalanceado a IkHz

0

0.5
20
80
70

20

2.5

dB

%
Ppm^C
dB
dB

Salida de Referencia en modo común(VREFour)
VREFour

IREFour

Rango de Voltaje referencial
de salida
Voltaje referencial de salida
contrapuesto
Corriente de referencia de
salida

Ruido en el Voltaje
referencial de salida
Referencia de rechazo de
fuente de alimentación

Nominal 2500V

-40 a +85°C

(VREFour = ±l%)
Generador
(VREF0uT = ±l%)
Carga
Ancho de banda de
10MHz
IkHz

-0.2

50

50
350

40

80

0.2 %

ppm/°C

MA
mA

M-VRMS

dB

Programación
Borrado/Reprogramado de
ciclos

10K 1M Ciclos

I/O Digitales
VIL
VIH

IIL.IIH

VOL
VOH

Entrada de bajo voltaje
Entrada de alto voltaje

Corriente de Fuga de
entrada

Bajo voltaje de salida (TDO)
Alto Voltaje de salida (TDO)

OV<TCK,ENSPl,CAL
Input <VS

OV<TDI,MTS,CS Inputs
<VS
IOL = 4.0mA
loHs-1.0mA

0
2

2.4

0.8
Vs

-10/+40
-70/+10

0.5

V
V

PA
íoA

V
V



Tabla 2.2 Características Eléctricas AC.

Símbolo Parámetros Condición Min. Típico. Max. Unidades
Rendimiento Dinámico(4)

SNR

THD

CMRR

Señal a Ruido
(G=l lo 10)
Distorsión Total Armónica
(Diferencial)

desequilibrio

Diferencial
(FP = SOOkHz)
desequilibrio
(FP = SQOkHz)
Factor de Rechazo en Modo
Común
(VIN=1Vto4V)
Nota: VIN+y VIN-
conectados ambos

O.IHzto SOOkHz, FC =
SOOkHz

FlN = 10kHz,
VIN = 6Vp-p
FlN = 10kHz,
VIN = 6Vp-p

FlN= 100kHz.
VIN = 6Vp-p

FlN = 100kHz,
VIN = 6Vp-p

10kHz

100kHz,
FC= SOOkHz

50

86

»90

-80

»90

-74

60

60

-74

-74

dB

dB

dB

dB

dB

dB

dB

Características del Filtro (4)

FC

[FC]

AFC

AFC/AT

AFC/AV

Rango de programación de
frecuencia de esquina
Exactitud en el valor
absoluto de frecuencia de
esquina

Incremento máximo entre
frecuencias de esquina
(Calculadas)
Variación de frecuencia de
esquina con respecto a la
variación de la Temperatura

Variación de la frecuencia de
esquina con respecto a la
variación del suministro de
voltaje.

Filtro de la familia
Buílerworth

Desviación calculada desde
un punto de-3dB

FC = 50,200oSGOkHZ

SOkHz a SOOkHz

SOOkHz a 750kHz

FC = SOkHz

FC = SOOkHz

FC = SOkHz

50

0,6

0.6

0.9

0.03

0.05

0.09

750

3

3.7

5.3

Khz.

%

%

%

%/°C

%/v

Respuesta del Filtro Elíptico (5)
Ondulación FC = 50kHz
de banda FC =
pasante SOOkHz

0.1
0.5

dB
dB

Fuente de Alimentación
vs
IS

PD

Suministro de Voltaje en operación
Corriente de alimentación
Disipación de Potencia

VS = 5.0V
VS = 5.0V

4.75 5

33

5.25
40

210

V

mA
mW

Rango de Temperatura
Operación
Almacenamiento

-40
-65

85

150

DC

°c
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2.3.2 CONDICIÓN DE ENCENDIDO SPI (TNTERFAZ PERIFÉRICA SERIAL)

Cuando el ispPAC80/81 se enciende, el registro de cambio del ¡nterfaz SPI vuelve

siempre a cero. Esto significa que si el pin ENSPI está en alto al encender el

dispositivo, la configuración inicial presentará una ganancia de 1X (OdB) y se

seleccionará la configuración "A" como la configuración "pre-determinada". La

única manera de prevenir este comportamiento sería mantener el pin ENSPI en

bajo mientras se enciende el dispositivo. Este proceso es normalmente

imprácticoj por lo que se aconseja que cuando el ispPAC80/81 se use en modo

SPI, se recargue primero la configuración deseada (tipo de filtro y ganancia) cada

vez que se cumpla el ciclo de encendido del dispositivo en la configuración "A",

logrando mantener en memoria la nueva configuración y esta será la "pre-

determinada".

2.3.3 CONFIGURACIÓN A/B

Una de las propiedades más relevantes del ispPAC80/81 es poder guardar dos

configuraciones completas, gracias a la memoria NVRAM que dispone en su

circuitería interna. Por facilidad, Lattice, denomina a las configuraciones como "A"

y "B", las mismas que pueden ser seleccionadas, configuradas y descargadas al

dispositivo a través de! software de desarrollo PAC-Designer.

La elección de la configuración que actuará en tiempo real, se logra con la

interfaz del dispositivo en modo SPI (pines del ENSPI = nivel lógico alto). El

ispPAC80/81 lee datos a través de un cable de empalme de 8 bits en la forma

siguiente: cuatro bits tienen condición "NO IMPORTA", seguidos por un bit de

comando CAL; 1 bit para la fijación de configuración A o B y ios bits de ganancia

PG1 y PG2, cuyo uso se detalla a continuación:



Tabla 2.3 Secuencia de control de los Bits SPI

MSB

Bit-7

PG2

Bit-6

PG1

B¡t-5

A/B

Bit-4

CAL

LSB

Bit-3

X

Bit-2

X

Bit-1

X

Bit-0

X

BIT 7 PG2: Ganancia Programable del IA
(Vea la tabla 2 para el seteado)

BIT 6 PG1: Ganancia Programable del IA
(Vea la tabla 2.4 para el seteado)

BIT 5 A/B: Bit de configuración del filtro
0 = Usa la configuración de filtro 'A
1 = Usa la configuración de filtro 1B'

BIT 4 CAL: Inicia la secuencia de calibración
0 - Ningún efecto
1 = Inicia la secuencia de calibración y elimina el offset

BIT 3 X : Bit sin usar, asignado a cero

BIT 2 X : Bit sin usar, asignado a cero

BIT 1 X : Bit sin usar, asignado a cero

BIT O X : Bit sin usar, asignado a cero

Tabla 2.4 Ajuste de Bits de Ganancia

Ganancia

1X(OdB)

2X(6dB)

5X(14dB)

10X(20dB)

PG2

0

0

1

1

PG1

0

1

0

1
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2.3.4 BITS DE USUARIO JTAG

Existen varios bits de usuario configurados en la NVRAM del ispPAC80/81 que

controlan varios aspectos y que pueden ser accedidos a través de los menús

desplegables o directamente en la pantalla de diseño de! esquemático por medio

de la interfaz del PAC-Designer. La lista de bits de control para la memoria

NVRAM se muestra en la Tabla 2,5.

Tabla 2.5 Bits de Usuario para la Configuración del JTAG

Símbolo Nombre Descripción

Bit

FreqRange

Bit de Rango de

Frecuencia Hi/Lo

Depende de la frecuencia de corte, el bit para el rango

de frecuencia es automáticamente seteado dentro del

Pac-Designer para optimizar la respuesta de la

función de transferencia del ispPAC80/81. Existen dos

configuraciones A y B que pueden seleccionarse en el

Pac-Designer,

Bits UES User Electronic

Sign ature

(Firma eíectrónica de

usuario)

Son bits de uso exclusivo del usuario que se

encuentran en la memoria, para guardar información

de! dispositivo como referencia para configuraciones

futuras. Los ispPAC80/81 contiene 21 bits de UES.

Estos bits UES son accesibles dentro del Pac-

Designer.

Únicamente se asignan bits UES en configuración A.

Bits Cap Bits para selección

de capacitores

Son un juego de 70 bits que están disponibles para

modificarlos valores de capacitancia existentes en los

filtros que se configuran en el ispPAC80/81 (TV o 'B').

Bit A/B Selección de

configuración inicial

Con el bit de configuración inicia! A/B puesto en "A"

(lógica 0), eí dispositivo cargará la configuración

guardada por eí usuario en modo A. La designación

de la configuración A o B con la que se desea iniciar

el ispPAC80/81 debe ser establecida previamente en

el PAC-Designer.

Bits

PG1 &PG

Bits programables de

Ganancia

Únicamente con la configuración A. Puede

modificarse el control SPl. Refiérase a la Tabla 2.4.



ESF Fusible de seguridad

Electrónica

Activando este bit, la visualización de ía configuración

del dispositivo y las subsecuentes son desactivadas

(JTAG Verify commands). Pueden ser restablecidos

por un usuario de JTAG (USRA) borrando órdenes y

reprogramando el dispositivo. Esta característica se

emplea para prevenir lectura desautorizada de la

configuración del dispositivo.

2.3.5 I/O DIFERENCIAL

Dentro de las especificaciones de funcionamiento del ispPAC80/81, se encuentra

el voltaje diferencial que se debe suministrar al dispositivo a través de los pines de

entrada IN+ e IN- (10 y 11); y obtener una respuesta por los pines de salida

OUT+yOUT~(13y 14).

Para comprender mejor como trabaja en modo diferencial el ispPACSO/81, a

continuación se muestra la configuración de entrada del chip en la Figura 2.7 y a

continuación se realiza una breve descripción.

Vdiff (-)

Figura 2.7 Entrada y Salida Diferencial presentes en ef ispPAC80/81
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El voltaje diferencial se determina tomando en consideración el signo del voltaje

en ambos pines de entrada diferencial.

Por ejemplo, si V(+) igual a 4V y V (-) igual a 1V, el voltaje diferencial se define

como V(+) - V (-) = Vdiff, o 4V - 1V = +3V,

Puesto que cualquier polaridad puede existir en la entrada diferencial, también es

posible ei opuesto extremo, por ejemplo cuando V(+) es igual a IV y V(-) es igual

a 4V, entonces el voltaje diferencial es ahora 1V - 4V = -3V.

E! voltaje diferencial aplicado a los dos operacionales resulta ser la diferencia

absoluta entre los dos Vdiff extremos, debido a que se conectan en paralelo

opuesto. Empleando el ejemplo anterior resultaría entonces:

| (+3V) - (-3V) | = 6V.

Por consiguiente en cada uno de los pines de salida OUT+ y OUT- (13 y 14), se

tendrá un voltaje referido a tierra de 3V, uno en desfase con respecto al otro.

Pero al considerar el voltaje entre los dos pines se obtendrá una salida diferencial

equivalente a 6V.

Además de tener entrada y salida puramente diferencial, existe la posibilidad de

que la entrada, la salida o ambos sean asimétricos, debido a que pueden

conectarse señales asimétricas a la entrada del ¡spPAC80/81, y una de las dos

salidas diferenciales puede usarse para manejar circuitería asimétrica.

2.3.6 ENTRADA ASIMÉTRICA

Para conectar la entrada diferencial del ispPAC8(Y81 en forma asimétrica, una de

las entradas diferenciales necesita ser conectada a una fuente DC,

preferentemente VREFour (todos los dispositivos ispPAC una vez que se han

polarizado, presentan una tensión de referencia interna de 2.5 V, ia cual se puede

disponer en cualquiera de los pines de salida del dispositivo).



•s\a señal de entrada debe ser acoplada mediante un capacitor o debe tener un

nivel de polarización DC igual al nivel de DC de la otra entrada como se muestra

en la Figura 2,8. Puesto que el voltaje de la entrada se define como VIN+ - VIN -,

el voltaje en modo común se ignora. De esta forma la señal de información queda

conectada solo a una entrada, mientras la otra debe estar conectada a un voltaje

de referencia.

VR1BF,

Figura 2.8 Entrada diferencial acoplada con una fuente DC

2.3.7 SALIDA ASIMÉTRICA

Para conectar la salida a un circuito asimétrico se sigue un procedimiento más

simple. Basta con conectar una de las salidas diferenciales. Cualquier salida lleva

la señal de información, con un valor igual a la mitad de la magnitud de la salida

diferencial. El nivel DC referencial de la salida asimétrica será el VREF0ur- Si a la

carga no se le acopla en AC, y por lo mismo se encuentra bajo la acción de un

potencial DC distinto de VREFour, en la carga se obtendrá una corriente

constante. Usando una de las salidas diferenciales se dispone de la mitad de la

amplitud de variación del voltaje de salida (3Vpp vs. 6Vpp).
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2.3.8 RANGO DE VOLTAJE DE ENTRADA EN MODO - COMÚN

Para los ispPAC80/81, el máximo rango de entrada de la señal y el rango de

voltaje de modo-común se relacionan con la ganancia del PACBIock. El voltaje de

entrada máximo multiplicado por la ganancia de un PACBIock individual no puede

exceder el rango de salida de ese bloque, debido a que se pueden presentar

recortes. El máximo rango en la entrada es de 1V a 4V, con un rango típico

extendido de 0.7V a 4.3V para un voltaje de alimentación de 5V.

La entrada de voltaje en modo común es VCM = (V¡N+ + ViN-)/2 (Presente en todos

los amplificadores operacionales por las imperfecciones que muestran). Cuando

el valor de VCM es de 2,5V no hay grandes restricciones en la entrada, VIN+ y VIN,

pueden adoptar diferentes valores entre 1V y 4V, siempre que no excedan el

límite del VCM- Esto se logra fácilmente cuando la señal de entrada al

ispPAC80/81 es totalmente diferencial y referida a 2.5V; es decir V|N+ - VIN- =

Cuando el VCM no es de 2.5V y la ganancia fijada es mayor que uno, se

presentará distorsión cuando se alcanza el límite máximo de entrada para una

ganancia en particular.

El VIN más bajo para una ganancia previamente establecida es expresada por la

fórmula, VIN- = 0.675V+ 0.584G-V|N donde G es la ganancia fijada y V!N es el

voltaje de entrada pico, expresado como |VÍN+ - V|N-| y el V[N mas alto es V!N+ =

5.0V - VIN- donde 5V es el voltaje nominal de alimentación. En la Tabla 2.6, se

muestra el máximo VIN para un rango dado de VCM (empleando las ecuaciones

antes indicadas). Si el máximo V[N es conocido (el equivalente o máximo valor, se

ubica bajo la columna de ganancia apropiada); el rango mas amplio para VCM se

encuentra horizontalmente en las dos primeras columnas de la izquierda.

Solamente un rango VCM igual o menor que, presentará un rendimiento libre de

distorsión. Así mismo, si el máximo rango de VCM es conocido, el valor más alto

de pico aceptable de VIN puede ser encontrado en la columna de ganancia



correspondiente. Todos los valores de V!N menores darán una salida sin

distorsión.

Tabla 2.6. Limitaciones en el rango del voltaje de entrada en modo común

VCM- V'N++V'N-
2

V,N-

1.000

1.100

1.200

1.300

1.400

1.500

1.600

1.700

1.800

1.900

2.000

2.100

2.200

2.300

2.400

2.426

2.500

V,N+

4.000

3.900

3.800

3.700

3.600

3.500

3.400

3.300

3.200

3.100

3.000

2.900

2.800

2.700

2.600

2.574

2.500

Magnitud del Voltaje de entrada

VIN (Voltios-Rico)

G=1

0.557

0.728

0.899

1,071

1.242

1.413

1.584

1.756

1.927

2.098

2.270

2,441

2.612

2,783

2.955

3.126

G=2

0.278

0.364

0.450

0.535

0.621

0.707

0.792

0.878

0.964

1.049

1.135

1.220

1.306

1.392

1.477

1.563

G=5

0.111

0.146

0.180

0.214

0.248

0.283

0.317

0.351

0.385

0.420

0,454

0.488

0.522

0.557

0.591

0.625

G=10

0.056

0.073

0.090

0.107

0.124

0.141

0.158

0.176

0.193

0.210

0.227

0.244

0.261

0,278

0.295

0.313

Voltaje de entrada pico para garantizar rendimiento dado una ganancia.
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Como se mencionó anteriormente, el módulo de desarrollo posee un conector de

5 pines (¡nterfaz JTAG), el mismo que está destinado para facilitar ía

programación de! ispPAC80/81 directamente desde el puerto paralelo del PC, a

través del cable de descarga ispDOWNLOAD y el software de desarrollo.

2.4 CABLE ¡spDOWNLOAD

El cable ispDOWNLOAD es empleado para la programación de ios dispositivos de

Lattice ISP, e! cual presenta las siguientes características:

• Es diseñado para todos los productos ispPAC de la familia Lattice

• La programación se realiza empleando niveles de voltaje del.SV a 5V.

• Presenta conexión a interfaces USB(v1.0 y 2.0) o Puerto paralelo del PC

• Los conectores AMP, son de fácil uso y programación.

• La presentación de los conectores es de 2 x 5 (10 pines) o 1 x 8 (8 pines).

• La longitud del cable de programación flyware es de 2 metros.

Con el sistema de programación, las funciones del hardware pueden ser

modificadas y programadas en tiempo real sobre el módulo de desarrollo para dar

características adicionales al producto, acortando el plan de diseño y depurando

la programación del dispositivo.

Después de completar el diseño lógico y la creación de un archivo de

programación en el sistema de desarrollo de Lattice (PAC-Designer), el software

programa los dispositivos que se encuentran en el módulo de desarrollo.

Las señales de programación son generadas desde e! puerto USB o puerto

paralelo del PC y dirigida a través del cable ispDOWNLOAD hacia el dispositivo.

Con este cable y el conector en el módulo no se requiere de componentes

adicionales para la programación. El software automáticamente genera el

comando apropiado ISP, programando direcciones y datos desde el archivo de

información de la programación.
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A continuación se ilustran algunos ejemplos de cables ispDOWNLOAD para

diferentes interfaces de PC:

Cabie ispDOWNLOAD HW-USB-1A para programación a través del Interfaz

de una PC.
Cttof

Cable USB ispDOWNLOAD. Contiene 6 cables para el puerto USB, conectores

Flywire, un adaptador de conexión AMP de 8 pines (1 x 8) y un adaptador de

conexión JTAG de 10 pines (2 x 5). Soporta programación a 1.8V, 2.5V, 3.3V y

5V.

Cable ispDOWNLOAD pDS4102-DL2 para programación empleando el interfaz

de PC

To
PC

RJ-45 Cirmec»!
eteli

k—-1

EndVtew
of AMP CorrBCtur

r
L

Vcc

sDo
SEHÍTD*

PioJ

To

Boa id

Cable Paralelo ispDOWNLOAD. Contiene cable multípar con un terminal RJ45 y

un conector AMP de 8 posiciones además de un adaptador de puerto paralelo.

Soporta Programación a 2.5V, 3.3V y 5V.
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Cable ispDOWNLOAD HW7265-DL2 para programación mediante el interfaz

de PC.

T»
PC

WCKT

//

f_ .ff 1

M
&

F*v.( Rjuofcn
_ _ 2 _ J W C - - "

6 V3C
fi GMC-

"" " nj - -QÍÍS^

••
*"

• •

• •

piurtwn P*n* ?*)>• ñnch?»
TCK 1 1 TCK

rws 3 3 tus
¡ TW 5 > Svíosn 5 TOI [

TDO 7 "̂̂  7 TOO

TRSF s 9 msrr

"

"

B

•

Funcío
í«;
GH3

VCC
ÜMQ

EHAÍ

Cable Paralelo ¡spDOWNLOAD. Contiene un terminal RJ45, un conector JTAG

de 10 posiciones y un adaptador de puerto paralelo. Soporta programación a

2.5V, 3.3Vy5V.

Cable ispDOWNLOAD HW7265-DL3 para programación a través del interfaz

de una PC

To
PC

Giey
.Red

Yeitaw

Í5TE4SI

Black

Wlile

To

Cable Paralelo ispDOWNLOAD. Contiene un adaptador para puerto paralelo,

cable multipar con terminal RJ45, conectores Flywire, un adaptador de conexión

AMP de 8 posiciones (1 x 8) y un adaptador de conexión JTAG de 10 posiciones

(2 x 5). Soporta programación a 1.8V, 2.5V, 3.3V y 5V.

Este cable es uno de los más empleados para el enlace PC / módulo de

desarrollo a través del conector AMP 1x8 o 2x5; para este efecto se recomienda

emplear ia tabla de conexiones que se ilustra a continuación:
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Conector de Puerto

Paralelo

Pines

DB25

-

10

2

5

6

4

-

3

7

12

8

13

15

20

Función

-

TDO

TDI

ispEN

TRST

TMS

-

TCK

JTAG

DL1-ID

OUT

DL2-ID

VCC

GND '

Cable FIywire

Función

Vcc

TDO

TDI

ispEN

TRST

TMS

GND

TCK

-

Color

Rojo

Café

Anaranjado

Amarillo

Verde

Violeta

Negro

Blanco

-

Módulo

#Pin

1

2

3

4

5

6

7

8

-

Conecíor de

8 posiciones

Vcc

SDO/TDO

SDIATDl

ispEN

Sin conexión

(TRST)

MODO/TMS

GND

SCLK/TCK

-

#Pin

6

7

5

10

9

3

4

1

2

8

Conector de 10

posiciones

Vcc

TDO

TDI

Habilitado

TRST

TMS

GND

TCK

Sin conexión

GND(Sin

conexión)

El cable ispDOWNLOAD que se va a emplear para la programación en el

ispPAC80/81 es el Pds41Q2-DL2, que dispone de 2 metros de longitud, un

conector RJ45, un conector AMP 1x8 y un adaptador para puerto paralelo de PC.

El cable de descarga anteriormente descrito se conecta al interfaz JTAG que

dispone el módulo de desarrollo, el mismo que obedece al estándar 1EEE1149.1,

que se describe a continuación.
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2.4.1 JTAG - ESTÁNDAR IEEE 1149.1

El Estándar IEEE 1149.1-1990 fue producto del trabajo realizado por un grupo de

compañías interesadas en resolver básicamente el problema del acceso físico a

los pines de los circuitos integrados (IC) colocados sobre una tarjeta de circuitos

impresos.

Como las tarjetas de circuitos impresos crecen en complejidad y densidad de

componentes, debido a las constantes mejoras en las tecnologías de fabricación

de circuitos integrados y de las mismas tarjetas, resultan también más difíciles de

verificar, volviendo obsoletos los métodos tradicionales de detección de fallas

(como las puntas de prueba y los generadores de tramas). Por tales motivos, se

necesitan métodos más baratos y confiables para realizar pruebas de

conectividad entre los circuitos integrados montados sobre la tarjeta.

En 1980 el grupo JTAG (Join Test Action Group) comenzó a trabajar en una

especificación para el diagnóstico de circuitos impresos sobre tarjetas de circuitos

impresos mediante exploración de contorno (boundary-scan tesfíng) la misma

que luego se estandarizó en 1990 con el nombre '7EEE Std. 1149.1-1990 Test

Access Port and Boundary-Scan Architecture" (Norma IEEE 1149.1-1990, Puerto

de Acceso para Pruebas y Arquitectura de Exploración por el Contorno). Esta

norma se conoce abreviadamente como JTAG, por el nombre del grupo creador.

El estándar IEEE 1149.1-1990 (Standard Test Access Port and Boundary-Scan

Architecture) en resumen se define como: Electrónica que puede incorporar un

circuito integrado para asistir en el test, mantenimiento y soporte para placas de

circuito impreso. Esta circuitería incluye una interfaz estándar a través de la cual

se transfieren datos y comandos con los que ei componente puede responder a

un conjunto mínimo de instrucciones.

Esta lógica de test se usa principalmente para comprobar que:

• Los componentes funcionan correctamente
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• Las conexiones entre componentes son correctas

• Diferentes componentes interactúan correctamente en un circuito impreso

En sí, es un interfaz serie compuesto de dos líneas de datos (una de entrada, TDI,

y otra de salida, TDO) una ínea de reloj (TCK) una de reset (TRST) y otra de

modo (TMS).

La piedra angular del JTAG es el Boundary Sean Register o BSR, un registro de

desplazamiento que contiene tantas celdas como pines tiene el chip, lo que

permite, gracias a un controlador de estados llamado TAP Controller (Test Access

Port), acceder y cambiar el estado de cada uno de los pines del componente. Por

decirlo de forma sencilla, con las cinco líneas del bus JTAG de un ispPAC se

puede poner la combinación que se quiera de unos y ceros en las líneas del

dispositivo, forzándolo a comportarse como más convenga.

Tal como ya se ha indicado, el ispPAC80/81 es un dispositivo programable. Esto

se lleva a cabo mediante la integración de todos los circuitos en un chip

programable. Esta programación se logra a través de las 5-lineas que conforman

la interfaz serial del estándar IEEE 1149.1 como se mencionó anteriormente, y

que trabajan con los niveles de lógica normal. Una vez que el dispositivo es

programado, toda la información de configuración es almacenada en el chip, en

celdas de memoria no volátil NVRAM.

2.4.1.1 Programación del Puerto Serial

La comunicación con el ispPAC80/81 se realiza vía el pórtico de acceso JTAG

pero configurado para pruebas (TAP). Este es usado por el ispPAC80/81 como

una iníerfaz serial programable.

La opción puerto de acceso para pruebas (TAP) del IEEE 1149.1 provee el control

en la ¡nterfaz para el acceso digital serial de I/O al ¡spPAC80/81. El controlador del

TAP es un controlador de 16 estados cuyo reloj es TCK y su control TMS.
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Bajo el protocolo correcto, las instrucciones son sustituidas en concordancia a un

registro de instrucción, ei cual determina la entrada de los datos siguientes, salida

de datos y operaciones relacionadas.

La programación del dispositivo se realiza a través del registro de usuario,

cambiando los datos de entrada, y ejecutando el programa de instrucciones de!

usuario. Después, el dato es transferido a las celdas no volátiles que determinan

la configuración del ispPAC80/81. Debido a que el controlador del TAP es cíclico,

los datos pueden ser alterados fuera del registro de usuario para verificar la

configuración actual del ispPAC80/81. Existen instrucciones para acceder a todos

los registros de datos y para realizar operaciones de control interno.

Para compatibilidad entre dispositivos, las especificaciones del estándar

IEEE1149.1 asigna dos registros de datos. Otros se especifican por su

funcionalidad, pero su inclusión es estrictamente opcional. Finalmente, existen

registros opcionales de datos definidos por el fabricante. Los dos registros

requeridos son el de bypass y el registro boundary-scan. Para el ispPAC80/81,

el registro bypass es un registro de desplazamiento (1-bit) que proporciona un

camino corto a través del dispositivo cuando se esta realizando el boundary

testing u otras operaciones.

El ispPAC80/81 no tiene lógica de boundary sean (barrido de borde) y por tal

motivo no tiene este registro. Todas las instrucciones relacionadas a las

operaciones del boundary sean sitúan al ¡spPAC80/81 en el modo bypass para

mantener flexibilidad con la especificación.

El registro de identificación opcional descrito en IEEE 1149.1 también está

incluido en el ispPAC80/81. Un registro de datos adicional incluido en el TAP del

ispPAC80/81 es el registro de usuario definido por Lattice.

La Figura 2.9 muestra como la instrucción y varios registros de datos son situados

en unispPAC80/81.
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Figura 2.9 Registros TAP del ispPAC80/81

2.4.1.1.1 Controladores específicos del TAP

El TAP consiste de un pequeño controlador de 16 estados que es controlado por

el Test Clock (TCK) y las entradas de selección de modo de prueba (TMS). Estas

entradas determinan si se realiza una Instrucción de Registro o una operación de

Registro de Datos. En un estado dado, el controlador responde de acuerdo ai

nivel de la entrada TMS como se muestra en la Figura 2.10. El Test Data in (TD!)

y TMS están sujetas al flanco ascendente del TCK, con el Test Data Out (TDO)

llegan a ser validas en el flanco descendente del TCK. Existen seis estados

constantes dentro del controlador: Test-Logic-Reset, Run-Test/Idle, Shift-Data-

Register, Pause-Data-Register, Shift-Instruction-Register, y Pause-lnstruction-

Register. Pero existe únicamente un estado constante para ia condición cuando el

TMS esta seteado en alto: estado Test-Logic-Reset. Este permite un reseteo para

ia prueba lógica dentro de los cinco o menos pulsos del TCK para mantener la

entrada TMS en aíto. El Test-Logic-Reset es el estado por defecto en el

encendido.
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Figura 2.10 Diagrama de control de estados, TEST ACCESS PORT (TAPj

Nota: El valor mostrado adyacente a cada estado de transición en esta figura

representa la señal presente en el TMS al tiempo de un flanco ascendente del

TCK.

Cuando se aplica la secuencia lógica correcta a las entradas TMS y TCK, el TAP

saldrá del estado Test-Logic-Reset y se moverá al estado deseado. El siguiente

estado después del Test-Logic-Reset es Run-Test/Idle. No habrá acción en Run-

Test/ldle (idie = estado estacionario) hasta que se realice una instrucción de

búsqueda. Después del Run-Test/Idle, se realiza: una instrucción de búsqueda.

Los estados de los bloques de dato y registro de instrucción son idénticos entre sí

difiriendo solamente en sus puntos de entrada. Cuando cualquiera de los dos es

ingresado al bloque, la primera acción es una operación de captura. Para los

registros de datos, el estado de Captura-DR es muy simple: captura datos (cargas

paralelas) sobre el trayecto serial de datos seleccionado (previamente escogidos

por la instrucción apropiada). Para ¡a instrucción de registro, el estado de Captura-

IR siempre cargará ía instrucción IDCODE. Esto permitirá siempre disponer el

registro ID para la lectura sin que ninguna otra instrucción sea cargada antes de la

operación Shift-DR. Esto, en conjunción con los bits de código asignados,

permiten una interrogación "ciega" de cualquier dispositivo en una cadena serial

dócil IEEE 1149.1.
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Desde el estado de captura, el TAP realiza transiciones a cualquier estado de

Exitl o Shift. Normalmente el estado Shift permite al estado de Captura probar

datos, cambiar o renovar la información de status. A continuación, el estado Shift

y el TAP retornan al estado Run-Test/Idle vía Exitl y estados Update o ingresan

al estado Pause vía Exitl. El estado Pause es usado para suspender

temporalmente el cambio de datos a través del registro de datos o instrucciones

mientras se realiza una operación externa. Desde el estado Pause, los cambios

pueden reasumirse por el reingreso al estado Shift vía estado Exit2 o ser

terminados por el ingreso al estado Run-Test/Idle vía los estados Exit2 y Update.

Si la instrucción es apropiadamente cambiada durante una operación Shíft-IR, la

siguiente entrada en el Run-Test/ld!e inicia el modo de prueba (estado

estacionario = prueba). Esto ocurre cuando ei dispositivo es actualizado, borrado

o verificado. Todas las demás instrucciones son ejecutadas en el estado Update.

2.4.1.1.2 instrucciones de Prueba

Tal como en los registros de datos, ei estándar ÍEEE 1149.1 también decreta la

inclusión de ciertas instrucciones; tres requeridas: BYPASS (salto o paso de chip),

SAMPLE/PRELOAD (muestreo/precarga), y EXTEST (fijación de un pin a un valor

dado, con prioridad sobre el valor lógico de la salida), y seis opcionales que

dependen exclusivamente del fabricante.

Cada una de estas instrucciones tienen una longitud de palabra mínima de dos

bits, sin embargo, Lattice fija un Word length de 5 bits, siendo claramente

identificares las instrucciones de BYPASS cuya combinación presenta cinco

unos (11111), y la instrucción EXTEST todos ceros (00000). De aquí que se

puede decir que el ispPAC80/81 contiene un número de instrucciones requeridas

así como también un número de instrucciones opcionales.

Todas las instrucciones disponibles para usuarios del ispPAC80/81 son

mostradas en !a Tabla 2.8.
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Tabla 2.8 Instrucciones TAP ispPAC80/81

e

instrucción

EXTEST

ADDUSR

ABE

BBE

VERA

VERB

PROA

PRGB

ENCAL

IDCODE

SAMPLE

BYPASS

Código

00000

00001

00010

00011

00100

00101

00110

00111

01100

01101

11110

11111

Descripción

External test. Default

to BYPASS.

Registro de datos de

dirección de usuario

Address user data

register(Aor B).

Usuario A bulk erase.

Usuario B bulk erase.

Verificación de

registro de datos de

Usuario A

Verificación de

registro de datos de

Usuario A

Programa de registro

de datos de usuario A

Programa de registro

de datos de usuario

B.

Habilita secuencia de

calibración.

Lee registro de datos

de identificación.

SAMPLE/PRELOAD

a BYPASS.

Bypass (conecta TDI

a TDO).
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2.4.1.2.3 BYPASS

Es una de las tres instrucciones requeridas. Esta selecciona el Registro de

BYPASS para ser conectado entre TDI y TDO y permitir que los datos seriales

sean transferidos a través del dispositivo sin afectar ia operación del

¡spPAC80/81. El código de bit de esta instrucción se define como todos unos

según el estándar !EEE 1149.1.

La instrucción SAMPLE/PRELOAD ordena al Registro Boundary-Scan a ser

conectado entre TDI y TDO. El ispPAC80/81 no posee registro Boundary-Scan,

así que para la compatibilidad este predefine el modo BYPASS siempre que la

instrucción sea recibida. El código de bit para esta instrucción es definido por

Lattice, como se muestra en la Tabla 2.8.

Cuando la instrucción EXTEST (prueba externa) es requerida pondría

normalmente al dispositivo dentro de un modo externo de boundary test,

habilitando mientras tanto al Registro Boundary-Scan a ser conectado entre TDI y

TDO. Además, desde que el ispPAC80/81 no tiene lógica de boundary-scan, el

dispositivo es puesto en el modo BYPASS para asegurar ía especificación de

compatibilidad. El código de bit de esta instrucción, todos ceros, se define por el

estándar IEEE 1149.1.

La instrucción opcional IDCODE (código de identificación) es incorporada en el

ispPAC80/81 y deja al dispositivo en su modo funcional cuando se la ejecuta.

Esta selecciona el Registro de Identificación del Dispositivo para ser conectado

entre el TDI y TDO.

El Registro de Identificación es un registro de desplazamiento de 32 bits que

contienen información con respecto a la fabricación del Cl, tipo de dispositivo y

código de versión (Figura 2.11).
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MSB LSB
XXXX/ 0000 0001 00100000/00000100001 /1

Número de Dispositivo
(16 bits) / Valor Constante

0120h = PAC80
0121h = PAC81

Fabricante de JEDEC
Cod. Identificación para

Versión Lattice Semiconductor

Figura 2.11 Código de Identificación (IDCODE).

32-Bits Palabra binaria para Lattice ispPAC80/81.

• El acceso al registro de Identificación se habilita inmediatamente, por medio de
8

una operación de búsqueda del controlador TAP, después de haber encendido el

dispositivo, o por la emisión de la instrucción Test-Logic-Reset. El código de bit

para esta instrucción se define por Lattice como se muestra en la Tabla 2.8.

La instrucción ADDUSR (registro de dirección de usuario) selecciona el registro

de usuario a ser cambiado durante una operación Shift-DR. La operación normal

de un dispositivo no es interrumpida por esta instrucción. Este precede una

instrucción PRGA o PRGB (programa de usuario A o B) para cambiar en una

configuración nueva desde el registro de usuario dentro de cualquier
<5

configuración de memoria A o B, y continúa una instrucción VERA o VERB

(verificación de usuario A o B) para remplazar la configuración actual de cualquier

configuración de memoria A o B dentro del registro de usuario.

El código de bit para esta instrucción se muestra en la Tabla 2.8.
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2.4.1.1.4Programación de Usuario A o B

PRGA y PRGB son instrucciones que habilitan los cambios de datos dentro del

registro de usuario para ser programados dentro de la memoria RAM del

¡spPAC80/81 y por consiguiente altera cualquiera o ambas de sus dos

configuraciones de usuario.

El registro de usuario es un registro de desplazamiento de 96-bits que contiene

todos los datos paramétricos controlados por el usuario pertenecientes a la

configuración del ¡spPAC80/81.

Nota: Aunque la longitud del registro de usuario es de 96 bits, solamente la

configuración "A" es la extensa.

El dispositivo de ganancia, fija los bits DES, y ESF que son parte de la

configuración "A" y no son almacenados en toda la memoria cuando se realiza la

configuración "B".

Cuando inicialmeníe se programa o reprograma el ispPAC80/81 con otro

software diferente del PAC-Designer, o un programador tercerista autorizado (Ej.

vía microcontrolador), la operación normal del dispositivo se interrumpe durante el

tiempo de programación vigente. Una operación de programación no empieza

hasta ingresar e! estado Run-Test/Idle. El tiempo requerido para asegurar la

retención de datos está dado en la tabla de especificaciones de la señal TAP.

El usuario debe asegurarse que el número de veces recomendadas de

programación sean registradas. El código de bit para aquellas instrucciones se

muestra en la Tabla 2.8.

2.4.1.1.5 Verificación de Usuario AoB

VERA y VERB son las siguientes instrucciones de Lattice y causan que las

configuraciones vigentes A o B del ispPAC80/81 sean cargadas dentro del
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registro de usuario. Esta operación no interrumpe la operación del dispositivo. La

configuración actual de cada configuración de memoria A o B puede ser movida

del registro de usuario inmediatamente luego de ejecutar la instrucción ADDUSR.

Nota: La verificación de la configuración de memoria "A" es posible solo cuando

el bit A/B se pone en O lógico.

Esto debe ser tomado en cuenta, para realizar verificaciones con configuraciones

desconocidas (refiérase a la nota de aplicación de Lattice que cubre los

algoritmos necesarios requeridos para completar e! dispositivo JTAG de control de

programación del ispPACSO/81, asignaciones de bit específicos, longitudes de

palabra, etc.).

Si el bit A/B se ha puesto en lógica 1, no será posible ejecutar ei comando VERA

adecuadamente. El código de bit para esta instrucción es mostrado en la Tabla

2 0
.O.

2.4.1.1.6 Calibración Habilitada

ENCAL es una instrucción de Lattice que habilita la salida de una secuencia de

auto-calibración.

Esta operación ocasiona que todas las salidas del dispositivo vayan a 2.5V hasta

que se complete la secuencia de calibración (ver en especificaciones de tiempo

Tabla 2.9 y Tabla 2.10). AI igual que con las instrucciones de programación

anteriores, la calibración no empieza hasta que se ingrese el estado Run-

Test/ldle. El cumplimiento de la calibración no es dependiente, sin embargo, lo es

en cualquier comando de control TAP. Esto significa que el estado TAP puede ser

devuelto inmediatamente al estado Test-Logic-Reset.

La única consideración sería el no cronometrizar el TAP durante las operaciones

analógicas criticas. Los primeros miíisegundos de la rutina de calibración son

consumidos en la espera por las configuraciones a establecer, aunque, deja
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bastante tiempo a cronometrizar el TAP al retornar del estado Test-Logic-Reset.

El código de bit para esta instrucción se muestra en la Tabla 2.8.

2.4.1.1.7 Borrado Completo Usuario A oJ3

Las últimas instrucciones de Lattice son ABE y BBE, La operación del dispositivo

es interrumpida durante una ABE o BBE, durante ia cual todas las entradas son

desconectadas y todas las salidas son conducidas a VREFOUT 2.5V. Para

economizar la circuitería interna, la programación puede solamente ser hecha

selectivamente en una dirección (de ceros a unos).

El ABE y BBE son usados para devolver todos los bits de usuario a estado de

cero al mismo tiempo. Un ABE o BBE usualmente procede a una operación

PRGA o PRGB, de lo contrario los cambios de uno a cero no podrían ser

¡mplementados. También puede usarse para borrar toda la información de

configuración de un dispositivo y puede ser la condición predefinida de partes

enviadas por la fábrica. Los mismos vínculos de tiempo de programación aplican

a ABE y BBE en cuanto a PRGA y PRGB, El código de bit para ésta instrucción

se muestra en la Tabla 2.8.

Las instrucciones ADDUSR, BYPASS, EXTEST, IDCODE y SAMPLE/PRELOAD

son todas ejecutadas en el estado Update-IR. Otras instrucciones como:

PRGUSR, VERUSR y UBE son ejecutadas en la entrada al estado Run-Test/ldíe.

Es recomendable que cuando todas las operaciones de interfaz serial sean

completadas, el controladorTAP se resetee y se deje en estado Test-Logic-Reset

(el encendido predefinido) y se desocupen las entradas TCKy TMS.

Esto asegurará el mejor desempeño analógico, minimizando en lo posible ¡os

efectos de lógica digital "conexión-interfacial (los dos lados de un circuito

impreso)".
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Tabla 2.9 Especificaciones de Tiempo (Modo Interfaz JTAG)

TA=25°C;

Símbolo Parámetro Condición Min. Typ. Max. Unid.
Rendimiento Dinámico

tckmin
tckh
tckl

tmss

tmsh

tdís

tdih

tdozx

tdov

tdoxz

tpwp

tpwe

tpwcah

tcalmin

tpwca!2

Periodo mínimo de Reloj
Tiempo alto TCK
Tiempo bajo TCK
Tiempo de
establecimiento TMS
Tiempo de retención TMS
Tiempo de
establecimiento TDI
Tiempo de retención TDI
Retardo Válido a TDO
Float
Retardo Válido TDO
Retardo Flotante a TDO
Valid
Tiempo para una
operación de
programación
Tiempo para una
operación de borrado
Tiempo para una
operación de auto-cal en
el encendido
Duración de pulso mínimo
en auto-cal

Tiempo para una
operación de auto-cal
iniciada por el usuario

Ejecutado en
Run-Test/Idle

Ejecutado en
Run~Test/ldle
Ejecutado
automáticamente
en el encendido

Ejecutado en ei
flanco
ascendente del
CAL

200
50
50

15

10

15

10

80

80

40

60

60

60

100

100

250

100

ns
ns
ns

ns

ns

ns

ns

ns

ns

ns

ms

ms

ms

ns

ms

tckmin

TCK

IfTISS

TMS

tmss

Run-T«#Wle staíe) rr

{Note: CAL intemally
ínib'aíed at device tumbón.)

TDO

Nota: Durante la programación del dispositivo en modo JTAG, la respuesta de la

salida analógica se desviará de ia conducta esperada. Esto es porque toda
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la información de la configuración se borra y se re-escribe como parte de

un ciclo de programación normal, momentáneamente el dispositivo cambia

los parámetros del filtro y por ende de ganancia. Durante el borrado, se

puede esperar un descenso en la frecuencia de esquina y un cambio

automático a una ganancia de 10X (por la especificación, mínimo 80ms) y

continuará hasta que los bits vayan a su estado final después de que se

emitan los comandos de escritura al JTAG (menos de 2ms, aunque el ciclo

de escritura debe mantenerse por alrededor de 80ms para lograr la

retención de los datos).

Tabla 2.10 Especificaciones de Tiempo (Modo Interfaz SPI)

TA=25°C;

Símbolo Parámetro Condición Min. Typ. Max. Unid.
Rendimiento Dinámico

tckmin
tckh
íckl
tcss

ícsminhi
tdis
tdih

tdozx
tdov
tdoxz

Periodo mínimo de Reloj
Tiempo alto TCK
Tiempo bajo TCK
Tiempo de establecimiento CS
Duración de pulso mínimo CS
Tiempo de establecimiento TDI
Tiempo de retención TDI
Retardo Válido a TDO Flota
Retardo Válido TDO
Retardo flotante a TDO Valid

200
100
100
20
40
15
10

60
60
60

ns
ns
ns
ns
ns
ns
ns
ns
ns
ns

tcknúrc ickh tckl

TCK

Iclls

ícss

tesrrinla

TDI

TDO

tdozx

hi-z

idov



Luego de haber descrito el módulo de desarrollo y analizar el funcionamiento de

los componentes que posee, haciendo hincapié en las características técnicas del

ispPAC80/81, se ha logrado mostrar las facilidades que brinda su manipulación y

tratamiento, así como también, el modo de operación del Cl.

El siguiente capítulo, hace referencia al software de desarrollo que se empleará

para la programación del dispositivo, con la finalidad de brindar al usuario las

facilidades para la administración de esta herramienta.
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CAPITULO 3

SOFTWARE PAC-DESIGNER

3.1 INTRODUCCIÓN

Para configurar los diseños en el ispPAC80/81 y comprobar la respuesta ha

lograrse, se emplea un programa compatible con Microsoft Windows denominado

PAC-Designer.

El PAC-Designer cuenta con una base de datos para la configuración de filtros;

con la que se pueden realizar disposiciones diferentes. El software lista las

posibles opciones de arreglo para los diseños, las mismas que pueden cargarse

directamente en los modos (A/B). Estas opciones se pueden encontrar con gran

facilidad en las barras de tareas que se describe posteriormente.

Este software es un sistema de desarrollo autónomo para el diseño analógico. La

programación, ingreso y simulación son todos completados desde el PAC-

Designer.

El control del diseño, como la selección de los pines de conexión, ganancia y

selección de valores son fácilmente llevados a cabo a través del Mouse, o a

través de cuadros de diálogo.

Para ayudar en ia implementación del diseño, Lattice suministra con el PAC-

Designer un cable ispDOWNLOAD que le permite al usuario programar el

dispositivo ispPAC.

En la Figura 3.1, se muestra el flujo de desarrollo de PAC-Designer, el cual

representa la interacción entre el software (PAC-Designer), y cada uno de sus

funciones.



51

Las líneas de entrada al software representan los mecanismos que emplea para

el desarrollo de los diseños, tal es el caso del archivo de librería que se utiliza

para obtener las configuraciones por desarrollar; la ímplementación de macros

para cumplir funciones nuevas o propias del sistema; y, la información que envía

el módulo de desarrollo al PAC-Designer para recuperar el contenido de la

memoria.

Las líneas de salida en cambio, sintetizan la interacción entre el programa y los

diferentes servicios que presta, así por ejemplo, la comunicación que existe entre

e! computador y el módulo; la simulación para la interpretación de ios datos

programados; y finalmente, los archivos de reportes y programación que son

documentos con contenido de esquemáticos (*.TXT / *.CSV); y, archivos para

exportar el modelo de ispPAC a un software diferente a! PAC-Designer

(*.SVF/*.JED).

Bestgn
Biíry

ispPAC80/81
Módulo de desarrollo

Progransmíng
Files

Figura 3.1 Diagrama de Flujo del PAC-Designer
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3.2 ADMINISTRACIÓN DEL PAC-DESIGNER

3.2.1 PROCEDIMIENTOS PARA EL MANEJO DEL PAC-DESIGNER

3.2.1.1 Creación de un nuevo esquemático

Se puede crear un nuevo esquemático, siguiendo el procedimiento que se

indica:

1. Del menú Archivo (File) se escoge la opción Nuevo (New), un cuadro de

diálogo de Esquemático Nuevo (New Schematic) se abre.

2. Se selecciona en el cuadro del esquemático del dispositivo ispPAC que

se disponga.

3. Con la opción OK, la ventana de esquematización es creada para el

dispositivo correspondiente.

3.2.1.2 Edición de un esquemático para el ispPAC80/81

El esquemático del ispPAC80/81 (Figura 3.2) permite simplemente con un clic y

a través de cuadros de diálogo poner los parámetros necesarios para la

configuración como: ganancia, Bits DES, valores de capacitancia, etc.

Al hacer doble clic sobre cada símbolo de la Ventana de Esquematización se

invoca el cuadro de diálogo correspondiente para revisar o modificar su

contenido.
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IA Gain Stacje

Wake Up
Configuraron

A-Filter Configuraron B-Filter Configuraron

Figura 3.2 Esquemático del ispPAC80/81 en el PAC-Designer

Las áreas que incluye el PAC-Designer y que pueden revisarse dentro del

esquemático son:

3.2.1.2.1 Fase de IA:

Incluye el Bloque de Ganancia con valores de: 1, 2, 5,10.

Polaríty fie Gaín Leve!;

2
5
ID 'Cancel
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3.2.1.2.2 Configuración de Arranque (Wake. Up):

La configuración del wake up determina que filtro es activo después de encender

el dispositivo.

El ispPAC80/81 tiene 2 configuraciones posibles de filtros que pueden ser

cargadas en la memoria E2CMOS que posee el dispositivo.

Wakeup Configuraron m...

A is wakeup confígur-atíon

B is wakeup ccnfíguration _

Note: When the B configuralion'is sefected the A 'j(*
configúrate cannot be verífied after dpwnload. •'

3.2.1.2.3 Bits UES: Firma Electrónica de Usuario

Los bits UES se programan por el usuario para el control del ID u otro tipo de

información del dispositivo.

bitl O
bit2 O
bH3 O
bit4 O
bit5 O
bitG O
bit? O

oggle
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3.2.1.2.4 Configuración del Futro A y B:

CfgA y CfgB representan las configuraciones de los filtros guardadas dentro del

dispositivo.

Al hacer doble clic en CfgA o CfgB se invoca al cuadro de diálogo para la

configuración del filtro, que posteriormente se muestra.

3.2.1.3 Utilidades de Diseño

Se puede usar las Utilidades de Diseño (Design Utility) para modificar el

esquemático de un ispPAC80/81.

Procedimiento para empezar a operar con el Design Utility:

1. En la ventana principal del esquemático del ispPAC80/81 se debe abrir la

opción Design Utilitied del menú Herramientas (Tools) para visualizar el

cuadro de diálogo.

2. De la lista que aparece en el cuadro de diálogo, se puede seleccionar la

Configuración para el filtro que se está implementando.

3. Se debe Presionar el botón OK para terminar el proceso.

3.2.1.4 Uso de las utilidades de los filtros del ispPAC80/81

La base de datos que dispone el PAC-Designer para diseño de filtros en el

ispPAC80/81 tiene más de 8000 configuraciones.

Se pueden usar las utilidades de los filtros deí ispPAC80/81 mediante los pasos

que siguen:
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1. En una ventana de esquematización abierta, se deben iniciar las

utilidades de diseño, tal como se explicó anteriormente.

2. Se invoca el cuadro de diálogo de Criterio de Filtro (Filter Criteria),

mediante un clic en la opción tipo de filtro (Filter Type) de la lista

despíegable de las utilidades de diseño, o, se debe escoger el criterio de

filtro (Filter on filtertype...) del menú View.

3. La configuración se selecciona a través de un clic en una de las líneas de

la lista que aparece en la ventana de configuración.

4. Con la secuencia Edit->Copy Filter Configuration to the Schematic, o

mediante un doble clic en el ID del filtro deseado, aparecerá el cuadro de

diálogo de Copia de Configuración de filtro (Copy Filter Configuration).

5. Seguidamente se debe escoger el síot de memoria A o B al cual se

trasladará la configuración, entonces al pulsar el botón OK, el

esquemático estará listo con el Filtro designado.

3.2.1.5 Importación de Datos al Esquemático del PAC-0esigner

Se puede importar varios tipos de datos, en varios formatos, al esquemático del

PAC-Designer para lo cual, se debe regir a los lineamientos:

1. Abrir el cuadro de diálogo de importación empleando el comando Import

del menú File.

2. Seleccionar una de las opciones Schematic o Plot Data del menú

despíegable ImportWhat

3. En el recuadro In This Format, escoger el formato del archivo a ser

importado.

4. En el recuadro Import From, buscar el archivo que va a importar.

5. Presionar el botón OK.
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3.2.1.6 Exportación de datos desde el Esquemático del PAC-Designer

Se puede exportar varios tipos de datos, en varios formatos, del esquemático dei

PAC-Designer. Para exportar los datos del esquemático del PAC-Designer se

recomienda:

1. Escoger el comando Export de! menú File para abrir el cuadro de diálogo

de Exportación.

2. Seleccionar una de ias opciones Schematic o Plot Data del menú

desplegable Export What.

3. En el recuadro In This Format, escoger el formato del archivo a ser

exportado.

4. Si se desea exportar los datos a un archivo, escoger la opción File del

área Export to, y busque ei archivo de datos que desea exportar con el

botón Browse.

5. Se puede exportar los datos al portapapeles del PC, para esto se debe

escoger ía opción Clipboard del área Export to.

6. Presionar el botón OK.

3.2.1.7 Exportación de un SpiceNetlist desde el PAC-Designer

El PAC-Designer tiene la capacidad para exportar un netlist al PSpice. El netlist

representa el esquemático activo y contiene todos los parámetros del circuito

necesarios para simular el diseño en el PSpice.

Los netlist deben tener ei mismo nombre como el archivo del design y deben

usar la extensión .lib.

Un modelo de la parte gráfica dei dispositivo se localiza en el subdirectorio Spice

del PAC-designer y usa la extensión .olb. Incluyendo ei netlist y el archivo OLB
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en el diseño del PSpice, puede usarse para construir circuitos para la simulación

gráfica.

Pasos para exportar un Spice Netlist desde el PAC-Designer:

1. Escoger el comando Export del menú File para desplegar el cuadro de

diálogo de Exportación.

2. Seleccionar el formato Spice Netlist y teclear el nombre del archivo del

netlist que se requiere.

3. Pulsar 'OK1 para exportar el netlist.

El nombre de! subcircuito generado será igual que el nombre del archivo, con

excepción de la extensión que es suprimida. Cuando el PAC-Designer exporta

un netlist en el Spice, ajusta los parámetros de los componentes usados en el

netlist para reflejar el diseño activo.

Por ejemplo, si se diseña un filtro biquad de SOkHz con un ispPACIO, y se

exporta el diseño al Spice, el subcircuito generado se simulará como un filtro de

biquad de SOkHz. Debido a que el PAC-Designer genera un subcircuito de Spice

para emparejar el diseño en la pantalla, es innecesario entrar en el netlist y el

'tweak1 de los parámetros para conseguir que el modelo generado se comporte

adecuadamente. Otra consecuencia de esto es que el netlist generado es único

para cada diseño. Si se hace cualquier cambio a un diseño en el PAC-Desígner,

es necesario reexportar un nuevo netlist para ese diseño y recargar en el Spice

para que los cambios sean efectivos.
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3.2.2 INTERFAZ DE USUARIO

3.2.2.1 Ventanas

3.2.2.1.1 Ventana Principal

Cuando se inicia el PAC-designer, la ventana principal se despliega. De este

cuadro de diálogo, se pueden crear nuevos archivos, o abrir diseños existentes.

i £ile View Qptions Help

3.2.2J.2 Ventana de Esquematización del ispPAC80/81

La ventana de esquematización del ispPAC80/81 permite revisar los valores de

ganancia y las configuraciones seleccionadas de filtro en las Utilidades del Filtro
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(Filter Utility ). Los Diseños pueden ser grabados, simulados o transmitidos a

un dispositivo ¡spPAC80/81.

3.2.2.1.3 Ventana de Configuración de Filtros en el ispPAC80/81:

&Ü DesignG: Filter Configurations

1
2
3
4
5
6
7
8
9
10
1)
12
13
14
15
16
17
18
.iqrr]r™

Bessel
Bessel
Bessel
Bessel
Bessel
Bessel
Bessel
Bessel
Bessel
Bessel
Bessel
Bessel
Bessel
Bessel
Bessel
Bessel
Bessel
Bessel

tefL

50.33kHz
St.lOkHz
SMSkHz
52,02kHz
52,47kHz
53,GlkHz
53.54l<Hz
53,90l<Hz
54.5í!íl<Hz
55.02kHz
55,51kHz
55.92kHz
56.56kHz
56,97kHz
57.4 6kHz
57.32kHz
58,39kHz
59,16kHz

^^^^p3kfe^^^

-H.OQdB
-14.07dB
-14.07dB
-14.04dB
-H.OOdB
-14.04dB
-14.09dB
-14.04dB
-14.1QdB
-14.06dB
-14.04dB
-H.OldB
-H.06dB
-H.OldB
-H.lldB
-13.94dB
-H.02dB
-H.09dB

-79.00dB
-79.1ódB
-79.09dB
-79.15dB
-79.07dB
-79.15dB
-79,14dB
-79.08dB
-79,18dB
-79.10dB
-79,09dB
-79.03dB
-79.13dB
-79.03dB
-79.10dB
-78,96dB
-79,04dB
-79,17dB

x^^;m^:m^m^

i

ii
1 J
, i1 i

í

-
í

1

f J
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El área gris de títulos presenta las columnas de Criterio de Filtro. Solo haciendo

un clic en un título de la columna (o escogiendo el criterio del filtro deseado dei

menú View) se despliega la ventana de diálogo de Criterio de Filtro (Filter

Gritería). El cuadro de diálogo puede usarse para escoger entre diferente tipos

de filtros disponibles. Arrastrando e! puntero del Mouse entre las columnas

(cuando se muestra doble-flecha) se modifica el ancho de cada columna. Las

cabeceras de las columnas también se muestran en el menú desplegable View

de la ventana de Configuración de Filtro. El área en blanco sostiene los datos

de configuración para diversos filtros. La primera fila se resalta cuando no existe

configuración cargada en el esquemático, caso contrario aparece sombreada la

fila a la que corresponda la configuración que posee e! dispositivo.

3.2.2.1.4 Ventana de Simulación - ispPAC80/81

La ventana que se ilustra a continuación es una ventana de simulación para el

ispPAC80/81.
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La ganancia y fase están en dos píanos, separados por una barra movible. La

Ganancia está en el plano superior al de la fase. Para agrandar una de las áreas

de graficación, se selecciona la barra movible y se arrastra hasta el sitio

deseado, o hasta que la respuesta de fase o la de ganancia adquieran el tamaño

deseado.

El eje vertical (Y) del plano de ganancia y fase pueden aumentar de tamaño

individualmente. El plano activo de la ventana de graficación se distingue por

presentar el título Ganancia o Fase resaltado (Gain/Phase). Un total de cuatro

(4) curvas pueden ser graficadas simultáneamente dentro de cada documento

esquemático. Éstos se despliegan en la Ventana de Simulación.

La Curva Activa se indica al "presionar" el botón "numerado" en la barra de

herramientas.

3.2.2.2 Menús

3.2.2.2.1 Mena de Archivo (File)

E! menú de Archivo (File), presenta los siguientes comandos:

Comando Descripción Atajos

New

Nuevo

Crea un Nuevo archivo de

Diseño o archivo JTAG, con la

extensión *.pjc.

Barra de herramientas

03
Teclado: Ctrl+N

Open

Abrir

Abre archivos de diseño o

archivos JTAG, con la extensión

Barra de herramientas:
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\. Teclado: Ctrl+O

Glose

Cerrar

Cierra los archivos asociados a

la ventana activa.

Save

Guardar

Muestra el cuadro de diálogo

Save As, y permite guardar en

disco, el archivo esquemático

existente con la extensión *. pjc.

Barra de herramientas:

Teclado: Ctrl+S

Save As

Guardar como

Muestra e! cuadro de diálogo

Save As, y permite guardar en

disco, el archivo esquemático

existente con la extensión *. pjc.

Save ABEL File

Guarda el archivo

ABEL

(Disponible solo cuando la

ventana ABEL Sourse esta

abierta.)

Muestra el cuadro de diálogo

Save As, y permite guardar en

disco, el archivo ABEL existente

con la extensión *. abl.

Barra de herramientas:

Teclado: Ctrl+S

Save ABEL File As

Guardar el archivo

ABEL como

(Disponible solo cuando ia

ventana ABEL Sourse esta

abierta.)

Muestra el cuadro de diálogo

Save As, y permite guardar en

disco, el archivo ABEL existente

con la extensión *. abl.

Import

Importar

Importa un diseño desde el

archivo JEDEC.



Export

Exportar

Exporta un esquemático o

información sumaria desde el

diseño actual. Soporta los

siguientes tipos de archivo:

• Archivo JEDEC

• Archivo Serial

Vector(.svf)

• Estructura de Texto

Browse Library

Explorar librería

Abre eí cuadro de diálogo PAC

Library Browser, que permite

buscar archivos en ios

subdirectorios de la Librería.

Summary Info

Resumen

de información

Permite desplegar y revisar la

un resumen de la información

del diseño.

Page Setup

Configuración

de página

Configura el formato de la

página para imprimir, incluyendo

títulos, comentarios, etc.

Print Preview

Vista Preliminar

Permite ver en pantalla lo que

se va a imprimir.

Print Setup

Configuración

de impresora

Muestra ei cuadro de diálogo

para configuración de

impresora, permite seleccionar

impresora, tamaño de papel, y
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orientación de página.

Print

Impresión

Imprime la ventana activa de

acuerdo a las condiciones

seleccionadas en Page Setup.

Barra de herramientas:

Teclado: Ctrl+P

Exit

Salir

Cierra el

Designen

software PAC-

3.2.2.2.2 Menú de Edición

El menú de Edición (Edit) contiene los siguientes comandos:

Comando Descripción

Clear Schematic

Borrar

esquemático

Reestablece el contenido inicia! al esquemático, como un

nuevo archivo (solo en la ventana de esquematización). No

altera los archivos ni cambia el nombre de la ventana de

esquematización.

Security

Segundad

Permite revisar el estado del bit de seguridad. Poniendo

esta opción se desactiva la habiiidad de cargar o verificar

datos válidos de un dispositivo una vez que se realiza la

descarga. La única manera de abrir un dispositivo es

transmitir la configuración sin tener seleccionada la

seguridad.

Symbol

Símbolo

Permite editar los símbolos del esquemático, usando el

cuadro de diálogo Edit Symbol.
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Cuando se realiza la simulación de un diseño, el menú de edición en este modo

omite el comando Clear Schematic.

3.2.2.2.3 Menú Ver

El menú View contiene ios siguientes comandos:

Comando Descripción Atajos

Redraw

Redibujar

Redibuja la ventana actual.

Zoom In Select Habilita e! "Acercamineto".

El cursor cambia a modo

"zoom"

Barra de Herramientas:

Zoom Previous Muestra el área última, del

stack de áreas previamente

aumentadas de tamaño o

reducidas de tamaño.

Barra de herramientas:

Zoom All Muestra el esquemático

completo.

Barra de herramientas:

Zoom Out Retrocede para alcanzar

una vista más amplia.

Permite activar o desactivar

la visualización de la barra

de herramientas.



de herramientas

PLD Toolbar

Barra de

herramientas PLD

Permite habilitar o

desactivar la visualización

de la barra de herramientas

de PLD.

Browser Bar

Barra de exploración

Permite habilitar o

deshabilitar la visualización

de la barra de exploración.

Status Bar

Barra de Estado

Permite habilitar o

deshabilitar la visualización

de la barra de estado.

3.2.2.2.4Menú Ver-Modo de Simulación

Ei menú View en el modo de simulación contiene los siguientes comandos:

Comando Descripción Atajos

Redraw Redibuja la ventana actual

Zoom In Select Habilita el "Acercamineto", El

cursor cambia a modo "zoom"

Barra de Herramientas

Zoom Previous Muestra el área última, del

stack de áreas previamente

aumentadas de tamaño o

reducidas de tamaño.

Barra de Herramientas

Zoom Al I Muestra el

completo.

esquemático Barra de Herramientas



Zoom ln>X25% Acercamiento del 25% solo en

el eje X.

Zoom ln>Y25% Acercamiento del 25% solo en

e! eje y.

Zoom In > XY25% Acercamiento del 25% en X y

Y.

Zoom Out > X25% Alejamiento en 25% solo en el

eje X.

Zoom Out > Y25% Alejamiento en 25% solo en el

eje Y.

Zoom Out >

XY25%

Alejamiento en 25% en X y Y.

Go To Active

Curve

Regresa a la curva activa

Curve > 1 Muestra la simulación. Curva! Barra de herramientas:

Curve > 2 Muestra la simulación. Curva2. Barra de herramientas:

Curve > 3 Muestra la simulación. CurvaS. Barra de herramientas:

Curve > 4 Muestra la simulación. Curva4. Barra de herramientas:

Crosshair Muestra el cursor crosshair. Barra de herramientas:

Datapoints Resaita los datos graficados
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(ensancha la curva activa)

Snap to Point Habiiita/deshabiliía ios pasos

del cursor en los puntos de

datos.

Toolbar Permite activar o desactivar la

visuaiización de la barra de

herramientas.

Browser Bar Permite habilitar o deshabilitar

la visualización de la barra de

exploración.

Status Bar Permite habilitar o deshabilitar

la visualización de la barra de

estado.

3.2.2.2.5 Menú de Curva — Modo de Simulación

El menú de curva contiene los siguientes comandos:

Comando Descripción

Curve > Actívate 1 Activa la curva 1 en la ventana de graficación. Esta curva

usa las condiciones puestas bajo el cuadro de diálogo de

Opciones del Simulador. Las tres curvas permanecerán

inalteradas a menos que igualmente sean activadas.

Curve > Actívate 2 Activa la curva 2 en la ventana de graficación. Esta curva

usa las condiciones puestas bajo el cuadro de diálogo de

Opciones del Simulador. Las tres curvas permanecerán

inalteradas a menos que igualmente sean activadas
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Curve > Actívate 3

Curve > Actívate 4

Curve > Delete 1

Curve > Delete 2

Curve > Delete 3

Curve > Delete 4

Activa la curva 3 en la ventana de graficacíón. Esta curva

usa las condiciones puestas bajo el cuadro de diálogo de

Opciones del Simulador. Las tres curvas permanecerán

inalteradas a menos que igualmente sean activadas

Activa la curva 4 en la ventana de graficación. Esta curva

usa las condiciones puestas bajo el cuadro de diálogo de

Opciones del Simulador. Las tres curvas permanecerán

inalteradas a menos que igualmente sean activadas

Suprime la curva 1 de la ventana actúa! de graficación.

Suprime la curva 2 de la ventana actual de graficación.

Suprime la curva 3 de la ventana actual de graficación.

Suprime la curva 4 de la ventana actual de graficación.

3.2.2.2.6Menú de Herramientas (Tools)

El menú Tools contiene los siguientes comandos:

Comando Descripción Atajos

Run Simulator

Ejecutar el Simulador

Ejecuta el Simulador. Con el

cuadro de diálogo Simulator

Options.

Barra de Herramientas:

Design Utilities

Diseño de utilidades

Lanzamiento del cuadro de

diálogo Design Utilities.

User-Defined Macros

Macros Definida por

usuario

Ejecuta macros especificadas

por usuario.



Download

Descargar

Escribe los datos del

esquemático en el dispositivo.

Se realiza una previa

verificación antes de la

descarga.

Barra de herramientas:

Upload

Cargar

Lee los datos desde el

dispositivo al esquemático. Los

datos que estuvieren en el

esquemático se pierden.

Verify

Verificación

Compara el dispositivo con el

esquemático.

Read IDCODE

LeerlDCODE

Muestra el IDCODE del JTAG

del dispositivo ubicado en el

módulo.

Auto-Calibrate

Auto Calibración

Realiza un ciclo de auto

calibración

3.2.2.2.7Menú de Opciones

El menú de Opciones (Options) contiene los siguientes comandos;

Comando Descripción

Simulator

Simulador

Abre el cuadro de diálogo Simulator Options.

JTAG Interface

InterfazJTAG

Abre el cuadro de diálogo JTAG Interface OPtions.
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3.2.2.2.8 Menú Ventana (Windoyv)

El menú ventana (Window) contiene los siguientes comandos:

Comando Descripción

Cascade

Cascada

Arregla las ventanas una sobre otra de manera solapada.

Tile

Mosaico

Arregla las ventanas en mosaico.

Arrange

Icons

Presenta el número de versión y otra información sobre el

software.

El menú Windows es desplegable y aumenta su tamaño en sentido vertical

debido a que lista las ventanas activas consecutivamente en la parte inferior.

3.2.2.2.9 Menú de Ayuda

El menú de Ayuda (Help) contiene los siguientes comandos;

Comando Descripción

Help Topics

Temas de Ayuda

Muestra la página principal de ayuda del PAC-

Designen

Licensing Information

Información de licencia

Un archivo de Ayuda que proporciona los detalles de

cómo obtener e instalar un archivo de la licencia

para habilitar el funcionamiento del PAC-Designer.
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License Status

Estado de licencia

Despliega la licencia actual con la que está

operando: LSC_PAC_STARTER o

LSC_PAC_SYSTEM, o ninguna ucencia (ilícito).

Actualmente, están generándose sóio licencias de

LSC PAC SYSTEM.

IspPAC on the Web

IspPAC en la Web

Muestra un cuadro de diálogo con sitios Web que

contiene enlaces de Soporte de Lattice.

Tech Support & Feedback

Soporte Técnico 8

Feedback

Muestra el Soporte Técnico & Feedback.

Help Configuraron

Configuración de Ayuda

Muestra e! cuadro de diálogo de configuración de la

Ayuda, le permite escoger el navegador de

Microsoft o el navegador de Internet predefinido.

About PAC Designer

Acerca del PAC Designer

Muestra un cuadro de diálogo con el número de

versión del PAC-Designer.

3.2.2.3 Barras de Herramientas (Toolbars)

3.2.2.3.1 Barra de Herramientas

El íoolbar (Figura 3.3) consiste en botones que le permiten a través de un clic

realizar tareas sin usar las órdenes o comandos del menú

Figura 3.3 Barra de Herramientas del PAC-Designer
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A continuación se listan los botones equivalentes a los comandos de los menús:

Abre un Nuevo diseño o una cadena JTAG a través de un cuadro de

diálogo. Un diseño consiste de la ventana de esquematización con todas

sus propiedades, mientras que una cadena JTAG puede contener

múltiples dispositivos y conectarse a un archivo de diseño ispPAC;

también-acomoda partes compatibles JTAG de longitud en cadena serial,

de conocidas instrucciones de registro (IR), Es equivalente al empleo del

comando File > New

Abre un archivo existente. Tal como se hace con el comando File >

Open.

Guarda el diseño actual, el esquemático relacionado y la ventana de

gráficas de respuesta. También se emplea el comando File > Save.

Imprime el esquemático activo o la ventana de gráficos de respuesta del

diseño. De igual manera que el comando File > Print.

Acercamiento de! área establecida entre dos puntos. Acción también

realizable mediante el comando View > Zoom In Select.

Regresar Zoom, zoom de retroceso sobre el área escogida para el zom

in en una ventana activa. El mismo efecto que emplear el comando View

> Zoom Previous,

Acercamiento que se realiza sobre todos los elementos de! esquemático

o ventana de curva de respuesta activa. Similar al empleo del comando

View > Zoom All.

Activa la curva 1 de la ventana de gráficos del simulador. La curval

puede ser actualizada a través del cuadro de diálogo Simulator Option

en la ventana de esquematización. Las otras tres curvas permanecerán

inalteradas a menos que igualmente sean seleccionadas y actualizadas.

De igual forma se puede activar una de las curvas mediante el comando
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Curve > Actívate 1; en la ventana de respuestas del simulador.

Activa ia curva 2 de la ventana de gráficos del simulador. La curva 2

puede ser actualizada a través del cuadro de diálogo Simulator Option

en la ventana de esquematización. Las otras tres curvas permanecerán

inalteradas a menos que igualmente sean seleccionadas y actualizadas.

De igual forma se puede activar una de las curvas mediante el comando

Curve > Actívate 2; en la ventana de respuestas del simulador.

Activa la curva 3 de la ventana de gráficos dei simulador. La curva 3

puede ser actualizada a través del cuadro de diálogo Simulator Option

en la ventana de esquematización. Las otras tres curvas permanecerán

inalteradas a menos que igualmente sean seleccionadas y actualizadas.

De igual forma se puede activar una de las curvas mediante el comando

Curve > Actívate 3; en la ventana de respuestas del simulador.

Activa la curva 4 de la ventana de gráficos del simulador. La curva 4

puede ser actualizada a través del cuadro de diálogo Simulator Option

en la ventana de esquematización. Las otras tres curvas permanecerán

inalteradas a menos que igualmente sean seleccionadas y actualizadas.

De igual forma se puede activar una de las curvas mediante el comando

Curve > Actívate 4; en la ventana de respuestas del simulador.

-Ni Ejecuta el simulador solamente para la curva activa (determinada por uno

de los cuatro botones de !a barra de herramientas al dar un clic). Las

condiciones son determinadas por las condiciones puestas en el cuadro

de diálogo del Simulator Options. Así mismo se puede emplear el

comando Tools > Run Simulator.

Crosshair, permite realizar lecturas de un gráfico ganancia/fase en una

simulación.

Carga el diseño actual en el dispositivo ispPAC conectado en el módulo

mediante el cuadro de diálogo JTAG Interface Options. Se realiza la

misma acción mediante el comando Tools > Download.



76

3.2.23.2 Barra de Estado

¡•Cif0a.t̂ aínéw-'désign or JTAG Chain

La barra de estado indica la función que realizan los menús, iconos, fuentes, y

procesos, cuando son seleccionados.

3.2.2.3.5 Barra de Navegación

La Barra del Navegador permite al usuario ir Adelante o Atrás entre las páginas

y opera como un Navegador Web.

3.2.2.4 Cuadros de Diálogo

3.2.2.4.1 Cuadro de Diálogo de Valor de Capacitor

Capacitor Valué

Vaíúe/Pole Frequenp.y

42.258 pF
42.291 pF
42.342 pF
42.413pF
4Z47Ü pF
42.553 pF

142.604 pF
•¡42.681 pF
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Este cuadro de diálogo se accede con doble ciic sobre el valor de cada

condensador, que se ubican en la tabla inferior de un esquemático. Este cuadro

de diálogo permite cambiar el valor del condensador.

3.2.2.4.2 Cuadro de Diálogo para Cambiar la Interfaz JTA G

íiChange JTAG Interface

Jnterface Method

¡j Note; Changíng Ihe interface meíhod will disable all JTAG
f programming «ntil PAC-Desígner is resta(ted.

El menú desplegable de Método de Interfaz incluye opciones para el Puerto

Paralelo, el Puerto Serial (todavía sin soporte) y el puerto USB (todavía sin

soporte)

3.2.2.4.3 Cuadro de Diálogo para Copiar la configuración de un Filtro

Copy Filter Confiquration

, Copyto...
||
|| <?• Configuiatíon A

C" Configuiatíon B

Invocado por el comando Edit > Copy Filter Configuration to Schematic (Este

comando es solo activo cuando esta abierta la ventana de configuración del

Filtro). Permite seleccionar una configuración de filtro entre A y B antes de

importarlo a un esquemático.
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3.2.2.4.4 Cuadro de Diálogo de Diseño de Utilidades

IspPAC2G Gain Configuration Ulility
¡spPACI G Ladder Filter Canrlgu rallo ns
ispPACSG Filter Configuratíons
¡spPACSI Filler Configurations
ispPACl ü_Biquadexe
ispPAC2ü_Bíquadese

- Descriphon- -- '-- ' ' -- —

GainUtiiityforispPACm

} jl Cahcef 1
!„_.. a

El cuadro de diálogo de diseño de utilidades es usado para abrir las utilidades de

diseño (ventana de configuración para el dispositivo en cuestión). Esto se

accede desde el comando Tools >Design Utilities.

3.2.2.4.5 Cuadro de Diálogo de Símbolo de Edición

Edit Symbol

C2 A Capacitor
L2 A Capacitor
C3 A Capacitor
C4 A Capacitor
_4 A Capacitor
C5 A Capacitor
Frequency RangeA
UES Bits

í -Cióse

Definiciones del cuadro de diálogo de símbolo de edición:

Listado: nombres de los símbolos

Glose: cierra el cuadro de diálogo.
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Edit: Abre un cuadro de diálogo subalterno para editar el símbolo seleccionado.

3.2.2.4.6 Cuadro de Diálogo de exportación

In,te forma]:

& File:

C

m

OK

„ Cancel

Seiial Vector Formal (SVF)
Formatted Te;-;t

iceModel

-EltoWse,,,

Definiciones del cuadro de diálogo de exportación:

ExportWhat: Selecciona el esquemático (Schematic), datos a graficar (Plot

Data) o resumen de información.

In this Format: Selecciona el tipo de archivo: JEDEC File, Serial Vector Format

(SVF), Formatted Text, o SPICE Model.

ExportTo: Exporta a un archivo o al Portapapeles de Windows

(Clipboard). El botón de exploración (Browse) es usado para

buscar un archivo y seleccionarlo.



80

3.2.2.4.7 Cuadro de Diálogo de Criterio de Filtro

Invocado desde ía ventana de configuración de filtros. Permite poner el criterio

del filtro para desplegar en la ventana de Configuraciones de Filtro.

FÜter Gritería

Matches;

I Gíeater than; JO

í
! Less (han:

1~jí Eftable filtering on íhís cdlurnn

3.2.2.4.8 Cuadro de Diálogo de Importación

Definiciones del cuadro de diálogo de importación:
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Import What: Selecciona ei Esquemático (Schematic), datos a graficar (Plot

Data).

In this Format: Selecciona ei tipo de archivo: JEDEC File para esquemático o

Gain/Phase Data para datos del gráfico.

Import From: Importa desde archivo. El botón de exploración (Browse) es

usado para buscar un archivo y seleccionarlo.

3.2.2.4.9 Cuadro de Diálogo de código JD JTAG

El cuadro de diálogo de ID JTAG mostrada debajo es un ejemplo de un

dispositivo ¡spPACIO. El código ID JTAG para los dispositivos ispPAC es como

se muestra a continuación:

Dispositivo

ispPACIO

ispPAC20

ispPACSO

¡spPACSO

¡spPAC81

ispPAC-POWR604

¡spPAC-POWR1208

Cadena de Bits

0000 0000 0001 0000 0000 0000 0100 001 1

0000 0000 0001 0001 0001 0000 0100 001 1

0000 0000 0001 001 1 0000 0000 0100 001 1

0000 0000 0001 0010 000000000100 0011

0000 00000001 00100001 000001000011

000000000001 01000001 000001000011

0000 00000001 01000000000001000011
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JTAG IDCODE

i IDCOPEFields
|¡
¡1 Manufacturar Lattiee Semiconductor

PartNumber

Versión

¡spPÁC-10

0000

¡ UndecodedlDCQDEtináry&ring

Fabricante - Lattice Semiconductor o "Desconocido"

Número de dispositivo - PAC10, o "Desconocido"

Versión (cadena binaria) - 31 Bits de IDCODE hacia la izquierda, 28 Bits de

IDCODE hacia la derecha.

Cadena binaria codificada IDCODE - 31 Bits hacia la izquierda, O Bits a la

derecha.

3.2.2.4.10 Cuadro de Diálogo de Opción de ínter faz JTAG

finJTAG Interface Options

' r Interface Method~

Uses PC Parallel Port [at porí 3BC, 378, or 278)

^ Change».

-Configure and Test ParalíelPc^t Inleiface-

fl/D'PoriÁddress'. ]

OK

Interface Method: Muestra el cuadro de diálogo para cambiar la interfaz JTAG

(Change JTAG Interface).
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I/O Port Address Button: Muestra el cuadro de diálogo de las opciones de Puerto

Paralelo (Parallel Port Options).

3.2.2.4.21 Cuadro de Diálogo New

•Créate a new docu'menf:

¡spPAC-POWR604: Supply Sequencing/Monitoring
¡spPACIO: Sígnal Conditioning

|¡spPAC20: Control Loop and Moníloring
¡spPACSO: Versalile Analoq Front-End
¡spPACSO: 5th Order LP Filter 50-750 kHz
¡spPAC81: 5th Order LP Füter 10-7
PAC-DesignerJTAG Chain

Permite abrir un Nuevo esquemático o Una cadena de archivos JTAG (PAC-

Designer JTAG Chain).

3.2.2.4.12 Cuadro de Diálogo de Exploración de Librería

PAC Library Browser ' V '̂ MlffifttBHHIIBBIBHHl̂ ]

,•
Director? C \PAC-Designer21 \LIBRARY\s

litcFAC FOV.FPICi: LED £fUBIilÍH
ispPAC POWRG04 LED BF" i
¡spPACIO BiquadFflteí pac | ¿Ubiect
¡spPAClO Gamxl 4pac 1 } . .
ispPA Cl 0 Gaintf 00 pac flulhor'
¡spPAC10_Gainx20pac ¡' | KeuWortí-
ispPACriOMGainx47 pac '¡ S
ispP/>C10lLadderFilte[.pac ', ¡ Cornments-
íspPACIQ Sum4s¡gs.pac í ™

'

PowetManager1208 LED Bequencer

Círcwíts Librad

Latlice PAC Applications Engineenng

iabPAC-PD\A/R1208 Seauence&p H ( Q.. MS

u

ispPAC20^B¡quad20 pac , i E*ampte íspPAC-POWRt208 LogiBuÜder sequence that
ispPAC20_Gamx1_Zpac ,i blinki Ihe LEDs on Ihé SvalUalion boatd off and on in
¡spPAC20 GainxlOOpac !* j sequqnce.
¡spP t̂̂ O^Gain^O pac Í-J|
ispPAC20_Gainx47.pac (!

¡spPACSO^Comparator l̂V pf j t

ispPACSO Gain/íl 0 5 Qffss ¡í
ispPAC30_G ainx20_5pac »í
ispPAC30Jntegrator. pac yy| ¡

(

í

^

J: ^ „ - . _ . „

OpenFile 9 ' Cióse !— l — u
;
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Permite identificar la base de datos de acuerdo al dispositivo que se planee

emplear para determinado diseño.

3,2.2.4.13 Cuadro de Diálogo de Configuración de Página

Page Setup

PnntWhal

Header:

Designl

Comrnenls*

í Canoel

fvi Filenarne

I? File Date/Time

í/ EilackAVhiiePrint

Permite seleccionar las opciones de impresión.

3.2.2.4.14 Cuadro de Diálogo de Opciones de Puerto paralelo

Parallel Port Options

Paralfe! Porí:
' r« Cancel

Portdríver:

Windows NT Kernel-mode driver (PACJTAG.SYS]

r Test cable connectíon-

PAC-Designer will apply pulses lo seíected pin

Pin: |TCK jjfj Pulse count ¡3p

Clt Dísable CPU ínteffugts dMTO íest | "



Definiciones de! cuadro de diálogo de opciones de Puerto Paralelo:

Puerto Paralelo (Parallel Port): Despliega: Direcciones que incluyen 3BCh, 378h

(predeterminada), y 278h. El PAC-Designer se comunica con el dispositivo PAC

por intermedio del puerto paralelo o de impresora del PC. El puerto 378 es el

valor predeterminado, y por ser e! puerto más común, se encuentra asignado.

Se debe emplear un cable de descarga de información para realizar la

conexión.

Controlador de Puerto (Port Driver): lista el controlador del puerto instalado.

Prueba de conexión de cable (Test Cable Connection): esta sección permite

probar el cable por la integridad de la señal o simplemente escribe pulsos para

verificar si se dispone del puerto adecuado.

Menú desplegable Pin: las selecciones incluyen TCK, TMS o TDI

Menú desplegable Contador de Pulsos (Pulse Count): selecciona el rango

desde 30 a 30,000,000

Casilla de verificación para deshabilitar el CPU durante interrupciones de prueba

(Disable CPU interrupts during test): provee una mayor estabilidad que se

refleja en el campo de acción.

Botón de Test:, realiza un Test, esto puede tomar desde microsegundos a

minutos, dependiendo de la cuenta y la velocidad del procesador,

OK: completa la acción.

Cancel; cancela la acción.
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3.2.2.4.15 Cuadro de diálogo de nivel de Ganancia y Polaridad

]¡ íi Cancelti '___"

Permite seleccionar la polaridad y el nivel de ganancia entre los valores

definidos 1, 2, 5, 10.

3.2.2.4.16 Cuadro de Diálogo de Ejecución de Macros definidas por Usuario

Run User-Defined Macro

í Seieoí a User-Defined macro to run:

Definiciones de! cuadro de diálogo de ejecución de Macros definidas por Usuario

Select a User-Defined Macro to Run: Nombres de las Macros apropiadas para

ejecutar. Las macros son archivos ejecutables que se ubican en el directorio

PAC-DesignerVUserDefinedMacro. El cuadro del listado permanece vacío si

ningún directorio posee una macro de extensión EXE.

OK: Inicia el programa
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Cancel: Cancela ei programa.

3.2.2.4.17 Cuadro de Diálogo de seguridad

Security

( tj [Secure devíee against feadingf ™""Z1'

Seguridad contra lectura del dispositivo (Secure Device Against Reading):

Pone un bit de seguridad para evitar desconfiguracion o manejo inapropiado del

dispositivo PAC.

La función de seguridad permite resguardar el diseño evitando lecturas al

archivo JEDEC o el empleo del comando UPLOAD.

3.2.2.4.18 Cuadro de Diálogo de Información Sumaria

Summary Information

Fíleñame: Designl

| Device. ¡spPACSO

lítle: U

I Subject:

Auíhor: jUnknownUser¡ ~~ i -^^-^

Keywords: SispPAC80

'Comments:



Este cuadro de diálogo se usa para revisar la Información Sumaria contenida

dentro de los archivos del PAC mediante ios campos: Título, Asunto, Autor,

Palabras claves, Comentarios.

Presionando OK se guardaran los cambios realizados, para un determinado

diseño.

3.2.2.4.19 Cuadro de Diálogo de Edición del UES

UES Editor

[•nürriber/ Bit Valué

UES bilí O
UESbit2 O
UES bit3 O
UESbit4 O
UES bit5 O
UES bitG O
UES bit? O

¡Cancel

Toggle

Permite cambiar el valor bits de UES en el dispositivo ispPAC.

3.2.2.4.20 Cuadro de Diálogo de Verificación

mPAC-Designer

Verlfy succeeded;
Devíce eqüaís schemafcíc

Se encarga de verificar que los datos del dispositivo sean iguales a los de la

ventana de esquematización del PAC-Designer.
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Para realizar la verificación:

Con el dispositivo específico en la ventana de esquematización, escoja Tools >

Verify. La verificación se realiza, y el cuadro.de diálogo de Verificación aparece

para certificar que el dispositivo es igual ai esquemático. Si el dispositivo no es

igual al esquemático, el cuadro de diálogo de Verificación indicará que la

comprobación ha fallado,

3.2.2.4.22 Cuadro de Diálogo Wakeup

El wakeup determina que configuración de filtro es activa después de encender

el dispositivo.

El ¡spPAC80/81 tiene 2 configuraciones de filtro que se guardan en la memoria

E2CMOS del dispositivo, dependiendo de la que se escoja "A" o "B, se inicia el

dispositivo.

Wakeup Configuration

<£•' A is wakeup configuralion

¡ O B ¡s wakeup configuration

Mote. When Ihe B configuraron is selected the A ;¡
confíguratiorrcannot be verifica aííer downíoad '(;-
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3.2.2.4.22 Cuadro de Diálogo de Opción del Simulador

3.2.2.4.22.1 Etiquetas de Curva

ISimulator Outions ^mmHUiiÜ&mi&í

|Í Curvel jcyivej

:
F Start' (Hsti

¡
ti FStop {Ha)
J
! Poínte/Dec-f
i
í
!| ínput node

Output node
1)i

1 'i Coníigufatío
¡',i ..- --!

^•tó1

)10M_ _'¿J
\: J500 F|!

p

jVm1 ¿J'

5 ^^-¿l:
n J Cfg A frjt

> ^ .̂ ^_
OK Jj¡ Cancel |'¡ é¿%

Las opciones del simulador se controlan a través de este cuadro de diálogo. Las

etiquetas superiores definen cuatro opciones, una para cada curva. Al ingresar al

cuadro de diálogo, la Curva Activa, es la etiqueta seleccionada; al salir de!

cuadro de diálogo, la curva seleccionada se volverá la Curva Activa.

Etiquetas de la curva (Curve Tabs ) - Selecciona una de cuatro juegos de

opciones. Moviéndose de curva en curva no se graban los cambios hechos en

una de ellas, sólo al pulsar OK se guardaran los cambios.

Frecuencia de Inicio y Frecuencia de Fin (Frequency Start and Frequency

End) - Valor en Hertzios. Escoja un valor de! menú desplegable.

Número de Puntos por Década (Number of Points per Decade) - Escoge un

valor del menú desplegable.



91

Nodo de entrada y Nodo de Salida (Input Node and Output Node) - Entradas y

salidas del PAC (IN1, OUT2, etc). Escoja de las selecciones proporcionadas en

el menú desplegable.

3.2.2.4.23.2 Etiqueta General.

Símulatoi- Options

IÍ¿U1X¿|_±w -
Genera!

C^nceí

Ejecute el Simulador después de cambiar las variables (Run Simulator after a

variable changes) - Cuando activa la casilla de verificación, la simulación

correrá automáticamente después de que usted cambie un símbolo editable en

cualquier parte del PAC-Designer: las ganancias, las interconexiones, los

valores de capacitancia, etc. Esto es útil si usted está cambiando el esquemático

frecuentemente. Finalmente pulse el botón OK.
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3.2.3 REFERENCIAS DE DISEÑO EN EL PAC-DESIGNER

3.2.3.1 Elementos de Diseño del ispPAC80/81

Ei cuadro inferior representa la pantalla principal de diseño del ispPAC80/81. Los

elementos de la pantalla del diseño son: Selección de configuración A/B, valor

de Condensador, Bit DES, Ganancia de Entrada, y Configuración inicial

"Wakeup".

3.2.3.1.1 Selección de configuración A/B

Haciendo doble clic en el cuadro de configuración A o B (CfgA o CfgB), la

Ventana de configuración del filtro se abre y es disponible para la elección del

filtro deseado. Si la configuración se cambia, esta se vera reflejada por el ID del
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filtro. El número de parámetros desplegados corresponderán al tipo de filtro

escogido y si ellos son aplicables a ese tipo o no.

3.2.3.1.2 Valores de condensador

Pueden alterarse los valores del condensador que constituyen la configuración

de un filtro a cualquier valor deseado. Esto permite la entrada manual de

configuraciones adicionales no incluidas en ia base de datos, por ejemplo.

Nota: Una vez que un cambio a un valor de la base de datos ocurre, la

configuración se marca como "modificada" y ei usuario debe asegurarse

después de que esto no comprometa la estabilidad del circuito en el nuevo

diseño. Los valores del condensador también pueden modificarse vía el menú

Symbo! del commando Edit. Para una vista más completa de cómo los

condensadores son empleados en el ispPAC80/81, refiérase al esquemático

simplificado del núcleo del filtro.

3.2.3.1.3 Núcleo Simplificado del filtro

La Ecuación de Transferencia Ideal para este circuito se muestra en la parte

inferior del gráfico. Los símbolos L2 y L4 realmente son condensadores y se

etiquetan de esta manera para facilidad de traducción del clásico (pasivo) diseño

de redes de filtros ladder. Las resistencias de -100K o -200K denotan la

inversión activa de la señal. La existencia de resistencia negativa simplifica el

dibujo y todavía conserva el sentido algebraico requerido para analizar el circuito

matemáticamente.

Nota: Ningún inductor es usado en el ispPAC8/81
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Ecuación de transferencia: Ésta es la ecuación de transferencia idea! para el

núcleo del filtro ispPAC80/81.

Nota: La fase es invertida solo para este bloque. En combinación con la

inversión del amplificador de entrada, la ganancia de salida (DC) del

ispPAC80/81 es positiva (ninguna inversión).

3.23.1.4 Bits UES

Los bits UES (firma electrónica de usuario) le permiten al usuario guardar un

único ID dentro de la memoria de la configuración del dispositivo para el uso

catalogado u otros propósitos. El valor de UES también puede modificarse vía el

menú Symbol, comando Edit.
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3.2.3.1.5 Ganancia de Entrada

Se pueden seleccionar ganancias de 1, 2, 5 y 10 haciendo doble clic en el

número sobre el amplificador de entrada. Los valores de ganancia también

pueden modificarse vía el menú Symbol del comando Edit.

3.2.3.1.6 Configuración 1nidal "Wakeup"

La configuración que el ispPAC80/81 asume cuando se enciende es fijado

haciendo doble clic en la configuración del símbolo de MUX en el esquemático.

Es muy recomendable que la condición wakeup se ponga en "A" si la

comprobación de la programación del dispositivo se prevee como una necesidad

futura (en otros términos, la habilidad al cargar la configuración completa de un

dispositivo previamente programado). Si "B" se selecciona como la configuración

inicial, la comprobación JTAG de bits de CfgA no puede realizarse después de

que el dispositivo se programe.

3.2.3.2 Ventana de Referencia de Configuración de Filtros en el ispPAC80/81

|üHiLoConfiq.PAC:2

£lB£¿^r^Filte®g¿]
27 Bessel
28 Bessel
29 Bessel
30 Bessel
31 Bessel
32 Bessel
33 Bessel
34 Bessel
35 Bessel

;v.cát̂ ffFF r̂3ii3
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64.71 KHz
64.91 KHz
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66.94KHz
67.35KHz

., rvn nr-if) }„

U

í̂5SS:̂ BGíi|
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-1^.29dB
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?&Iî :S:?<FílFij

-78.90dB ="
-79.47dB ' l
-79.38dB
-73.09dB
-79.23dB ' I
-73.87dB - I
-79.30dB
-79.1 2dB
~78.97dB rp|
„-!(-' •* O !<-> , .11111.1.»

'• ^A



96

Esta ventana se usa para que el usuario pueda seleccionar el filtro, basado en

varios parámetros. Después de la selección del filtro, la configuración puede

transferirse a la ventana de Entrada de Diseño (Esquemático). Haciendo doble

clic en cualquier parte del listado, se abrirá el cuadro de diálogo para copiar la

configuración del filtro, la misma que pueden ser cargada en la configuración A o

B. Las opciones de configuración mejoran si se presiona sobre la cabecera de

cada columna de esta ventana, lo cual permitirá, mediante la ventana de criterio

del filtro ajustar los parámetros de diseño.

El criterio de selección incluye el tipo del filtro (Bessel, Chebyshev, etc), la

frecuencia de corte (a -3dB ), ganancia a 2x y 10x, la frecuencia de esquina, y

así en adelante. Algunos tipos de filtro no tienen entradas en todas las

columnas, porque esas características técnicas no se aplican. Por ejemplo, los

filtros de Bessel tienen un declive monótono en la atenuación, considerando que

los filtros Elípticos tienen "Choques" en la banda de atenuación. Como resultado,

los filtros Elípticos tienen una especificación de rechazo en la banda de

atenuación, que los filtros de Bessel no poseen.

Cada tipo de filtro tiene un máximo de señal interna específica que se presenta a

diferentes niveles y nodos dentro del filtro. Por consiguiente, la columna de

MaxVin despliega el nivel señalado máximo aceptable a la entrada del filtro (es

decir, después dei amplificador de instrumentación con su ganancia

programable). El usuario es advertido para vigilar que la máxima amplitud de la

señal que entra en el bloque del filtro sea un valor menor que el máximo

especificado en esta columna.

Nota: Éste no es un proceso ordenando, sino una consulta y una muestra de

líneas de datos calificativos. Debido a esto, el orden para el criterio de selección

no tiene efecto en la salida que se muestra en la tabla. El criterio en efecto en

cualquier momento dado puede ser verificado usando los comandos del menú

View mientras se este en esta ventana. Todas los ítems que se seleccionan en
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el menú View quedarán marcados con un check junto a ellos. También, la base

de datos puede revertir todas los posibles modificaciones hechas en el menú

desplegable View, escogiendo la opción mostrar todas las configuraciones en

lista (ShowAIl Configurations in list).

3.2.3.3 Símbolos del ispPAC80/81

La tabla de símbolos que se ilustra a continuación es una lista de los "distintivos

esquemáticos" del ispPAC80/81. Cada símbolo es un grupo combinado de

células E2 que juntos configuran un PACCell o PACBIock.

La primera columna es el nombre del símbolo cuando aparecen en el cuadro de

diálogo Edit-Symbol.

El Tipo de Librería (Type Library) para estos símbolos se encuentra en el

directorio; PAC-Designer's\PDSDK\PacConstants en donde se halla el archivo

*.BAS de estos símbolos, y que representan un objeto OLE para diseñar macros

en aplicaciones externas como el Visual Basic.

Nombre en el PAC-Designer

C1 Capacitor A

C2 Capacitor A

L2 Capacitor A

C3 Capacitor A

C4 Capacitor A

L4 Capacitor A

C5 Capacitor A

OLE Automation VB Constant

PAC80_C1A

PAC80_C2A

PAC80_L2A

PAC80__C3A

PAC80J34A

PAC80_L4A

PAC80_C5A

Índex

0

1

2

3

4

5

6



3.2.4 SIMULACIÓN ANALÓGICA.

3.2.4.1 PAC -Designer Simulador AC

3.2.4.1.1 Simulación

V98

Frequency Range A

U ES Bits

Wakeup Configuraron

Gain

C1 Capacitor B

C2 Capacitor B

L2 Capacitor B

C3 Capacitor B

C4 Capacitor B

L4 Capacitor B

C5 Capacitor B

Frequency Range B

PAC80_PM1A

PAC80_UES

PAC80_ESF

PAC80_AB

PAC80_PG

PAC80_C1B

PAC80_C2B

PAC80_L2B

PAC80_C3B

PAC80_C4B

PAC80_L4B

PAC80_C5B

PAC80_PM1B

7

8

9

10

11

12

13

14

15

16

17

18

19

Después de que un diseño se ha configurado, puede simularse para verificar el

comportamiento y comparar con los resultados esperados. El simulador también

puede usarse durante ei diseño de entrada para probar varias opciones o

comparar configuraciones alternadamente. E! simulador es capaz de computar y

desplegar la respuesta AC de cuatro combinaciones entrada/salida. Las
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simulaciones pueden realizarse en cualquier momento a lo largo del camino

entre un pin de entrada y uno de salida.

Una vez que la ventana de simulación se abre, los gráficos de ia señal de

respuesta de amplitud y fase versus frecuencia se despliegan.

3.2.4.1.2 Ventana Básica de graflcación

El simulador presenta un gráfico de fase/ganancia de la configuración del diseño

actual. El gráfico se muestra en una ventana de graficación, que puede

despíegar cuatro gráficos de configuraciones diferentes si se desea. Así, pueden

compararse los resultados de los cambios en los valores de los parámetros.

La simulación se controla por opciones puestas en el cuadro de diálogo de

opciones de simulación (Simulator Options Dialog Box). Esto controla el inicio

y fin de la frecuencia, los nodos de Entrada y Salida, y la curva de resultados de

la simulación. La simulación se graba en el archivo de diseño del PAC.

La ganancia y fase están en dos planos, separados por una barra movible. La

ganancia está en ei plano superior al de la fase. Para agrandar una de las áreas

de graficación, seleccione la barra movible localizada en el centro de los dos

gráficos, cuando el cursor cambia a una doble flecha, la barra puede arrastrarse

para ampliar cualquiera de los esquemas de manera indistinta o hasta que

adquieran el tamaño deseado.

El eje vertical (Y) del plano de ganancia y fase pueden aumentar de tamaño

individualmente. El plano activo de ia ventana de graficación se distingue porque

el título de Ganancia o Fase se resalta.
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Un total de cuatro (4) curvas pueden graficarse simultáneamente dentro de la

ventana de simulación. La Curva Activa se puede definir al "presionar" el botón

"numerado" en el barra de herramientas.

3.2.4.1.3 Inspección del Gráfico

La ventana de inspección del gráfico es un mecanismo que opera solo sobre la

Curva Activa.

Una vez que active una curva, habilite el crosshair con View > Crosshair. El

PAC-Designer puede leer la frecuencia de salida, la ganancia y la fase

localizando el crosshair sobre el gráfico de respuesta en los paneles de

graficación y presenta las lecturas en el sector derecho de la barra de estado de

la ventana de simulación.

Manteniendo presionado el botón izquierdo del Mouse a lo largo de la curva, los

datos fluyen hasta el sitio en el que el usuario desee obtener lectura, empleando

el teclado la exploración de datos es mucho más delicada.

Los datos del gráfico pueden exportarse a un software tercerista como un

procesador de texto o una hoja de cálculo para usar en la documentación del

diseño.

3.2.4.1.4 Curva Activa

La curva activa controla:

• Donde se guardan los resultados de la simulación ejecutada.

• Los mecanismos de inspección de la Ventana de Graficación.



• Qué curva del gráfico se va a exportar

Solo una curva es activa a la vez, la misma que es indicada por:

• Una curva "sólida", a diferencia de una curva entrecortada/punteada,

en el área de graficación.

• Un botón numerado (1, 2, 3, o 4) de la barra de herramientas

• Presenta un indicador de presencia de Curva (Curve Presence

Indicator) en la ventana de graficación

Se puede cambiar de Curva Activa mediante;

• Los botones "numerados" en la barra de herramientas de la Ventana de

Esquematización y la ventana del simulador.

• Haciendo un clic en el Indicador de Presencia de Curva.

• Flecha arriba: activa la curva [N-1] (solo de la ventana de graficación).

• Flecha abajo: activa la curva [N+1] (solo de la ventana de graficación).

• Cuadro de diálogo Simulator Options.

• Comando Víew->Curve->1.2.3 o 4.

3.2.4.1.5 Cursor Crosshair

El PAC-Designer leerá los datos de Frecuencia, Ganancia y Fase a través del

cursor crosshair y mostrará los resultados en e! sector derecho de la barra de

estado.



Para Habilitar el cursor emplee el comando View->Crossha¡r, o con el botón

crosshair de la barra de herramientas.

Operación con el Mouse:

Primer Cllck: El cursor se mueve a la posición hecha por el clic.

Segundo Click: Habilita el panel de Ganancia o Fase.

Operación con Teclado:

Flecha Izquierda: Presenta datos de uno en uno hacia la izquierda

Flecha Derecha: Presenta datos de uno en uno hacia la derecha.

Fiecha Arriba: Activa la curva [N-1]

Flecha Abajo: Activa la curva [N+1]

3.2.4.1.6 Indicador de Presencia de Curva

La ventana de simulación indica la presencia de curva de datos vía el indicador

de Presencia de Curva sobre el lado derecho de la ventana de graficación. Los

indicadores muestran:

• La curva activa a través de un rectángulo de selección sólido sobre ei

nombre VolSIA/iM.

• Las curvas que están presentes, tienen un nombre de VoN/ViM. Si es que

no existen datos no hay ningún texto en el nombre. Sin embrago, la curva

todavía puede seleccionarse; en este caso sólo el rectángulo de la

selección será visible.

Operación del Mouse:

Un clic: Activa la Curva
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Dob/e elle: Invoca el diálogo de opción de simulador para esta curva, y hace esta

Curva Activa.

En el ejemplo que se ilustra a continuación, la curva 2 es la activa y las curvas 3

y 4 no están disponibles.

3.2.4.2 Opciones del Simulador

La simulación es controlada por un conjunto de opciones con el cuadro de

diálogo Simulator Qptíons. Estos controlan la frecuencia de inicio y Fin, los

nodos de entrada y salida, y la curva de resultados de la simulación. Los

cambios del simulador son guardados en el archivo de diseño *.pac.

Para ponerlas opciones de! Simulador

1. Escoja Options >S¡mulator.

2. Una vez que aparezca la ventana de Opciones de Simulador

(Simulator Options), modifique las opciones para las cuatro

curvas de acuerdo a sus necesidades. A continuación pulse OK

para efectivizar los cambios.

3. Se puede escoger las Opciones Generales del Simulador

(Símulator Options General Tab) y activar el casillero de

verificación de Ejecutar el simulador después de cambiar las

variables (Run Simulator after a variable changes). Cuando se

activa esta casilla de verificación, la simulación correrá

automáticamente después de que usted cambie un símbolo

editable en cualquier parte del PAC-Designer: las ganancias, las

interconexiones, los valores de capacitancia, etc. Esto es útil si
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usted está cambiando el esquemático frecuentemente. Finalmente

pulse el botón OK.

3.2.4.3 Simulación de un diseño

El simulador genera un gráfico de ganancia y fase de la configuración del diseño

actual. El gráfico se muestra en una ventana de graficacion que puede desplegar

cuatro gráficos cada uno de una configuración diferente si se quiere. Así, pueden

compararse resultados de los cambios en los valores de los parámetros.

Se deben poner las opciones del simulador antes de ejecutar una simulación.

Para simular un diseño:

• Escoja Tools >Run Simuiator para desplegar la ventana de graficacion.
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CAPITULO 4

DISEÑO DE FILTROS EN EL ispPAC

Como se ha abordado en capítulos anteriores, el ¡spPAC80/81 es un dispositivo

que integra filtros analógicos pasa bajos de quinto orden, permitiendo al usuario la

implementación de miles de filtros en siete topologías diferentes en un rango de

50 a 750 kHz sin la necesidad de componentes externos ni temporizadores (reloj).

Usando el software PAC-Designer, descrito en el Capítulo 3, el usuario selecciona

el filtro y ío puede configurar de acuerdo a sus necesidades en ef módulo de

desarrollo. Las configuraciones pueden ser guardadas en la memoria no volátil

E2CMOS del dispositivo o revisadas en ei software para adaptarlo a diferentes

aplicaciones.

Para diseñar los filtros pasa bajos de quinto orden en el ispPAC80/81, es

necesario empezar discutiendo de manera general los conceptos básicos de los

filtros analógicos, sus principales características y la respuesta que se espera

obtener para cada configuración.

4.1 CONCEPTOS DE FILTROS

Un filtro eléctrico es un cuadripolo capaz de atenuar determinadas frecuencias del

espectro de la señal de entrada y permitir el paso de las demás. Se denomina

espectro a la representación de las amplitudes de los armónicos de una señal en

función de la frecuencia. Experimentaimente se puede visualizar mediante un

analizador de espectros; obsérvese que mientras un osciloscopio es un

instrumento que analiza la señal en relación al tiempo, el analizador lo hace con

relación a la frecuencia.

Entonces, se denominan filtros a los circuitos que se encargan de separar o

rechazar diferentes tipos de señales, distinguiendo entre estos a los filtros

analógicos y filtros digitales.
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Los filtros analógicos son los que se encargan de trabajar con señales de tipo

analógicas (continuas), y los digitales los que se encargan de trabajar con señales

de tipo discretas, cuya implementación generalmente se realiza vía software.

4.1.1 Clasificación.

Los filtros se pueden clasificar de acuerdo a los siguientes aspectos:

- Frecuencias Atenuadas

- Tecnología Empleada

- Función Matemática o aproximación utilizada para proyectar el filtro.

Según las Frecuencias Atenuadas, se pueden tener:

- FILTROS PASA BAJOS: Permite e! paso de las frecuencias inferiores

hasta una determinada frecuencia de corte (fe). Las frecuencias superiores

resultan atenuadas.

- FILTRO PASA ALTOS: Deja pasar las frecuencias superiores desde una

determinada frecuencia de corte (fe), atenuando las inferiores.

- FILTRO PASA-BANDA: Permite el paso de las frecuencias situadas dentro

de una banda delimitada por una frecuencia de corte inferior y otra

superior. Las frecuencias que están fuera de esta banda son atenuadas.

- FILTRO RECHAZA BANDA: Permite el paso de las frecuencias que se

encuentren fuera de la banda delimitada por dos frecuencias de corte,

atenuando las que se encuentren dentro de la banda.
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Figura 4.1 Respuesta ideal de diferentes filtros:

a) pasa bajos, b) pasa altos, c) pasa banda, d) rechazo de banda.

Considerando la tecnología empleada, se tienen:

FILTROS PASIVOS: están construidos exclusivamente con elementos

pasivos como resistencias, condensadores y bobinas. Estos filtros en bajas

frecuencias no son muy empleados debido a que exigen ¡nductancias muy

grandes.

FILTROS ACTIVOS: Constan de elementos pasivos asociados a otros

activos (Amplificadores Operacionales - OPAMPs).

FILTROS DIGITALES: Estos filtros son en realidad programas de

computación que manipulan datos digitales. La señal analógica es

convertida en digital mediante un sistema de conversión A/D. La señal

binaria resultante se trata en el filtro digital y a continuación se convierte en

analógica en un conversor D/A. Estos filtros son útiles para procesar

simultáneamente muchos canales de transmisión y por su gran versatilidad
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y poder de procesamiento son los filtros empleados en aplicaciones de

gran complejidad.

De acuerdo a la función matemática utilizada, los tipos más comunes son:

Butterworth y Chebychev. En este capítulo no es intención hacer un análisis

matemático exhaustivo; simplemente extraer las ventajas y desventajas que

ofrecen los mismos, con el fin de establecer referencias con las que se pueda

comparar los circuitos que aquí se diseñarán.

Para la comprensión del módulo de desarrollo, se analizan en este capítulo el

diseño de los filtros analógicos activos y preferentemente de los filtros pasa-bajos.

4.1.2 Diseño de Filtros Activos

Se decidió referir brevemente la teoría requerida para diseñar los filtros, con la

intención de destacar todo el trabajo que se puede obviar, gracias a la existencia

de los dispositivos que son tema de este proyecto de titulación.

El diseño de filtros activos consiste en calcular los valores de los componentes

que, asociados a un Amplificador Operacional, permitirán realizar un filtrado a

partir de una frecuencia de corte predeterminada.

Las operaciones para calcular dichos componentes dependen de los siguientes

factores:

- Utilización de circuitos base de primer o segundo orden como: de Rauch o

de Sallen y Key;

- Características de respuesta del filtro.

Como el objetivo de este proyecto de titulación es el de dar a conocer la

versatilidad y funcionalidad de los filtros diseñados con el dispositivo ispPAC80/81

con respecto a los filtros activos comunes, se centrará la atención sobre filtros

activos pasa bajos de Butterwoth, y CHEBYCHEV, que son los de mayor empleo

por su gran respuesta de amplitud y fase que presentan en su implementación



con circuiíeria y OPAMPs. Se deja además para la implementación en el módulo

de desarrollo ios filtros de tipo Gaussiano, Bessel, Legendre, de Fase Lineal y

Elípticos o de Cauer.

El circuito base de 2do. orden de un filtro paso bajo posee ia siguiente expresión:

(Ec. 4.1)

Donde:

H(0) = Ganancia en DC

E- — = Factor de amortiguamiento
22

(JÜQ = Frecuencia natural (resonancia)

Al considerar la relación üj02 = b.u)c2 (siendo coc la frecuencia de corte deseada) la

ecuación anterior toma la forma:

(Ec. 4.2)

2

ba),.

El parámetro "b" determinará que el filtro sea de Butterworth o de CHEBYCHEV si

b=1 o b^1, respectivamente.

En la anterior ecuación el polinomio en "s" del denominador es el que caracteriza

a los filtros y define su comportamiento. Operando sobre la ecuación (4.2), esta se

reduce a:

(Ec.4.3)

Para el punto en que cuc^lrad/s el polinomio del denominador queda:
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s2 + 2%4bs + b s s2 + as + b (Ec. 4.4)

Este polinomio recibe el nombre de polinomio normalizado.

Los parámetros a y b de! polinomio normalizado, se listan en tablas para cada

orden del filtro.

Si se desea construir un filtro de Ser orden se utilizaran uno de 1er y otro de 2do

en serie; para construir uno de 4to orden se conectaran dos de 2do orden en

serie.

Esto implica que, para el diseño de un filtro de cualquier orden, basta conocer dos

circuitos básicos, uno de 1er y otro de 2do orden.

Para el cálculo de cada una de estás circuitos se debe conocer los polinomios

normalizados de su denominador, para esto se emplearán las Tablas 4,1 y 4.2.

Para un filtro Butterworth de Ser orden su denominador sería: [(s+1)(s2+1s+1)].

Si se desea construir un filtro CHEBYCHEV de 4to orden y amplitud de rizado de

0.1 dB, su denominador seria:

[(s2+0.528313s+1.330031)(s2+1.275460s+0.622925)].

Con estos coeficientes se pueden calcular los componentes de cada una de los

circuitos base.
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Tabla 4.1 Parámetros a y b para filtros Butterworth hasta Octavo Orden.

n

2

3

4

5

a

1.414214

1

1/W0

0.765367

1.847759

0.618034

1.618034

1/W0

b

1

1

1

1

1

1

1

1

n ,

6

7

8

a

0.517638

1,414214

1.931852

0.445042

1246980

1.801938

1/w0

0.390181

1.111140

1.662939

1.961571

b

1

1

1

1

1

1

1

1

1

1

1

Tabla 4.2 Parámetros a y b para filtros CHEBYCHEV hasta el sexto orden con

rizado de 0.1dB, 0.5dB, 1dB, 2dB y 3dB de amplitud.

.'.;,- n\

2

3

Y

0.1

0.5

1.0

2.0

3.0

0.1

0.5

1.0

a
2.372356

1.425625

1.097734

0.803816

0.644900

0.969406

1/W0

0.626456

1/W0

0.494171

b

3.314037

1.516203

1.102510

0.823060

0.707948

1.689747

0.969406

1.142448

0.626456

0.994205

n
5

5

Y

0.1

0.5

1.0

2.0

a

0.333067

0.871982

1/W0

0.223926

0.586245

1/W0

0.178917

0.468410

1/w0

0.134922

0.353230

b ':'.:;

1.194937

0.635920

0.538914

1.035784

0.476767

0.362320

0.988315

0.429298

0.289493

0.952167

0.393150
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4

2.0

3.0

0.1

0.5

1.0

2.0

3.0

1/W0

0,368911

1/W0

0.298620

1/W0

0.528313

1.275460

0.350706

0.846680

0.279072

0.673739

0.209775

0.506440

0.170341

0.411239

0.494171

0.886095

0.368911

0.839174

0.298620

1.330031

0.622925

1.063519

0.356412

0.986505

0.279398

0.928675

0.221568

0.903087

0.195980

6

3.0

0.1

0.5

1.0

2.0

3.0

1/W0

0.109720

0.287250

1/W0

0.229387

0.626696

0.856083

0.155300

0.424288

0.579588

0.124362

0.339763

0.464125

0.093946 .

0.256666

0.350613

0.076459

0.208890

0.285349

0.218308

0.936025

0,377009

0.177530

1.129387

0.696374

0.263361

1.023023

0.590010

0.156997

0.990732

0.557720

0.124707

0.965952

0.532939

0.099926

0.954830

0.521818

0,088805

4.1.3 Filtros de Butterworth

En general se cumple que ei módulo de la función de transferencia de un filtro

paso bajo Butterworth viene dado por:

,2/1

1+ 0}

(Ec. 4.5)

n = 1,2,3,.
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Dicho módulo sirve para conocer su representación de Bode, consta de un factor

constante G0¡ que indica la ganancia ante una señal de entrada continua (cu=0), el

valor oüc es la frecuencia de corte y n el orden del filtro (cuanto mayor sea el orden

del filtro, más se aproximará a la curva ideal: (a) de la Figura 4.1).

Si en la ecuación (4.12) co»ujcjse tiene:

G)

(Ec. 4.6)

_201og|G(/0)|«í201ogG0 -2Q/dog
CD

El segundo término permite saber el grado de atenuación en la banda de corte

[cüc,+c0]. Así un filtro Butterworth pasa bajo y de primer orden (n=1) tendría una

pendiente de atenuación de 20dB/década en dicho intervalo; uno de segundo

orden de 40db/década, etc.

Otra característica de los filtros es la forma plana de su banda pasante debido a

que al ser b=1 todas los circuitos base colocados en serie poseen la misma

frecuencia.

Figura 4.2 Respuesta real típica del filtro de Butterworth
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4.1.4 Filtros de CHEBYCHEV.

Un filtro de Butterworth para frecuencias próximas a la de corte comienza a

atenuar, pero de modo progresivo; si se desea una respuesta que se acerque

más a la ideal se puede recurrir a ios filtros de CHEBYCHEV. Este filtro siendo de

igual, orden que el de Butterworth, posee una respuesta mejor, debido a que su

pendiente es más vertical. Sin embargo, presenta un rizado en la banda pasante.

El módulo de la función de transferencia de un filtro pasa bajo Chebychev es:

n = 1,2,3......

(Ec. 4.7)

Donde:

GO = ganancia del filtro paso bajo para señal de entrada continua (aj~0).

ujc = frecuencia de corte.

e = constante que determina la amplitud del rizado en la banda pasante.

N = orden del filtro; y

Cn(oo/Loc) = polinomio de Chebychev definido de la siguiente forma:

(D

CO,

r a>
eos H. arceos •—

I lfflc

cosh n. arceos
I

co
O)c JJ

para
CO

O < — < 1

(Ec. 4.8)

para
co

>1



115

Se puede comprobar fácilmente en la ecuación (4.8) que para una entrada

continua (aj=0), la función \G(¡aj)\á el valor G0 si el orden es impar y en el
r?.

caso de ser par el valor alcanzado será

De la ecuación (4.15) se desprende que en la banda de paso existe un rizado a

diferencia de la banda de paso en los filtros Butterworth que es plano. Dicho

rizado posee los valores máximos y mínimos indicados en el párrafo anterior, de

donde se puede deducir su amplitud en decibeiios:

(Ec. 4.9)

De estas expresiones se puede concluir que la amplitud del rizado sólo depende

del parámetro E] que el rizado en la banda de paso depende del orden del filtro, y

que dicho número de orden indicará el número de máximos y mínimos que se

alcanzan en la banda de paso.

El valor de y caracteriza al filtro, su valor máximo permitido es de 3dB y se da

para un valor de e =0.99763. Ei diseño de un filtro Chebychev tiene la

particularidad de que a mayor amplitud del rizado, mayor atenuación en la banda

de corte. Por lo que el diseñador se ve en la necesidad de elegir lo que mejor se

adapte a sus necesidades, dependiendo de la repercusión en el circuito de tal

amplitud de rizado en la banda de paso.

La razón de dicho rizado se encuentra en que al tener dos o más valores distintos

de "b" en un filtro, ocasiona que existan dos o más pulsaciones distintas.

El porcentaje de atenuación del filtro Chebychev en decibeiios es, en la mayoría

de los casos, superior a n20dB/década. Su valor aproximado viene dado por la

expresión:

201og|G(y¿y)| «201ogG0 - 2Q]og(X) - 6(n-l)- tóOlogI — ] (Ec 4.10)
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Figura 4.3 Respuesta real típica del filtro de Chebychev

4.1.5 Circuitos Base de 1er y 2ílü Orden Para Filtros Paso Bajos

4.1.5.1 Filtro Paso bajos de 1er Orden

La estructura del circuito base, se representa en la Figura 4.2 siguiente:

7-4-1

Vs

Figura 4.4 Filtro de 1er orden, pasa-bajos.

Su función de transferencia es:

(Ec. 4.11)

De esta expresión se desprende:
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Ganancia del circuito: #(o) =

Frecuencia de corte: ®c = 2^7rc;o?0 =—— = 6¿yc.Ei valor de C debe ser fijado

por el diseñador.

Para anular los efectos de la tensión de offset es necesario que Rf sea

igual al paralelo de R2y R¿ RI = -—^—.

Deduciendo R2 y RS se tiene: IL =
^

l

En el caso de H(0) =1 las ecuaciones serían otras: la frecuencia de corte sería la

misma pero R2 sería un circuito abierto y RS sería un cortocircuito.

4.1.5.2 Circuitos de 2do orden para filtros pasa bajos.

Existen dos tipos de circuitos que se pueden emplear, ambas con buena

estabilidad, baja impedancia de salida, facilidad de ajuste de la ganancia y

frecuencia, necesidad de pocos componentes externos, etc.

4.1.5.2.1 Circuito deRauch o de Realimentación Múltiple

74

/77

idoFigura 4.5 Filtro de 2 orden pasa-bajos (de Rauch).



Función de transferencia:
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H(s) = -
s2R2R3ClC2+.

1 1 1 } .— + — + — +1
A ^ ^

(Ec. 4.12)

Equivalente a:

H(0)

I 1 1 1
, — -i- — + —

U ^ *3

(Ec. 4.13)

+ 1

El signo negativo de esta ecuación indica que la salida está invertida respecto de

la entrada

- Ganancia del circuito: #(o)= —

Del término independiente de la ecuación (4.13) se deduce que la

frecuencia de corte es: ú)n2 =• : ~bco? =>¿z> =

R2 se calcula a partir de la relación:

«2 =

6C,

El radicando de R2 debe ser mayor o igual que cero, caso contrario deben

variarse los valores que no necesariamente son fijos.
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4.1.5.2.2 Circuito de Sallen y Key

->do

-"2

3 741

6 -o Vs

Ffe

Figura 4.6 Filtro de 2 orden paso-bajo (de Sallen y Key).

Función de transferencia:

-f 1 + ̂  +
C,

Equivalente a:

#(*)=•
+ !--H(0) + 1

(Ec. 4.14)

(Ec. 4.15)

De esta expresión se advierte que la entrada y salida tienen igual signo.

- Ganancia del circuito: #(o) = 1 + —~

La pulsación de corte es:
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^2 ~ , 2 „

Para calcular R-j se parte de la relación:

^ 2 * *•] ^~"2

2

a +

Para anular ios efectos de la tensión de offset es necesario que RI más R2

sea iguai al paralelo de RS y R¿

2

3

El radicando de R1 debe ser mayor o igual que cero, caso contrario debe

variarse los valores que no necesariamente son fijos.

Con la combinación de los tres circuitos vistos, se pueden construir filtros pasa

bajos de cualquier orden, lo que demuestra la gran complejidad del diseño e

¡mplementación, puesto que para el análisis de filtros de quinto orden se requerirá

de un número de circuitos que depende exclusivamente del diseñador, lo cual

implica un gran volumen en la construcción, mayor empleo de tiempo, mayor

costo y, sobre todo, la presencia de inconvenientes por el acoplamiento de los

dispositivos como es el caso de la presencia de retraso y distorsión en las

respuestas de amplitud y fase, fenómenos que son muy limitados en el

¡spPAC80/81.
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4.1.6 Recomendaciones para el Diseño de Filtros Activos Pasa Bajos con Circuitos

Base

• En cada uno de los circuitos descritos, el valor de uno de los

condensadores debe ser fijado por el diseñador, se aconseja que el valor

elegido sea próximo a 10/fc(Hz) [jj,F].

• En filtros de orden superior a dos, cada circuito se debe diseñar

individualmente atendiendo a los valores de a y b de acuerdo al orden.

• Las circuitos no pueden mezclarse entre sí, deben ser circuitos básicos de

configuración (1er o 2do orden) o de Sallen y Key

• En un filtro de m etapas, la ganancia es el resultado de multiplicar las

ganancias parciales de cada una de las circuitos que lo componen.

4.1.7 Diseño Práctico de filtros Pasa Bajos Activos de quinto orden

Para completar el conocimiento de filtros activos pasa bajos, se plantea el diseño

de dos filtros de quinto orden, con dos frecuencias de corte distintas 50 KHz y

750KHz, frecuencias que más adelante se emplean en los proyectos con el

ispPAC80/81.

4.1.7.1 Filtro Pasa Bajos de Butterworth

4.1.7.1.1 Filtro Pasa Bajos de Butterworth confc — 50kHz

Para el diseño del filtro de Butterworth pasa bajos, se deben establecer las

características para el circuito.

a) Orden = 5

b) Ganancia = 1

c) Frecuencia de corte = 50 kHz

d) Resistencias = 120 kQ



122

Debido al orden que presentará ei filtro (5to Orden), es necesario emplear tres

etapas para el diseño de! circuito.

Para el diseño de la Primera Etapa, se emplea un circuito básico de Primer

Orden.

Vin R
vW

Vout

Figura 4.7 Circuito Básico de Primer Orden

Definición de parámetros:

Ganancia = 1

Frecuencia de corte = 50 kHz

Resistencia - 120 kfi

RC

coc = 2?fc = 27r(500GO) => coc = 100000^-

Para los filtros de Butterworth se conoce que: b = 1

1
bRa).

C* =

C = 26,5pF => C = 27pF (valor normalizado)
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En la segunda y tercera etapa del filtro se emplea un circuito de Rauch de

Segundo Orden.

Vin
•-

R1

A/W

R3
AA/V

:i UF

Vout
—•

Figura 4.8 Circuito de Rauch de Segundo Orden

Definición de parámetros:

Ganancia = 1

Frecuencia de corte = 50 kHz

Resistencias:

Ri = R2 = R3= 120

= 100000*

\^rf) '—•

r =
°

7,0362x10

Q

"22

A partir de la expresión: IL =
bC,

.±

, se despeja el vaior de

C2j para igualar esta ecuación con la anteriormente encontrada en función de CL
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=> C,

¿C,
¿2

¿C,
bC,

7,0362x10

C,

-22

A partir de las tablas para el diseño de filtros de Butterworth se conocen los

valores de a y b que son: 1.4142 y 1 respectivamente, entonces, de la igualdad

antes indicada se obtienen el valor para Ci:

Ci= 1,25x1(r11 F

Ci = 12,5 pF r=> d - 12 pF (valor normalizado)

Conocido el valor de Ci, se encuentra el equivalente para C2:

7,0362xl(T22 7,0362 xlO '22

C, 12,5x10-12

= 56 pF (valor normalizado)

vout

Figura 4.9 Filtro de Butterworth de quinto orden con ganancia unitaria
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4. L 7.1.2 Filtro Pasa Bajos de Butterworth confc = 750kHz

Características para ei circuito.

a) Orden = 5

b) Ganancia = 1

c) Frecuencia de corte = 750 kHz

d) Resistencias = 120

Debido al orden que presentará el filtro (5to Orden), es necesario emplear tres

etapas para el diseño del circuito.

Para el diseño de la Primera Etapa, se emplea un circuito básico de Primer

Orden.

Vin R

T
Vouí

* •

Figura 4.10 Circuito básico de Primer Orden

Definición de parámetros:

Ganancia = 1

Frecuencia de corte - 750 kHz

Resistencia = 120

A6(2?. = •
RC

a>c = 2-nfc = 2^(750000) r^> a)c =1500000^-

Para los filtros de Butterworth se tiene que: b = 1
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x-12

C - 1,76pF => C - 1,8pF (valor normalizado)

En la segunda y tercera etapa del filtro se emplea un circuito de Rauch de

Segundo Orden.

Vín R1

<

C1

>

<R2

R3

> A A A 4
V V V *

1 UF

Vouí

Figura 4.11 Circuito de Rauch de Segundo Orden

Definición de parámetros:

Ganancia = 1

Frecuencia de corte = 750 kHz

Resistencias:

RI = R2= Rs^ 120

oc =2^=1500000^

1

312x10-24



a

A partir de la expresión:
¿>Q

- , se despeja el valor de

C2, para igualar esta ecuación con la anteriormente encontrada en función de C-i.

¿C,
£Z £2

2»C,

x2 ^ \
a 1 f a 1

2^2 f̂l , ,
( * ' bCj ^Q

3,12x10

Q

-24

A partir de las tablas para el diseño de filtros de Butterworth se conocen los

valores de a y b que son: 1.4142 y 1 respectivamente, entonces, de la igualdad

antes indicada se obtienen el valor para Ci:

Ci = 0,516 x1Q-12F

Ci = 0,516 pF => Ci = 1 pF (valor normalizado)

Conocido el valor de Ci, se encuentra el equivalente para C2:

c, 1x10-12

C2 = 3,3 pF (valor normalizado)
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Vout

Figura 4.12 Filtro de Butterworth de quinto orden con ganancia unitaria y

frecuencia de corte de 750kHz

4.L 7.2 Filtro Pasa Bajos de Chebychev

4.1.7.2.1 Filtro Pasa Bajos de Chebychev con frecuencia de corte de SOkllz

Para el diseño del filtro de Chebychev pasa bajos se deben establecer las

características para el circuito.

a) Orden = 5

b) Ganancia = 1

c) Frecuencia de corte = 50 kHz

d) Resistencias - 120

e) Rizado ̂

Debido al orden que presentará el filtro (5to Orden), es necesario emplear tres

etapas para el diseño del circuito.

Para el diseño de la Primera Etapa se emplea un circuito básico de Primer Orden.
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Vin R

T
- +

Vout
-4 •

Figura 4.13 Circuito Básico de Primer Orden

Definición de parámetros:

Ganancia = 1

Frecuencia de corte = 50 kHz

Resistencia = 120

Rizado^ 0,1dB

1
RC

= 23r(50000) => O)c = 100000;?

Para los filtros de Chebychev con rizado de 0.1 dB:

a = 2,372356

b = 3,314037

=> C = -

c =

C = 8,OOpF ^> C = 8,2pF (valor normalizado)

En la segunda y tercera etapa dei filtro se emplea un circuito de Rauch de

Segundo Orden.
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C1

-R2

Vin R1
AA/V

R3
AAA/-

1 uF

Vout

Figura 4.14 Circuito de Rauch de Segundo Orden

Definición de parámetros:

Ganancia = 1

Frecuencia de corte - 50 kHz

Resistencias:

R-i = R2 = R3= 120 kQ

Rizado = 0.1dB

C,

1
(120m)(33314037)(100000^-)2C1(120m)

a

A partir de la expresión:
¿C,C,

2o?,
- , se despeja el valor de

, para igualar esta ecuación con la anteriormente encontrada en función de CL
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C =—' 2

•4(7/0+1)

a

bC¡

212 xlO"22

¿C,

A partir de las tablas para el diseño de filtros de Chebychev se conocen los

valores de a y b que son: 2,372356 y 3,314037 respectivamente, entonces, de la

igualdad antes indicada se obtienen el valor para Ci:

Ci = 6,31 x10"12F

C-i - 6,31 pF =¿ Ci - 6,8 pF (valor normalizado)

Conocido el valor de Ci, se encuentra el equivalente para C2:

2,12 xlCT22 2,12x10-**
C, = — = 7z- = o 1,1 pr

2 Cj 6,8 xlO"12

n> C2 = 33 pF (valor normalizado)

Se muestra en la Figura 4.15 el circuito para el filtro de Chebychev de quinto

orden con ganancia unitaria y frecuencia de corte de 50kHz:

Vin I20k0hm Vout

Figura 4.15 Filtro de Chebychev de quinto orden con ganancia unitaria y

frecuencia de corte de SOkHz
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4.1.7.2.2 Filtro Pasa Bajos de Chebychev con frecuencia de corte de 750kHz

Para el diseño del filtro de Chebychev pasa bajos, se deben establecer las

características para el circuito.

f) Orden = 5

g) Ganancia = 1

h) Frecuencia de corle = 750 kHz

i) Resistencias = 120 kQ

j) Rizado = 0.1 dB

Debido al orden que presentará el filtro (5to Orden), es necesario emplear tres

etapas para el diseño del circuito.

Para el diseño de la Primera Etapa, se emplea un circuito básico de Primer Orden

(Figura 4.16).

Vout

Figura 4.16 Circuito básico de Primer Orden

Definición de parámetros:

Ganancia = 1

Frecuencia de corte = 750 kHz

Resistencia = 120

Rizado = 0,1dB
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RC

coc =27üfc =2?r(750000) => coc =1500000*:

Para los filtros de Chebychev con rizado de 0.1 dB:

a = 2,372356

b = 3,314037

1

c= 1
- = 5,33xlO"13F

(3,314037)(120m)(1500000;r)

= 0,533pF => C = 1,OpF (valor normalizado)

En la segunda y tercera etapa del filtro se emplea un circuito de Rauch de

Segundo Orden.

C1

•R2

Vin R1
A/W

R3
A/W

UF

Vouí

Figura 4.17 Circuito de Rauch de Segundo Orden

Definición de parámetros:

Ganancia = 1

Frecuencia de corte = 750 kHz

Resistencias:

Ri = R2=R3= 120

Rizado = 0.1 dB
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¿^=2^=1500000*

1

1 1

(120m)(35314037)(1500000^r)2C1(120m)

C2 —
9,43x10"25

a \\- "T"

A partir de la expresión:
bC, \bC

2ó)
- , se despeja el valor de

, para igualar esta ecuación con la anteriormente encontrada en función de d.

C =v^ ™

AC,
bCt ) UQ

-4(770+1.)

6C,

s 2 / v 2
a l [ a l

bC,

9,43x10

C,

-25

A partir de las tablas para el diseño de filtros de Chebychev se conocen los

valores de a y b que son: 2,372356 y 3,314037 respectivamente, entonces, de la

igualdad antes indicada se obtienen el valor para Ci:

= 1,91x10'13F

- 0,19 pF => Ci = 1 pF (valor normalizado)

Conocido el valor de C-j, se encuentra el equivalente para

_ 9,43x10-" _9,43xlQ-2"
\~"y — '—' ,n — • i? -L fsJ-

- y "1x10-12

5,6 pF (valor normalizado)



En las Figura 4.18 se muestra el circuito para el Filtro de Chebychev de quinto

orden con ganancia unitaria y frecuencia de corte de 750kHz:

Vout

Figura 4.18 Filtro de Chebychev de quinto orden con ganancia unitaria y

frecuencia de corte de 750kHz.

4.2 Filtros Pasa Bajos Programadles Usando el ispPAC80/81

A continuación se describen los filtros que pueden ser desarrollados empleando el

ispPAC80/81.

Tal como ya se indicó, el ispPAC80/81 es un dispositivo que integra filtros

analógicos pasa bajos de quinto orden y en tiempo continuo. El usuario puede

implementar miles de filtros analógicos sobre siete topologías diferentes en un

rango de 50 a 750 kHz sin ia necesidad de componentes externos ni

temporizadores (reloj).

Usando e! software PAC-Designer, el usuario selecciona el filtro y lo configura de

acuerdo a sus necesidades. Las configuraciones pueden ser guardadas en la

memoria no volátil E2CMOS del dispositivo o simuladas en el software para su

análisis o el de nuevas aplicaciones.

La frecuencia de corte en tiempo-continuo del filtro puede ser seleccionada entre

aproximadamente 50 kHz y 750 kHz, a una resolución de 0,6% o mejor.
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El PAC-Designer soporta la simulación y programación del ispPAC80/81 con

cualquier filtro pasa bajos de quinto orden, y la base de datos de filtros integrada

proporciona miles de filtros de tipo: Gaussiano, Bessel, Butterworth y Legendre,

así como dos filtros de Fase Lineal, tres CHEBYCHEV y 12 filtros Elípticos con

varios factores de amortiguamiento. Otros tipos de filtros son realizables con el

ispPAC80/81 y pueden ser ingresados programando los componentes

individualmente.

Para simplificar la elección apropiada del tipo de filtro, estos se organizan según

el coeficiente de amortiguamiento, desde los valores bajos hasta los más altos.

Los valores más bajos son buenos por su respuesta de fase y sus características

de retraso de grupo, mientras que para valores elevados del coeficiente de

amortiguamiento mejora la amplitud de la respuesta.

El grupo final de filtros utilizan una respuesta mixta (polos y ceros) que favorece

una amplitud de respuesta con una pendiente pronunciada con cuatro valores

diferentes fuera del margen de rizado, sobre las combinaciones 3fo/fs.

A continuación se muestran las respuestas con un comentario breve sobre las

ventajas de cada filtro, seguido por secciones que discuten cada tipo de filtro con

más detalle. Estas serían las respuestas de frecuencia teóricas que se deberían

obtener con los filtros diseñados dentro del ispPAC.
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4.2.1 Respuestas de los filtros a implementar en el ispPAC80/81

4.2.1.1 Filtro Gaussiano:

Amplitud Retraso de Grupo

Respuesta de fase, muy linea! (pero no perfecta).

Banda de transición lenta.

4,2.1,2 Filtro deBessel:

V\
\

t

\ \

v *

15

• 4

Q

•z

1

Amplitud Retraso de Grupo

Perfecta respuesta de fase



4.2.1.3 Filtro Equirípple de Fase Lineal.
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i!'

-«a

Amplitud Retraso de Grupo

La banda de fase lineal más ancha que en Bessel

4.2.1.4 Filtro deButíenvorth

\d
Retraso de Grupo

Máxima amplitud llana (Maximally fíat ampliíude)



4.2.1,5 Filtro de Chebychev
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Amplitud

•10 §•
o

Retraso de Grupo

Rizado igual que en la banda de paso

4.2.1.6 Filtro de Legendre

Amplitud

t«á
|

8 ̂

Retraso de Grupo

Mezcla de la banda de paso de Butterworth y la banda de transición de

Chebychev.



4.2.1.7 Filtro Elíptico
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y
i

"'• i' •j
V

as

so-S

,KSO
CL

•30 |

S

- n
Amplitud Retraso de Grupo

Banda de paso Equiripple y banda suprimida, relación entre 0.1 dB y 1.3

es

ífe1

16
D

t o.

Amplitud Retraso de Grupo

Banda de paso Equiripple y banda suprimida, relación entre 0.1 dB y 2.7

La lista de filtros en este capítulo intenta servir al usuario como punto de partida.

El PAC-Designer permite simular la respuesta de dos filtros diferentes, el usuario

puede comparar los varios diseños para ver qué combinación presenta los

mejores beneficios para un proyecto dado.
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La base de datos de filtros del ispPAC80/81 ofrece cuatro opciones para la

respuesta de fase, más varias opciones para la respuesta de amplitud, incluyendo

12 opciones para respuesta de amplitud elevada (Elíptico).

También tiene la habilidad para modelar y simular más de estas opciones si se

requiere una respuesta diferente. De entre éstos, debe haber un filtro de

respuesta excelente para casi todas las combinaciones de parámetros del filtro.

4.3 PROGRAMACIÓN DE FILTROS EN EL PAC-DESIGNER

Una vez analizadas de manera general todas las características que presentan

los filtros de quinto orden que pueden ser programados en el ispPAC80/81,

enseguida se abordan las especificaciones a ser empleadas en los filtros que se

programarán en el chip, y de ios cuales se examinará la respuesta de fase y

j% amplitud, con el objeto de comprobar que las respuestas señaladas en la sección

anterior, son las que se obtienen del ispPAC80/81 por intermedio del módulo de

desarrollo.

El rango de frecuencia para el diseño de los filtros pasa bajos de quinto orden en

el EspPAC80/81 es amplio (50 - 750KHz); sin embargo este intervalo no es único,

debido a que se especifican límites para cada uno de los filtros que se pueden

descargar, de ahí que se han escogido varias frecuencias que permitirán analizar

las respuestas que brindan cada tipo de filtro de acuerdo a una frecuencia y

* ganancia específica.

Para la programación de los filtros, se deben ajustar los parámetros definidos en

el software para una adecuada configuración, esto es, la frecuencia de corte y la

ganancia que se espera a la salida. Una vez establecidas estas condiciones se

procede a la simulación y descarga de la configuración al dispositivo, para

efectuar las pruebas y obtener los resultados.
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Para la configuración, de los diferentes filtros se han escogido cuatro frecuencias

de corte:

- 50 KHz

- 350 KHz

- 550 KHz

- 750 KHz

Para cada una de las ganancias 1, 2, 5, 10, y de acuerdo a ios límites de

frecuencia de cada filtro que establece el PAC-Designer y que se indican en ia

Tabla 4.3.

Tabla 4.3 Intervalos de frecuencia para programación de filtros en el

PAC-Designer

FILTROS

Bessel

Fase Lineal 1

Fase Lineal 2

Gauss

Butterworth

Legendre

Chebychev

Elíptico

FRECUENCIA DE CORTE

Frecuencia

Mínima [KHz]

49.87

50.00

50.00

49.97

54.03

50.01

50.00

55.65

Frecuencia

Máxima [KHz]

297.08

298.42

304.59

301.47

752.01

488,38

500.00

575.19

La programación que se desarrollará en el PAC-Designer, es para dos filtros de

prueba, el Filtro de Butterworth, debido a la gran característica de respuesta que

presenta así como también e! amplio rango de frecuencia de corte con el que

cuenta; y, los filtros elípticos que, como se indicó en uno de los capítulos

anteriores, dispone de una gran cantidad de parámetros fácilmente medibles.
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Una vez que se han definido los filtros a ser diseñados, se inicia la programación

de acuerdo a los lineamientos que se detallan a continuación, luego que se estima

que hasta este punto ya se conocen las características y funcionalidades del

software sin embargo, más adelante se explican con mayor detalle:

1. Del menú File, opción New, se selecciona el dispositivo; para este caso en

particular:

ispPACSO 5th Order LP Filter 50-750 KHz

2. Escogido el dispositivo, se inicia la ventana de esquematización, para

cargar los filtros.

3. Haciendo uso del mouse o de ia barra de menús, se abre la ventana de

configuración de filtros.

4. De la ventana de configuración de filtros se selecciona el tipo de filtro y la

frecuencia de corte que previamente se ha establecido.

5. Una vez que se identifica el filtro, con doble clic sobre este o mediante ¡a

barra de menú, se invoca la ventana de copia de filtro, en donde se

seleccionará el slot de memoria A o B para posteriormente la descarga del

filtro.

6. Se regresa a la ventana de esquematización (ventana principal), cerrando

la ventana de configuración de filtros; con e! objetivo de verificar que e! filtro

elegido está ya ubicado en el slot de memoria seleccionado.

7. Se configuran los bits UES, para resguardar la información una vez que se

descargue al dispositivo.

8. A continuación se realiza la simulación, para verificar que la respuesta de

amplitud y de fase sean las correctas.
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9. Se guarda la configuración en un archivo definido de extensión *.pac, para

futuros cambios en e! diseño o nuevas aplicaciones.

10. Tanto la respuesta de fase como la de amplitud y los datos de la

simulación, se imprimen para realizar comparaciones con las lecturas de

los instrumentos de medida que se emplearán para la verificación del

funcionamiento del filtro en el chip mediante los elementos de

comprobación que contiene el Módulo de Desarrollo.

11. Se procede a descargar la configuración del filtro al módulo de desarrollo,

empleando las opciones presentes en la barra de menú.

12. Se realiza un UPLOAD del módulo de desarrollo al PAC-Designer para

garantizar que la descarga a sido efectiva y que la configuración es la

estipulada por el usuario.

13. Inmediatamente se obtienen lecturas con los instrumentos de medida

pertinentes, osciloscopio y espectrómetro.

14. Se comprueban los datos reales con los simulados; y se certifica la

aplicabilidad y funcionamiento del ispPAC80/81, mediante ei módulo de

desarrollo.

Una vez que se han listado los pasos a seguir para la programación del

dispositivo, enseguida se detallan las configuraciones de prueba seleccionadas

para la implementación en el módulo de desarrollo.

4.3.1 Programación del Filtro de Butterworth en el ispPAC

Para la programación del filtro de Butterworth se emplearán ias frecuencias de

corte que se listaron anteriormente y que son parte del rango de operación que

proporciona el PAC-Designer,



145

Por facilidad de interpretación, se definirán las frecuencias de corte como fcn,

siendo n el número de frecuencia de prueba, tai como se muestra a continuación:

- fc1 = 50 KHz

- fc2 = 350 KHz

- fc3 = 550 KHz

- fc4 = 750 KHz

Para iniciar la implementación del filtro de Butterworth dentro del PAC-Designer

se selecciona !a opción NEW del menú File de la barra de menús, lo cual conlleva

a la aparición de la ventana de selección del dispositivo para un nuevo

esquemático] tal como se muestra en la Figura 4.19. Esta ventana permite

seleccionar el dispositivo a emplear, en este caso el ispPACSO.

€reáte a new document;

ispPAC-PQWR12Ü8: Supply Sequencing/Monitoring
¡spPAC-PQWR6Ü4: Supply Sequencing/Monitoring
ispPACIO: Signal Conditioníng
ispPAC20: Control Loop and Monitoríng
ispPACSO: Versatile Analoq Fronl-£nd

5fh Ofder LP Filier 5Ü-7501
ispPACSI: 5th Order LP Filler 10-75 kHz
PAC-Designer JTAG Chain

OK

Cancel

Figura 4.19 Ventana de selección de dispositivo para un nuevo esquemático
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Una vez seleccionado el dispositivo a emplearse para el diseño, se despliega la

ventana de esquematización que se ilustra en la Figura 4.20

- DesígnZ

í¡ Fue Edit Vlew Tools 0p~tíons .MfJndow Help

**,'+{

: Schematic

ispPAGSO

5th arder
Low-pass Filter

PAC el |

_E

OA

CfgA unknown CfgB unknown

L4

12.732 pF

42.732 pF

3.359 pF

9559 pF

48,369 pF

48369 pF

83.090 pF

83.090 pF

32.359 pF

32.359 pF

59.041 pF

59.041 pF

39.607 pF

39.607 pF

UES Bits ='000000000000000000000

Figura 4.20 Ventana de esquematización

La ventana de esquematización inicial presenta en su contenido:

La entrada al filtro (1N), ei elemento amplificador (IA) que ai iniciarse adopta una

ganancia unitaria, el bloque de filtrado, eí elemento de salida (OA); y la salida del

filtro (OUT); a continuación, se aprecia el mux que permite adoptar una

configuración como predeterminada; seguidamente aparecen vacíos los bloques

de configuración, y finalmente se presentan los valores de capacitancia y ios bits

DES que serán configurados por el usuario.
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A continuación se inicia el proceso de elección del filtro, para este caso en

particular se seleccionará el filtro de Butterworth, cuya frecuencia de corte es de

SOKHz. Para este efecto se invoca a la ventana de configuración de filtro,

empleando el mouse (doble clic en el esquemático sobre CnfgA o CnfgB) o la

barra de menú (Tools> Design Utilities > ispPACBO Filter Configurations). De

inmediato aparecerá la ventana de configuración de filtros, de donde se

selecciona el filtro requerido, en este caso el filtro de Butterworth, con ID # 1058 y

frecuencia de corte de 54.03KHz, que es la que más se aproxima a la que se

planteó para las pruebas.

Este procedimiento se repite las veces que sean necesarias para las diferentes

configuraciones de prueba.

.V.iPíC-Ccs,'grcr (Oesignl: Filiar ConfigurationiJ
Toqts .Opttons Wlndow .Help

D

J2X l'ClKQffiFC"-3if l l CI • I q \3 | -C4 Í
1055 Gsussian
1056 Gaussfesn
1057 Gausslen

1059 Buttemorth
1060 Butterworth
1061 Buttetworth
1062 Buttcrwúrth
1063 Buttemorth
1064 Butíemorth
1065 Buttemofth
J066 Buttfimwth
1067 Buttetworth
1058 Buttetworth
1069 Buttemorth
1070 Buttemorth
1071 Buttemorth
1072 Buttemorth
1073 Buttemorth
1074 Butterworth
1075 Butterworth
1076 Butterworth

1077 Buttemorth
1078 ButtetHorth
1079 Butterworth
1080 Buttetworth
1061 Buttemorth
1062 Butterworth
1083 Buttemorth
1084 Buttemortli
1085 Buttemorth
1086 Buttemorth
1087 Butterworth
1089 Butterworth
1089 ButtHHOrth
1090 Buttoworth
1091 Buttetworth
1092 Butterworth
1093 Buttemorth
1094 Butterworth
1095 Buttemorth
1096 Buttetworth

294.45WÜ
29Q.66ttiz

-ÍH.42ÚB
-94.90*
-W.43*

6,00
6.00
6.00

O.COOpF 4.465pF 5.910pF 0.000̂ = 5.938pF
O.OOOpF 4.165pF 5.910pF O.OOOpF 5.938pF
O.OOOpF 4.4̂ pF 5.734pF O.OOOpF

6.505pf=
6.400pF
6.41

Figura 4.21 Ventana de Configuración del Filtro
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Una vez marcada la línea de la lista que contiene el filtro requerido dentro de la

base de datos que dispone el PAC-Designer, es necesario direccionar a un slot de

memoria. Para ello es necesaria la ventana de copia de filtro que se ilustra en la

Figura 4.22, la cual puede ser convocada mediante el ratón (doble clic sobre la

línea del filtro deseada) o a través de la barra de menú (Edit > Copy Fiiter

Configuration to schematic...)

Copy Fiiter Configuration^

to.. i i
í! fy CohííguraiionÁ

i O Goníiguraljon B

Figura 4.22 Ventana de Copia de Filtro a Esquemático

Una vez que aparece la ventana de copia de filtro, el usuario es libre de

seleccionar el slot de memoria que crea conveniente; para este caso en particular

se selecciona el slot de configuración A.

Debido a que se pueden configurar dos filtros diferentes dentro del ispPAC80/81,

en la configuración B, repitiendo este proceso, se selecciona otra frecuencia de

prueba, para realizar las simulaciones.

Se recomienda revisar el esquemático con la finalidad de comprobar que las

configuraciones seleccionadas son parte del diseño. Para ello, se cierra la

ventana de configuración de filtro y de inmediato se visualizará la ventana de

esquematización con los cambios realizados tal como se muestra en la Figura

4.23.



149

>U PAt-Designer - Design2

i, File Edlfc Vfew fools Opüons Wíndow Help

I D
! ffl

tws O-

:'».J.Des¡an2: Schematic

ispPACBO

•51h orclsr
Low-pass Filler

PÁCelí

OUT

OA

Wakeup-CfgA

CfgA
Type = Butterworth
Fc=S4.03kHz
Fs =
PB Ripple =
SB Alien =
RllDrID=si05S

CfgB
= Biitterworth

PB Rlpple =
SBAtten =
FIItorID =

C1 C2 L2 C3 C4 U C5

CfgA

CfgB

18.218 pF

2,825 pF

0.000 pF

D.OOO pF

47.626 pF

7357 pF

58539 pF

S.089 pF

0.000 pF

0.0DO pF

47.G58 pF

7.345 pF

9.089 pF

1.WPF

Figura 4.23 Ventana de esquematización con presencia de filtros.

Del esquemático mostrado en la Figura 4.9, se puede advertir:

- Ganancia seleccionada en el IA de 1.

- Bloque de Filtrado de quinto orden.

- La configuración predeterminada (Wakeup), es la confA.

- El slot de confA contiene:

- Filtro de Butterworth

- Frecuencia de corte igual a 54.03KHz.

- Identíficador del filtro en la base de datos 1058.

- El slot de Conf.B contiene:

- Filtro de Butterworth

- Frecuencia de corte igual a 350.55KHz

- Identificador del filtro en la base de datos 1368
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- Los valores de capacitancia son automáticamente seteados por el software,

sin embrago pueden ser modificados por el usuario,

- Los bits UES se mantienen todos en cero, a la espera de la modificación

por parte del usuario.

Una vez establecida la implementación del filtro, se puede modificar la ganancia

previa a la simulación del mismo a través del cuadro de diálogo de polaridad y

ganancia que aparece haciendo doble clic con e! ratón sobre la etapa

amplificadora (IA) o mediante la barra la de menú (Edit > Symbol > Gain > Edit.).

Polarity & Gain teíel
* • ••TfcflBB

Figura 4.24 Cuadro de diálogo para fijación Ganancia

Modificada o no la ganancia del filtro se procede a realizar las simulaciones de

amplitud y fase. Para este efecto basta con invocar a la ventana de simulación a

través de la barra de menú (Tools > Run Simulator) o mediante la barra de

herramientas (un clic sobre el icono H ). Enseguida aparecerán las simulaciones

de amplitud y fase para el filtro que se encuentra en el slot de memoria A; sin

embargo, como se explicó en el capítulo anterior se puede presentar

simultáneamente las curvas activas de los dos filtros, eliminar uno de las dos,

etcétera.

Luego de que el filtro de Butterworth ha sido programado, se realiza la simulación,

para obtener las respuestas de amplitud y fase.
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Martíh 18, 2OO5 Gaín Plot

12-OM

Vout H/Vin U

Figura 4.25 Respuesta de amplitud para el filtro de Butterworth con ganancia

unitaria y frecuencia de corte de 54.03KHz obtenida en el simulador del PAC-

Designer:
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-35O

Voul H/Vln 'I Sfl.TKHz -S.GZdB -223.20 Deg

Figura 4.26 Respuesta de fase para el filtro de Butterworth con ganancia

unitaria y frecuencia de corte de 54.03KHz obtenida en el simuiador del PAC-

Designer:

Empleando las frecuencias de corte listadas, y alterando el parámetro de

ganancia, la repuesta que presente el filtro será similar a la que se mostró

anteriormente, con la única diferencia en que existirá un desplazamiento en la

amplitud y en la fase. Sin embargo, se presentan las simulaciones para cada una

de las frecuencias, manteniendo ganancia unitaria.
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2.T

-20

-40

Gain Pío*

Vout -22G.38O8S

Figura 4.27 Respuesta de amplitud para el filtro de Butterworth con ganancia

unitaria y frecuencia de corte de 350.55KHz obtenida en el simulador del PAC-

Desígner



•4.3
March 19, 2OOS phase Plot

TT71M

Figura 4.28 Respuesta de fase para el filtro de Butíerworth con ganancia

unitaria y frecuencia de corte de 350KHz obtenida en el simulador del PAC-

Designer:



•9.1
-Maeclh 2Ot Í2ÓO5

-20

-4Q

Gsfcn F»iot

rr

--(OO

-12O

Figura 4.29 Respuesta de amplitud paraje] filtro de Butterworth con ganancia

unitaria y frecuencia de corte de 550KHz .obtenida en el simulador del PAC-

Designer

9
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Mardh 2O. 2QO5 Ph*as<e P.lot

Voutl/Vinl

Figura 4.30 Respuesta de frecuencia para el filtro de Butterworth con ganancia

unitaria y frecuencia de corte de 550KHz obtenida en el simulador de! PAC-

Designer
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Marco» "19. 2OO5

TTIew
Voul HA/ln "I

Figura 4.31 Respuesta de amplitud para el filtro de Butterworth con ganancia

unitaria y frecuencia de corte de 752.01KHz obtenida en el simulador del PAC-

Designen



March H9..2OO5 Phase Plot

Figura 4.32 Respuesta de fase para el filtro de Butterworth con ganancia

unitaria y frecuencia de corte de 752.01 KHz obtenida en ei simulador del PAC-

Designer:

Una vez que los filtros han sido programados, se procede a descargar la

información al dispositivo por intermedio del cable de descarga y el módulo de

desarrollo.
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Finalizada la programación, es necesario conectar el módulo de desarrollo al PC,

esto se logra a través del cable de descarga ispDOWNLOAD (puerto paralelo del

PC - pórtico de interfaz JTAG) como se mencionó en el primer capítulo.

Realizada la conexión PC/Módulo, desde el PAC-Designer se invoca a la opción

de descarga, empleando la barra de menú (Tools > Download) o, mediante la

barra de herramientas (icono

Alrededor de 5 segundos transcurren mientras se realiza !a programación del

dispositivo en el módulo. Terminado este proceso, aparece la ventana de

verificación (Figura 4.33), que garantiza la descarga.

PAC-Designer

Vehfy'succeeded! <
Devfce-equals saherrtatic

Figura 4.33 Ventana de Verificación de Descarga - Filtro de Butterworth

Realizada la descarga, el proceso de programación concluye.

4.3.2 Programación de Filtros Elípticos en el ispPAC

Para la programación de este tipo de filtros se emplearán las frecuencias de corte,

para lo cual se vuelve a usar la notación fcn siendo n el número de frecuencia de

prueba, a más de la frecuencia de banda de paso, que dentro de la base de datos

presenta una mejor distribución para el escogitamiento de los filtros de prueba.

fc1 = 50 KHz

fc2 = 350 KHz

fo3 = 550 KHz
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Luego de la selección del dispositivo a emplear y tener e! esquemático listo para

iniciar la programación (siguiendo el procedimiento descrito en el futro de

Butterworth), se inicia el proceso de elección del filtro, para este caso en particular

se seleccionará el filtro Elíptico, cuya frecuencia de banda de paso es de 50 KHz,

y presenta una frecuencia de corte equivalente a 56.23KHz, para este efecto se

invoca a la ventana de configuración de filtro, empleando el ratón (doble clic en el

esquemático sobre CnfgA o CnfgB) o la barra de menú (Toois> Design Utilities >

¡spPACSO Filter Configurations), de inmediato aparecerá la ventana de

configuración de filtros, de donde se selecciona el filtro requerido, en este caso el

filtro Elíptico, con ID # 3083.

Este proceso se repite las veces que sean necesarias para las diferentes

configuraciones de prueba.

r - (Dvtignl: Hller ConfuiiJr.Uiun*]
prt Twtf .Qptfcnj -Wlndow Hefc

YD'J-^T!^J\C¿CffL¿P^M~Í''. '̂g'ax'fc i/^n¿iom\Í'jPaj£8j^ftw^<ft)y.ll ĵ toíSfJM^ l̂Fjî Bĵ Ateorr j^Matfln i Ct ĵ
3080 aiebyshsY
3081 Owbyihw 196.HHb
3082.. jÜpUcat SS.fiSHr

6.00 7.01,. !':?

Figura 4.34 Ventana de Configuración de Filtros Elípticos



161

Una vez marcada la línea de la lista que contiene el filtro requerido dentro de la

base de datos que dispone el PAODesigner, es necesario direccionar a un slot de

memoria, para ello es necesaria la ventana de copia de filtro que se ilustra en la

Figura 4,35, la cual puede ser convocada mediante el ratón (doble clic sobre la

línea del filtro deseada) o a través de la barra de menú (Edit > Copy Filter

Configuraron to schematic...)

Copy FHter Configuration

lo...

<£ ConíiguralionA

O Cotllíggraüon B

i .
Figura 4.35 Ventana de Copia de Filtro Elíptico a Esquemático

Una vez que aparece la ventana de copia de filtro, el usuario es libre de

seleccionar el slot de memoria que crea conveniente; para este caso en particular

se selecciona el slot de configuración A.

Debido a que se pueden configurar dos filtros diferentes dentro del ispPAC80/81,

en la configuración B, repitiendo este proceso, se selecciona otra frecuencia de

prueba, para realizar las simulaciones.

Se recomienda revisar el esquemático con la finalidad de comprobar que las

configuraciones seleccionadas son parte del diseño, para ello, se cierra la ventana

de configuración de filtro y de inmediato se visualizará la ventana de

esquematización con los cambios realizados tal como se muestra en la Figura

4.36.
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j.'klPAC-Designer - Design2

File Edit Vlew Toóte Qptlons Wlndow Help
GffiíM

D »
'.{a ffi «•

W!

•'wOesiqn2: Schematic

ispPACSO

5(h otilar
Low-pass Filter

RAColl

WakeupaCfgA

CfgA
Typn = Ellípllcn!
Fc=55.65hHz
Fs=fl9.S3hHz

8 AHen - -SB.74dB
Fi!lerlD = 30B2

CfflB
Type = ElllpHonl
Fe =375.14tiHz
Fe = 705.85kHz
PB Rípple = -Ü.SOdB
SB Altan--B3.B1dB
Filiar 1D = B924

L4

CffjB

35.8SÍ1 pF

6.684 pF

2327 pF

0341 pF

4l.173pF

5.655 pF

65.669 pF

10.*93 pF

B.3B6 pF

0.950 pF

36.4B7 pF

4.901 pF

18.686 pF

3388 pF

UES Bits -ODOOOOOOOOOOOODOOOOOQ

Figura 4.36 Ventana de esquematizaron con presencia de filtros elípticos.

Del esquemático mostrado en ia Figura 4.36, se puede advertir:

- Ganancia seleccionada en el IA de 1.

- Bloque de Filtrado de quinto orden.

- La configuración predeterminada (Wakeup), es la confA.

- El sloí de confA contiene:

- Filtro Elíptico

- Frecuencia de corte (Fe) igual a 55.65KHz.

- Frecuencia en la banda de parada (Fs) igual a 99.83KHz

- Rizado en la Banda de Paso igual a-0,10dB

- Atenuación en la Banda de parada igual a -58.74dB

- Identificador en la base de datos 3082.

- El slot de Conf.B contiene:

- Filtro Elíptico

- Frecuencia de corte (Fe) igual a 375.14KHz.
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- Frecuencia en la banda de parada (Fs) igual a 705.85KHz

- Rizado en la Banda de Paso igual a -O.SOdB

- Atenuación en la Banda de parada igual a -63.81dB

- Identificador en la base de datos 6924.

- Los valores de capacitancia son automáticamente seteados por el

software, sin embrago pueden ser modificados por el usuario.

- Los bits UES se mantienen todos en cero, a la espera de la modificación

por parte del usuario.

Una vez establecida la implementación del filtro, se puede modificar la ganancia

previa a la simulación del mismo a través del cuadro de diálogo de polaridad y

ganancia que aparece, haciendo doble clic con el ratón sobre la etapa

amplificadora (IA) o mediante la barra la de menú (Edil > Symbol > Gain > Edil.),

Polarity & Gain L,e*e

Cancel

Figura 4.37 Cuadro de diálogo para fijación de Ganancia en los filtros elípticos.

Modificada o no la ganancia del filtro se procede a realizar las simulaciones de

amplitud y fase, para este efecto basta con invocar a la ventana de simulación a

través de la barra de menú (Tools > Run Simulator) o mediante la barra de

herramientas (un clic sobre el icono |H ).

Luego de que el filtro Elíptico ha sido programado, se realiza la simulación, para

obtener las respuestas de amplitud y fase. Igualmente que en la simulación de los

filtros de Butterworth, se presenta las respuestas de amplitud y fase para las

diferentes frecuencias de prueba manteniendo ganancia unitaria.
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Marcih 2O. ZOOS <3ahi Ploí

•233.18Deg

Figura 4.38 Respuesta de amplitud para el filtro Elíptico con ganancia unitaria,

frecuencia de banda de paso de SO.OOKHz y frecuencia de corte equivalente a

56.23KHz obtenida en el simulador del PAC-Designer



íMardh 2O. 2005 Phase Plot

Figura 4.39 Respuesta de fase para el filtro Elíptico con ganancia unitaria,

frecuencia de banda de paso de SO.OOKHz y frecuencia de corte equivalente a

56.23KHz obtenida en el simulador del PAC-Designer.
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Vout 1/Vin '1 37-4KHZ -2.94OB

Figura 4.40 Respuesta de amplitud para e! filtro Elíptico con ganancia unitaria,

frecuencia de banda de paso de 350.28KHz y frecuencia de corte equivalente a

375.14KHz obtenida en el simulador del PAODesigner.
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Figura 4.41 Respuesta de fase para el filtro Elíptico con ganancia unitaria,

frecuencia de banda de paso de 350.28KHz y frecuencia de corte equivalente a

375.14KHz obtenida en el simulador del PAC-Designer.



1.68

IManch ZO, 2OQ5

LTTK—' ÍOOIK
Voul t A/ín 'I STGKHz -3.O2dB

Figura 4.42 Respuesta de amplitud para el filtro Elíptico con ganancia unitaria,

frecuencia de banda de paso de 500 KHz y frecuencia de corte equivalente a

575.19KHz obtenida en el simulador del PAC-Desígner.
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íMarch 2O, 2OOS Pílase Pial

Vout i/vín i

Figura 4.43 Respuesta de fase para el filtro Elíptico con ganancia unitaria y

frecuencia de banda de paso de SOO.OOKHz obtenida en el simulador del PAC-

Designer.

Finalizada la programación de los filtros elípticos, es necesario conectar el módulo

de desarrollo al PC con el objeto de descargar el filtro programado a! dispositivo.
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Realizada la conexión PC/Módulo, desde el PAC-Designer se invoca a la opción

de descarga, empleando la barra de menú (Tooís > Download) o, mediante la

barra de herramientas (icono

Cinco segundos transcurren mientras se realiza la programación del dispositivo en

el módulo, terminado este proceso, aparece la ventana de verificación (Figura

4.44), que garantiza la descarga.

PAC-Designer

Veíífy.succeeded;
Dfe'vice equals'schenriatic

Figura 4.44 Ventana de Verificación de Descarga de Filtros Elípticos,

Realizada la descarga, el proceso de programación concluye.

Las simulaciones de los filtros diseñados presentan una respuesta de amplitud y

fase que en comparación con los filtros teóricos, satisfacen los conceptos y

ratifican la versatilidad que disponen los chips ispPAC para el desarrollo de

aplicaciones analógicas.

En el siguiente capítulo se detallan los datos reales obtenidos de los filtros

programados mediante lecturas de voltaje y frecuencia en el osciloscopio, y se

establece el análisis de resultados, con las simulaciones presentadas para los

filtros de Butterworth y Elípticos de este capítulo.
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CAPITULO 5

ANÁLISIS DE PRUEBAS Y RESULTADOS

Luego de que los filtros han sido programados y descargados en el módulo de

desarrollo, se inicia el proceso de obtención de datos, y presentación de

resultados; una vez que se han obtenido las simulaciones, y se han efectuado las

mediciones con los instrumentos adecuados.

Las pruebas se desarrollaron en el Laboratorio de Electrónica Básica de la E.P.N

(Figura 5.1), haciendo empleo de los materiales e instrumentos disponibles,

facilitando y garantizando un óptimo desempeño; además, se presentan

fotografías dei módulo de desarrollo en los anexos de este proyecto de titulación.

Figura 5.1 Pruebas desarrolladas en el Laboratorio de Electrónica Básica de la

E.P.N
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El proceso realizado para la obtención de los valores de las frecuencias de corte

para cada uno de los filtros de prueba, se describe a continuación:

Posterior a la programación del filtro, se polariza el módulo de desarrollo (Vs - 5V)

y se descargan las configuraciones a través del cable ispDOWNLOAD.

Una de las entradas diferenciales (V|N+) es sometida a la acción del nivel de

voltaje adecuado (según las especificaciones del filtro descargado) mediante un

generador de señales con frecuencia variable para realizar el muestreo de la

señal; V]N- se mantiene bajo ia acción del VREFOUT (2,5VDc) a través del Jumper

(J2); la señal a ser monitoreada es el V[N sometido a una de las entradas

diferenciales y el voltaje de salida diferencial presente en las pines 13 y 14 (OUT+

y OUT-).

De esta manera se obtienen las lecturas pertinentes para el posterior cálculo de

ganancia, y desarrollar la curva ganancia vs frecuencia para realizar las

comparaciones y análisis de resultados.

5.1 FILTRO DE BUTTERWORTH

La frecuencia de corte planteada es de SOKHz, dentro de la base de datos del

PAC-Designer se cuenta con un filtro cuyo valor más-cercano al planeado es de

54.03KHz, valor que es sometido para comparación con las pruebas realizadas

en e! módulo de desarrollo.

La señal de entrada sinusoidal (V¡N) empleada para efectuar las mediciones es de

GV, máximo permitido para este filtro, la frecuencia se varía en pasos aleatorios,

con el objeto de obtener mayor cantidad de muestras y precisión en los

resultados, tal como se muestra en la Tabla 5.1.
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Tabla 5.1 Datos obtenidos en el Módulo de Desarrollo (Filtro de Butterworth)

Frecuencia
[Hz]

10000

11000

12000

13000

14000

15000

16000

17000

18000

19000

20000

24000

28000

32000

36000

40000

44000

48000

52000

56000

60000

70000

80000

90000

100000

200000

VIN[Vpp]

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

VOUT [Vpp]

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,6

4,16

3,93

1,28

1,12

0,72

0,64

0,32

Ganancia

°0-lnd OUT MR1^uxiug LUDJ
V VIN J

-0,91514981

-0,91514981

-0,91514981

-0,91514981

-0,91514981

-0,91514981

-0,91514981"

-0,91514981

-0,91514981

-0,91514981

-0,91514981

-0,91514981

-0,91514981

-0,91514981

-0,91514981

-0,91514981

-0,91514981

-0,91514981

-0,59926447

-3,1811584

-3,675174

-13,4188256

-14,5786646

-18,4163751

-19,4394255

-25,4600254
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300000

400000

500000

6

6

6

0,18

0,12

0,1

-30,4575749

-33,9794001

-35,563025

A continuación se realiza !a representación gráfica (Bode) de la Ganancia vs.

Frecuencia de los datos obtenidos;

o
10

-3 -

-6 -

-9 -

-12

-15 -

-1R

-21

-94

-27

-30

-33

-36

-39

30
i i

1b<)00
-66C \ .[

1

0

s

300

\

0 )' IODO

Figura 5.2 Representación de los datos obtenidos para e! filtro de Butterworth con

ganancia unitaria y frecuencia de corte de 50 kHz.

De los datos medidos y del gráfico se puede apreciar que a -3dB, la frecuencia de

corte es equivalente a 56KHz que comparada con !a frecuencia de corte de la

simulación 54,03KHz, presenta un error, el mismo que se calcula como se

describe a continuación:

Vteórico - Vreal
Vreal

x]00
56kHz

x 1.00 = 3,51%
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Siguiendo el procedimiento antes indicado, se establecen las comparaciones con

las tres frecuencias de corte de prueba restantes fc2 = 350KHz, fc3 = 550KHz y fc4

= 750KHz, resultados que se muestran en las Tablas 5.2, 5.3 y 5.4

respectivamente.

Tabla 5.2. Datos obtenidos en el Módulo de Desarrollo (Filtro de Butterworth)

Frecuencia
[Hz]

15000

16000

17000

18000

19000

20000

24000

28000

32000

36000

40000

44000

48000

52000

56000

60000

100000

150000

200000

250000

300000

350000

400000

V,N[Vpp]

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

-^•.i.^ví.e-
6

Vou-rtVpp]

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

5,4

o 4,16

3,93

Ganancia
(\¡ \d OUT HdRl

VV VIN J

-0,915149811

-0,915149811

-0,915149811

-0,915149811

-0,915149811

-0,915149811

-0,915149811

-0,915149811

-0,915149811

-0,915149811

-0,915149811

-0,915149811

-0,915149811

-0,915149811

-0,915149811

-0,915149811

-0,915149811

-0,915149811

-0,915149811

-0,915149811

-0,915149811

3̂,181158395

-3,675174
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450000

500000

550000

600000

650000

700000

750000

800000

850000

900000

950000

1000000

6

6

6

6

6

6

6

6

6

6

6

6

1,28

1,12

0,72

0,64

0,32

0,18

0,12

0,1

0,05

0,02

0,01

0,0092

-13,41882561

-14,57866455

-18,41637508

-19,43942553

-25,46002544

-30,45757491

-33,97940009

-35,56302501

-41,58362492

-49,54242509

-55,56302501

-56,28726846

Representación gráfica de los datos obtenidos (Diagrama de Bode):

1

-21

-5

-8

-11

-17

-20

-26

-35-

-38 •

-44 -

-A7 -

O 1 000

-

1 VkQQ CC 300

5000

v

u

\

1

\O

-

Figura 5.3 Representación de los datos obtenidos para el filtro de Butterworth con

ganancia unitaria y frecuencia de corte de 350 kHz.
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Tabla 5.3. Datos obtenidos en el Módulo de Desarrollo (Filtro de Butterworth)

Frecuencia
[Hz]

10000

11000

12000

13000

14000

15000

16000

17000

18000

19000

20000

24000

28000

32000

36000

40000

44000

48000

52000

56000

60000

100000

150000

200000

250000

300000

350000

V,N[VPP]

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

V0ur[Vpp]

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

Ganancia

°(Vdnrr OUT FfíRlZUXIUg LUDJ

V VIN )

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0
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400000

450000

500000

550000

600000

650000

700000

750000

800000

850000

900000

950000

1000000

2

2

2

2

2

2

2

2

2

2

2

2

2

2

1,9

1,8

1,39

1,2

0,8

0,5

0,4

0,38

0,3

0,16

0,12

0,1

0

-0,445527894

-0,915149811

-3,160303908,

-4,436974992

-7,958800173

-12,04119983

-13,97940009

-14,42492798

-16,47817482

-21,93820026

-24,43697499

-26,02059991

Diagrama de Bode correspondiente a los datos tabulados anteriormente:
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100

-3

-6

-9

-12

-15

-18

-21 -

-24

coooo

50COÍ

xxooo

Figura 5.4 Representación de los datos obtenidos para el filtro de Butterworth con

ganancia unitaria y frecuencia de corte de 550 kHz.

Tabla 5.4, Datos obtenidos en el Módulo de Desarrollo (Filtro de Butterworth)

Frecuencia
[Hz]

100000

150000

200000

250000

300000

350000

400000

450000

500000

V,N[Vpp]

2

2

2

2

2

2

2

2

2

VOUT [Vpp]

2

2

2

2

2

2

2

2

2

Ganancia

°0-1ní7 OUT IrriRlz-uxiog LUDJ
V V!N )

0

0

0

0

0

0

0

0

0
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550000

600000

650000

700000

t 750000

800000

850000

900000

950000

1000000

2000000

2

2

2

2

2

2

2

2

2

2

2

1,96

1,91

1,75

1,6

• " 1,43

1,2

0,81

0,7

0,6

0,4

0,02

-0,175478486

-0,399932568

-1,15983894

-1,93820026

: -2,913879164

-4,436974992

-7,850899536

-9,118639113

-10,45757491

-13,97940009

-40

Diagrama de Bode correspondiente a los datos tabulados anteriormente:

101

-3

-6

-9

-12

-15

00 OODOO

75000

1 )QOOQQ

Figura 5.5 Representación de los datos obtenidos para el filtro de Butterworth con

ganancia unitaria y frecuencia de corte de 750 kHz.
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5.2 FILTROS ELÍPTICOS

La frecuencia de corte planteada es de 5QKHz, la base de datos del PAC-

Designer cuenta con varios filtros elípticos; de los cuales para este caso en

particular se selecciona ei que presenta una frecuencia de corte de 55.65KHz con

una frecuencia de banda de paso de SOKHz, valores cercanos al planeado, los

mismos que son sometidos para comparación con las pruebas realizadas en el

módulo de desarrollo.

La señal de entrada sinusoidal (V^) empleada para efectuar las mediciones es de

6V, máximo permitido para este filtro, la frecuencia se varía en pasos aleatorios1

con el objeto de obtener mayor cantidad de muestras y precisión en los

resultados, tal como se muestra en la Tabla 5.5.

Tabla 5.5 Datos obtenidos en el Módulo de Desarrollo (Filtro Elíptico fe =

55,65KHz)

Frecuencia
[Hz]

100

500

1000

1500

2000

2500

5000

10000

15000

20000

25000

30000

35000

VIN[Vpp]

6

6

6

6

6

6

6

e
6

6

6

6

6

V0ur[Vpp]

5,94

5,94

5,94

5,94

5,94

5,94

5,94

5,94

5,94

5,94

5,96

5,94

5,94

Ganancia

°0x1opl OUT IfdBl¿.vx iog LUDJ
V VIN J

-0,08729611

-0,08729611

-0,08729611

-0,08729611

-0,08729611

-0,08729611

-0,08729611

-0,08729611

-0,08729611

-0,08729611

-0,05809981

-0,08729611

-0,08729611
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40000

45000

50000

55000

60000

65000

70000

75000

80000

85000

90000

95000

100000

105000

110000

120000

150000

160000

170000

200000

230000

250000

300000

350000

500000

750000

1000000

2000000

3000000

6

6

6

, 6y

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

5,9

5,94

5,84

4̂,4

2,16

1,12

0,48

0,31

0,18

0,09

0,029

0,028

0,0075

0,001

0,0054

0,0075

0,0019

0,0001

0,001

0,0048

0,0055

0,0062

0,0055

0,0059

0,0054

0,004

0,0038

0,0018

0,001

-0,14598477

-0,08729611

-0,23476807

-2,69397148

-8,87394998

-14,5786646

-21,9382003

-25,7357911

-30,4575749

-36,4781748

-46,315065

-46,6198644

-58,0617997

-75,563025

-60,9151498

-58,0617997

-69,987953

-95,563025

-75,563025

-61,9382003

-60,7557712

-59,7151912

-60,7557712

-60,1459848

-60,9151498

-63,5218252

-64,036198

-70,4575749

-75,563025
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Graficando los datos tabulados anteriormente, se obtiene el diagrama de Bode de

la variación de la Ganancia en función de la frecuencia, que se muestra a

continuación, para el filtro Elíptico ID 3083 del PAC-Designer,

1030_7 —

-17

-27

-37

-47

-57

-67

-77

-87-

-97

d¿00 55khz

105 fcHE

100300

06 dB

IQ0QOOO 33000

Figura 5.6 Representación de los datos obtenidos para el filtro elíptico con

ganancia unitaria y frecuencia de corte de 50 kHz,

De los datos medidos y del gráfico se procede a calcular los errores presentes

dentro de los parámetros: frecuencia de corte, frecuencia de parada y la

atenuación de la banda de parada, valores fácilmente identificables dentro de las

simulaciones así como también en los datos tabulados y graficados.

Ejemplo de cálculo:

Error presente en la frecuencia de corte:

Vteórico = 55,65kHz

Vreal = 55 kHz
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o „ —
Vteorico - Vreal

Vreal
xlOO

55¿5kPIz-55kHz
x 100 =

Error presente en la frecuencia de parada:

Vteóríco = 99,83kHz

Vreal = 105kHz

Vteorico - Vreal

Vreal
xlOO

IQSkHz
x 100 = 4,92%

Error presente en la atenuación de la banda de parada:

Vteórico = -58,74dB

Vreal = -58,06dB

e „ —
Vteorico - Vreal

Vreal
xlOO e. =

• 58,74¿!B-(-58,06£ffi)

(-58,06¿ffi)
xlOO = 1,15%

Una vez desarrollados los ejemplos de cálculo empleados en los filtros elípticos,

se procede a mostrar los resultados para las dos frecuencias de corte de prueba

restantes en las Tablas 5.6 y 5.7.

Tabla 5.6 Datos obtenidos en el Módulo de Desarrollo (Filtro Elíptico

fc2 = 526 KHz)

Frecuencia

[Hz]

10000

50000

V,N[Vpp]

4

4

VourlVpp]

3,9600

3,9600

Ganancia

°(V'1rm OLJT MR!/-uxiog LUDJ

V VIN )

-0,087296108

-0,087296108



100000

150000

180000

225800

260000

295000

310000

350000

375000

400000

425000

450000

483000

500000

510000

528000

547000

560000

575000

600000

1000000

1500000

2000000

2500000

3000000

4

4

4

4

4

4

4

4

4

4

4

4

4

4

4

4

4

4

4

4

4

4

4

4

4

3,9600

3,9600

3,9600

3,9600

3,9600

3,9600

3,9600

3,9600

3,9600

3,9600

3,9600

3,9600

3,9500

3,9900

3,8500

3,6000

3,4500

3,2000

2J500

2,0000

0,1000

0,0002

0,0004

0,0010

0,0008

-0,087296108

-0,087296108

-0,087296108

-0,087296108

-0,087296108

-0,087296108

-0,087296108

-0,087296108

-0,087296108

-0,087296108

-0,087296108

-0,087296108

-0,109257914

-0,021741913

-0,331985236

-0,915149811

-1,284817925

-1,93820026

' -3,25454595

-6,020599913

-32,04119983

-88,51937465

-80

-72,04119983

-73,97940009

Diagrama de Bode obtenido.de los datos tabulados para el filtro elíptico con

fe = 526kHz:
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10000

-20

-45

-70

-95

qoboo 3,2
5750o

dB btpooo

MHz

h qopooo

Figura 5.7 Representación de los datos obtenidos para el filtro elíptico con

ganancia unitaria y frecuencia de corte de 550 kHz.

Tabla 5.7 Datos obtenidos en el Módulo de Desarrollo (Filtro Elíptico

fc3 = 375,14KHz)

Frecuencia
[Hz]

100

500

1000

1500

2000

2500

5000

10000

V1N[Vpp]

6

6

6

e
6

6

6

6

V0ur[Vpp]

6

6

6

6

6

6

6

6

Ganancia

°f)-W OUT fdRl^uxiog MUDJ
V VIN )

0

0

0

0

0

0

0

0
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15000

20000

25000

30000

35000

40000

45000

50000

55000

60000

65000

70000

75000

80000

85000

90000

95000

100000

105000

110000

120000

150000

160000

170000

200000

230000

250000

300000

350000

375000

400000

450000

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

6

5,98

5,98

5,97

5,96

5,96

5,94

5,92

5,92

5,9

5,88

5,87

5,85

5,84

5,83

5,8

5,8

5,75

5,75

5,75

5,75

5,75

5,88

5,9

5,98

5,98

5,92

5,8

5,7

4,2

2,3

0,75

0

-0,02900133

-0,02900133

-0,04353839

-0,05809981

-0,05809981

-0,08729611

-0,11659087

-0,11659087

-0,14598477

-0,17547849

-0,19026298

-0,21990769

-0,23476807

-0,24965391

-0,29446514

-0,29446514

-0,36966811

-0,36966811

-0,36966811

-0,36966811

-0,36966811

-0,17547849

-0,14598477

-0,02900133

-0,02900133

-0,11659087

-0,29446514

-0,44552789

-3,0980392

-8,32846829

-18,0617997
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500000

550000

600000

700000

750000

800000

850000

1000000

1100000

1500000

2000000

6

6

6

6

6

6

6

6

6

6

6

0,28

0,12

0,04

0,0046

0,001

0,004

0,0038

0,002

0,0004

0,003

0,004

-26,6198644

-33,9794001

-43,5218252

-62,3078684

-75,563025

-63,5218252

-63,9673531

-69,5424251

-83,5218252

-66,0205999

-63,5218252

Representación gráfica de los datos tabulados para el filtro elíptico con fe

375,14 kHz:

1 :c opooo

Figura 5.8 Representación de los datos obtenidos para el filtro elíptico con

ganancia unitaria y frecuencia de corte de 370 kHz.
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5.3 TABULACIÓN DE RESULTADOS

Luego de obtener los resultados de las mediciones en el módulo de desarrollo, se

tabulan los resultados para el análisis comparativo con los datos de las

simulaciones.

Resultados de los filtros de Butterworth programados:

MUESTRA

(m)

1

2

3

4

VALORES TEÓRICOS

fcm [kHz]

54,03

351,00

552,00

752,01

VALORES REALES

fcm [kHz]

56

350

550

750

ERROR

[%]

3,5%

0,3%

0,4%

0,3%

Resultados de las frecuencias de corte en los filtros Elípticos programados:

MUESTRA

(m)

1

2

3

VALORES TEÓRICOS

fcm [kHz]

55,65

375,14

526,00

VALORES REALES

fcm [kHz]

55

375

575

ERROR

[%]

1,80%

0,04%

8,52%

Resultados de las frecuencias de parada en los filtros elípticos programados:

MUESTRA

(m)

1

2

3

VALORES TEÓRICOS

fsm [kHz]

99,83

705,85

1300,00

VALORES REALES

fsm [kHz]

105

750

1500

ERROR

4,92%

5,89%

13,33%
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Resultados de la atenuación en la banda de parada en los filtros elípticos

programados:

MUESTRA

(m)

1

2

3

VALORES TEÓRICOS

Atenuación™ [dB]

-58,74

-63,81

-68,79

VALORES REALES

Atenuación™ [dB]

-58,06

-63,52

-72,04

ERROR

[%]

1,17%

0,46%

4,51%

5.4 ANÁLISIS DE RESULTADOS

De ios datos de error obtenidos, producto de las comparaciones efectuadas entre

las simulaciones utilizando la base de datos del PAC-Designer y las pruebas

practicas realizadas en el laboratorio, se hace evidente la dificultad que se

presento al momento de calibrar las frecuencias en el generador de señales con

la finalidad de tener la frecuencia tanto de corte como de parada lo más cercana

al valor de las simulaciones, lo que se ve reflejado en el alto porcentaje de error

en algunos casos, sobre todo con frecuencias extremas.

Como se puede apreciar en los casos en que las frecuencias de corte y parada

son muy cercanas a las que se tiene en el software, los errores obtenidos son

mínimos dentro de los rangos aceptables y comprueban el óptimo funcionamiento

dei ispPAC80/81 y del módulo de desarrollo.
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CAPÍTULO 6

CONCLUSIONES Y RECOMENDACIONES

6.1 CONCLUSIONES

La arquitectura que presentan estos dispositivos abre un sin número de

posibilidades para cambiar de un momento a otro la configuración inicial del chip, y

que, en conjunto con las herramientas de desarrollo, potencialmente se constituye

en un verdadero laboratorio teórico práctico que permite verificar de una manera

fácil y dinámica diseños analógicos tradicionales.

El acceso a las cinco líneas del estándar IEEE 1149.1 en todos los dispositivos

ispPAC, así como también la disponibilidad de la interfaz adecuada con el PC

permiten controlar la revisión, configuración, reprogramación y borrado del chip,

todo ello sin necesidad de tocar el circuito impreso (Módulo de Desarrollo).

Gracias a esta técnica, el fabricante del equipo (OEM) distribuye actualizaciones

del firmware y garantiza un mayor tiempo de vida de ios dispositivos.

Una de las grandes ventajas que presenta el programa PAC-Designer es la opción

que le permite al usuario de este paquete trabajar con todos los dispositivos de la

familia ispPAC, a pesar de que entre ellos difieren en el número de pines y en el

orden de disposición. La amplia base de datos que posee este software contiene

la información que posibilita la programación de todos los dispositivos a ser

empleados sin necesidad de recurrir a otro programa.

Del análisis de pruebas y resultados se advierte claramente la facilidad con la que

se obtienen resultados eficaces de los diseños propuestos, a pesar de que no para

todas las frecuencias empleadas en las pruebas se tiene una respuesta con un
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error mínimo, sabiendo que el máximo tolerable es del 5%, se atribuyen las tasas

superiores a la dificultad en el momento de efectuar las lecturas en ei osciloscopio,

por el reducido intervalo de amplitud que se presenta en la práctica al llegar a la

frecuencia de corte lo que hace que la lectura sea poco exacta, También, los

pasos que se adoptaron para la variación de las frecuencias en el generador de

señales los mismos que son heterogéneos debido a la dificultad presente en la

manipulación de las perillas al igual que el no poder exceder el valor máximo

graduado en este dispositivo que es de 3 MHz perjudicando la obtención de mayor

número de pruebas para la representación gráfica que ayudan a certificar el

óptimo comportamiento del dispositivo y del módulo de desarrollo.

La programación del ispPAC80/81 es sumamente fácil, basta con seguir los

lineamientos descritos en el cuarto capítulo y familiarizarse con el GUI del PAC-

Designer.

La seguridad que presentan los ispPACs una vez realizada la programación es

única, permitiendo mantener la exclusividad y autonomía sobre los diseños

realizados.

Los circuitos integrados de la familia ispPAC, han incrementado el número de

dispositivos analógicos programabies que se comercializan en la actualidad,

aumentando con ello el campo de aplicación de este tipo de dispositivos con una

mayor visión hacia el desarrollo tecnológico futuro,

6.2 RECOMENDACIÓN

Finalmente, se recomienda el empleo del módulo de desarrollo para la tecnología

ispPAC como parte del laboratorio de Electrónica Básica de la Escuela Politécnica

Nacional para brindar a ios estudiantes la facilidad de manipular diseños

analógicos y de manera especifica ios filtros analógicos que son el contenido de

este proyecto de titulación, con la finalidad de manipular los circuitos directamente
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desde el software evitando complicaciones y mejorando el tiempo de respuesta de

las prácticas, obteniendo además resultados óptimos y de gran utilidad para el

proceso de enseñanza aprendizaje.
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ANEXO A

Figura A.1 Módulo de Desarrollo y materiales empleados para su programación

Figura A.2 Conexión del Módulo de Desarrollo con los dispositivos empleados
para realización de pruebas
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Figura B.1 Fuente de Alimentación empleada para la polarización del
ispPAC80/81 a través del módulo de desarrollo

Figura B.2 Generador de señales empleado como VlN para efectuar las pruebas
en el módulo de desarrollo
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Figura C.1 Pruebas Preliminares


